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Chapter 1:

Introduction
In this chapter...


DesignPro Manager Overview



Supported File Formats



What’s New in DesignPro Manager 3.00



About this User Guide



Conventions



Getting the Answers You Need

This guide provides both background and procedural information for using DesignPro
Manager for Xerox. Because business requirements and user preferences can vary for each
company, the material contained herein should be viewed as a general guide only.
As you step through the material, please remember that your specific business needs will
govern selection of the options and preferences described. Similarly, certain selections
will require that some tasks be repeated, while other selections will enable you to omit
tasks entirely.

DesignPro Manager Overview
DesignPro Manager is a Windows-based desktop program for managing and converting
resources to multiple supported formats. You can also open other DesignPro applications
and utilities using the Manager.

15

Additionally, Manager provides numerous productivity-enhancing functions to:












Convert resources, such as documents, overlays, fonts and images from one format
to another. This is helpful while printing, when you need your resources in a single
format.
Search for and replace resource(s), such as fonts and images used in an overlay.
Packaging of these resources for later use is also supported.
Link files to applications, thereby enabling you to start an application and open a file
in one step.
Establish shortcut icons for DOS or Windows-based applications for opening from
DesignPro Manager.
Directly access the contents of the physical folder using the virtual folder, providing
easy access to resources in a very organized manner.
Set input and output file properties using the Converters interface and/or Command
Line Converters.

The Manager provides an Explorer view of all drives, incorporating standard MSWindows functionality. The Explorer view in the Explorer Window (page 33) displays all
of the physical files and folders on your computer and network. The Elixir Resources view
in the Resources Window (page 33) displays files and folders in your computer according
to resources types (documents, overlays, fonts and images). This is done with the help of
using Virtual Folders (page 52). The Manage Window (page 37) is used to search for and
replace resources, and also to package resources if necessary.
This guide describes all functions and features of the DesignPro Manager, therefore
certain options described may not apply to your specific configurations. In such cases,
unavailable options display in gray (disabled) on menus and dialog boxes, and some
screens and icons may not display at all.
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Supported File Formats
DesignPro Manager opens and saves documents, overlays, fonts and images in multiple
formats. The supported input and output formats are listed by the resource types below:
Overlay Formats




Input formats: the supported input formats for overlays are as follows:
• Elixir Form (*.efr)
• Elixir Legacy Forms (*.elx)
• Elixir PrintDriver Forms (*.ep)
• Windows EMF Files (*.emf)
• Xerox Form Object Files (*.frm)
• Xerox Form Source Files (*.fsl)
Output formats: the supported output formats for overlays are as follows:
• Elixir Forms (*.efr)
• Elixir Legacy Forms (*.elx)
• PCL Page (*.pcl)
• PDF Page (*.pdf)
• PostScript (*.ps)
• Image File (*.tif,*.lp3,*.img;*.seg)
• VIPP Files (*.vip)
• Xerox Form Object Files (*.frm)
• Xerox Form Source Files (*.fsl)
• Xerox Metacode Files (*.met, *.mta, *.nor)

Font Formats


Input formats: the supported input font formats are as follows:
• Elixir Legacy Font (*. hdr)
Includes Legacy and DesignPro Tools fonts; both use the same extension.
• Elixir Legacy Coded Font (X0*.cdf; X1*.cdf…)
• Elixir Legacy Code Page (*.cod)
• PCL Font (*.flj; *.pcl)
• Xerox Font Files (*.fnt)

Chapter 1: Introduction
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Output formats: the supported output font formats are listed below:
• Elixir Legacy Font (*. hdr)
• Elixir Legacy Coded Font (X0*.cdf; X1*.cdf…)
• Elixir Legacy Code Page (*.cod)
• PCL Font (*.flj; *.pcl)
• Xerox Font Files (*.fnt)

Image Formats




Input formats: the supported input image formats are as follows:
• BMP Files (*.bmp)
• Elixir Legacy Graphics (*.lp3)
Includes Legacy and DesignPro Tools images; both use the same extension.
• JPEG Files (*.jpg; *.jpe; *.jpeg)
• PCX Files (*.pcx)
• PNG File (*.png)
• TIFF Files (*.tif)
• Xerox IMG and Xerox LGO (*.img, *.lgo)
Output formats: the supported output image formats are listed below:
• Bitmap File (*.bmp)
• Elixir Legacy Graphic (*.lp3)
• Elixir Form (*.efr)
• JPEG File (*.jpg; *.jpe; *.jpeg)
• PCX File (*.pcx)
• PNG File (*.png)
• TIFF File (*.tif)
• Xerox IMG and Xerox LGO Files (*.img, *.lgo)
The DesignPro Tools support most of the standard encoding schemes for
parsing Tiff images, such as CCITT G3 G4, JPEG, etc. For output formats, the
supported encoding schemes include PackBit, CCITT G3 and CCITT G4.

For details on the Image Converter options, see “Image Converter Options”
section of the DesignPro Tools Online Help by clicking
of the dialog.

18

on the top-right corner

DesignPro Tools Manager® for Xerox User Guide

Document Formats


Input formats: the supported input document formats are listed below:
• Elixir PageDef (*.epd)
• Elixir FormDef (*.efd)
• Elixir AppBuilder 4.xx (Document.dbf)
• Xerox LCDS/Metacode (*.met, *.mta, *.nor)

In order to open an Elixir AppBuilder file, you must be on an AppBuilder version
4.10 or greater.



Output formats: the supported output document formats are as follows:
• Elixir PageDef (*.epd)
• Elixir FormDef (*.efd)
• Xerox LCDS/Metacode (*.met, *.mta, *.nor)

Associated DesignPro Applications
DesignPro Tools for Xerox employs four integrated applications to provide advanced
functionality for designing projects and creating resources such as documents, overlays,
fonts and images for Xerox jobs. Each application helps you to create or modify one or
more of these necessary resources in a user-friendly environment. The applications
include:








DesignPro Manager: a Windows-based desktop program for managing and
converting resources to multiple supported formats. You can also open other
DesignPro applications using the DesignPro Manager.
DesignPro Form Editor: an advanced overlay design tool used to create and edit
forms for Xerox printers.
DesignPro Font Editor: a complete font design application used for creating and
editing Xerox fonts as well as Elixir and PCL fonts. You can also open True Type
fonts in this editor.
DesignPro Graphics Editor: a full service bitmap editor providing various
transformations and commands for tiling images into raster fonts and image
modifications, such as resizing and cleaning up scanned images.

Chapter 1: Introduction
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What’s New in DesignPro Manager 3.00
DesignPro Manager 3.00 introduces new and advanced features for managing your project
resources. Also, some of the existing features have been enhanced in the new version. The
sections below briefly explain the new features:
DAT Files
DesignPro Manager helps you to create DAT files that contain form references for
composing normalized data streams. You can also insert additional script commands in a
DAT File using the available options. Previously, this feature was available only in
DesignPro Form Editor.
Resource Searching and Replacement
DesignPro Manager enables you to determine if a specified font or image resource is
being used in any overlay, and also to replace the resources (image or settings file) used
within the overlay(s). It also helps to simultaneously replace a resource used in multiple
files.
Packaging Resources
DesignPro Manager provides the facility to package your required resource files in a
single Zip File (*.zip). For supported file formats, all the dependant resources of the
specified resource can also be included.
Collecting Diagnostic Information
DesignPro Manager can package your system information, all DesignPro application
settings, and configurations into a Zip File (*.zip). Such information is required for
replicating your PC environment on any other system.
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About this User Guide
The DesignPro Tools Manager for Xerox User Guide provides definitions and step-bystep instructions to help you convert Xerox specific resources and organize and manage
the resources.
The guide is organized to mimic the resource conversion and management process for
resources such as overlays, fonts, images and documents. Each section is placed in the
same order you can use while working with resources:
Introduction
Introduces DesignPro Manager and basic conversion terminology including input and
output formats. Also introduces this manual and identifies resources for finding answers
and contacting Customer Support.
Section I: DesignPro Manager Basics
Describes the DesignPro Manager workspace, including the workspace tools and
associated navigation operations. Also explains how to define, locate, and manage virtual
folders. Steps for creating application shortcuts are also given.
Section II: Managing and Converting Resources
Describes how to convert resources to different output formats, search, replace and
package the resources. Also provides information on the commands used for accessing
DesignPro Tools Command Line Converters.
Section III: File Transfers
Describes how to transfer files between your PC and host computer. It also explains how
to configure host connections, specify font libraries and download and upload files for
subsequent processing.
Section IV: Utilities
Introduces you to the basic stand-alone and additional utilities that are a part of the
DesignPro Tools Suite.
Section V: References
Provides a reference for commonly encountered error and warning messages, includes
sample conversion instructions for resources and a glossary of terms.

Chapter 1: Introduction
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Who Should Use this Guide?
This guide assumes you are already familiar with Microsoft Windows operations, printer
and font management operations and PC peripherals. You should also have access to
reference manuals for PC software and hardware, including any printers you are using for
the resource conversion and print process.

Related Guides
If you require further information about a specific topic or wish to obtain product
background information, reference the following resources, all of which are part of the
DesignPro Tools for Xerox documentation package.


DesignPro Tools for Xerox Getting Started Guide



DesignPro Tools Form Editor for Xerox User Guide



DesignPro Tools Font Editor for Xerox User Guide



DesignPro Tools Graphics Editor for Xerox User Guide



DesignPro Tools for Xerox Migration Guide

Conventions
Elixir products adhere to Microsoft Windows conventions for using menus, menu
commands, dialogs, command buttons, icons and mouse. See your Windows manual for
more information.
This guide uses the following typographic and symbolic conventions to identify special
information.
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Typographic Conventions
This guide uses the following typographic conventions to identify special information.

Convention

Information Type/Example

Bold type

Text for you to enter.
Field names, windows, toolbars, buttons and workspace areas within a
task step.
Example: Click Save State on Exit from the General category.
Example: From the Tools menu, select Options.
Example: Use formats displayed in the Output Formats list.
Example: Click the Applications tab.
Example: Click OK to save the settings.

Italic type

References to other documents and books.
Example: Refer to DesignPro Tools Form Editor User Guide for
more information.

Symbolic Conventions
Look for the following symbols as you read through this guide to identify special
information.

The Note symbol calls your attention to additional information.

The Tip symbol highlights a helpful tip.

Chapter 1: Introduction

23

The Shortcut symbol calls your attention to an easier way of accomplishing a
task.

The Warning symbol warns you of problems you might encounter.

The Migrating Users symbol provides notes and tips for anyone migrating from
a previous version of DesignPro Tools.

The Question symbol refers you to the Online Help for more information.
To open Online Help:


From the Help menu select Contents, or



Click

in an open dialog.

Getting the Answers You Need
Elixir Technologies provides you with multiple ways to learn and use DesignPro Manager:
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Customer Support (page 25)



Elixir Web Site Support (page 26)



Elixir Training (page 26)



Product Help (page 26)



Release Notes (page 26)
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Customer Support
If you purchased this product directly from Elixir Technologies, you can contact the
Customer Support Center for your region at the number listed below.
If you have purchased this product from some other source, please contact the
authorized support representative from that source. Elixir provides customer
support for products purchased directly from Elixir.

North and South America




+1 805 641 5900 ext. 3
Monday - Friday, 7:00 am to 4:00 pm Pacific Standard Time; if closed, press 2 to
reach Elixir’s extended Support coverage.
Elx_support@elixir.com

Asia Pacific


Asia_support@elixir.com

Europe






+44 (0) 207 993-4811
Monday - Friday, 6:00 am to 4:00 pm Central European Time.
+1 805 641 5900 ext. 3
Monday - Friday, 4:00 pm to 2:00 am Central European Time.
Europe_support@elixir.com

An Elixir Product Specialist will take your call and ask for the following information:


Your name, organization, telephone number and address.



Elixir product name and version number.



A complete description of the problem, including any error messages printed or
displayed on your monitor.
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Elixir Web Site Support
You can obtain product support from the Elixir web page at www.elixir.com.
Select Support to:


Ask a question of Elixir Support.



Download the latest Product Releases and Patches.



View the latest product Release Notes.



Sign up for Elixir Training.



Renew your product license.

Elixir Training
Elixir Technologies offers training for its full range of Windows-based products. For more
information, contact Elixir Learning at +1 805 641 5900, ext. 4.

Product Help
Elixir software provides Online Help for all product functions and contains step-by-step
procedures that you can follow as you work:


Context-Sensitive Help can be activated from within the software for certain
dialogs by clicking



in the top-right corner of a dialog.

Online Help can be opened from the Help menu by selecting Contents.

Release Notes
Release Notes display at the start of product installation so you can review them before
beginning the installation process. Once installation completes, you can access Release
Notes from the product CD located at drive:\Relnotes.
There are two formats of the Release Notes file, Relnotes.pdf and Relnotes.txt. The PDF
file can be viewed using Adobe Reader. The TXT file can be viewed using either Notepad
or WordPad.

26

DesignPro Tools Manager® for Xerox User Guide

Section I: DesignPro Manager Basics
Chapter 2: The Manager Environment
This chapter provides information on DesignPro Manager environment, including the
workspace tools and associated navigation operations.
Chapter 3: DesignPro Manager Basics
This chapter describes the basic features of the DesignPro Manager. It explains the use of
system and virtual folders for managing different resources and how to create shortcuts for
frequently used applications.
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Chapter 2:

The Manager
Environment
In this chapter...


Opening Manager



What’s in the Workspace?



Workspace Tools



Basic Workspace Functions



Saving Application State

Opening Manager
To open the Manager, from the Start menu, select All Programs, Elixir Applications,
DesignPro Tools, DesignPro Manger.

What’s in the Workspace?
When you start the Manager, the workspace and all associated components display. The
workspace provides a central location from where you can access the applications and
utilities available within the DesignPro applications.
The Manager workspace includes the following main components:


Navigation Window (page 31)



Resources Window (page 33)



Explorer Window (page 33)
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Details Window (page 34)



Manage Window (page 37)



Messages Window (page 37)



Status Bar (page 42)

The illustration below identifies each part of the Manager workspace when all
components are open:
Menu

Toolbar

Title bar

Resources window

Manage window

Details window
Navigation window
Explorer window
Messages window

You can customize the position and size of the windows per your requirements. The
workspace windows can be displayed as either floating or docked and can also be hidden
from view. See “Showing and Hiding Workspace Windows” on page 43 for details.
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Navigation Window
The Navigation window consists of the following three tabs that you can use for
switching between different views:


Applications Tab (page 32)



Tools And Utilities Tab (page 32)



My Shortcuts Tab (page 32)

As you switch between the tabs, the window title changes accordingly. By default, the
Navigation window is docked on the left side of the workspace, although you can move
the window anywhere within the workspace.
The Applications tab
displays the DesignPro
applications.
The Tools And
Utilities tab displays
the tools and utilities
provided with the
DesignPro Tools.
The My Shortcuts tab
displays the
customized shortcuts
you create.

Image shows the different tabs available in the Navigation window.
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Applications Tab
The Applications tab contains icons that you can click to open the installed DesignPro
applications such as Form Editor, Font Editor, Graphics Editor, Converters, Elixir Scout
Manager and Elixir Viewer.
To open the Converters, drag and drop the required file(s) onto the Converters icon,
.
See “Converting Files to Different Formats” on page 93 in Chapter 5: "Using Converters"
for details.
Tools And Utilities Tab
The Tools And Utilities tab contains icons that you can click to start the installed tools
and utilities such as Product Registration, Printers etc.
To open a printer, drag and drop the required file(s) onto the Printers icon,
. For more
information, see “Printers” on page 158 in Chapter 8: "Stand-Alone Utilities".
My Shortcuts Tab
My Shortcuts tab displays user-defined shortcut icons for different applications. You can
open the applications directly through the icons available on this pane; thus, saving time in
having to locate the application’s executable files. You can create shortcut icons for any
application using the Shortcut wizard. See “Creating Application Shortcuts” on page 65
in Chapter 3: "DesignPro Manager Basics" for details.

Icon Display in the Navigation Window
You can choose to view large or small icons for the application links in the Navigation
window.
To change view options:
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1

Click the required tab in the Navigation window.

2

Right-click in the window area and select one of the following view options from the
pop-up menu:
 Large Icons: displays large icons for the application links.
 Small Icons: displays small icons for the application links.
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The application icons display as specified.

Applications tab displaying the DesignPro applications in small icons.

For My Shortcuts tab, the icon view options are available in the View
sub-menu.

Resources Window
The Resources window displays the hierarchy of virtual folders containing the Elixir
resources. Virtual folders are an abstract representation of the DesignPro Tools file folder
structure. You can map the physical folder in the Explorer window to a folder in the
Resources window. This is useful for organizing data by its specific type.
When you map a physical folder to a virtual folder using the Resources window, the
mapped folder displays in the Resources window. For more information on virtual
folders, refer to Chapter 3: “DesignPro Manager Basics” on page 49.

Explorer Window
The Explorer window displays a Windows explorer view of the system folders. You can
perform all of the standard MS-Windows operations on the system folders in this window.
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Details Window
The Details window displays the contents (files) of the virtual or system folders selected
from the Resources window or the Explorer window.
To view the contents of a folder:

1

Select the required folder using the Explorer or the Resources window.
The contents of the selected folder display in the Details window.

2

Select the type of file you want to display from the Filter drop-down list.
The Filter drop-down list is available at the top-left corner of the Details window. It
is enabled only when you select a virtual folder from the Resources window.

For example, select Forms, Elixir, Elixir1 from the Resources window. The contents of
Elixir1 display in the Details window. You can select either Elixir Legacy Form (*.elx) or
Elixir Form (*.efr) from the Filter drop-down list to display the associated resource files.
Name of the virtual
folder selected from Path of the mapped
physical folder.
Resources Tree.

Filter drop-down list.

Details window displaying the files in a virtual folder.
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Changing the Details Window View
To change the Details window view, you can select one of the following View menu
options:


Large Icons: displays large icons for files.



Small Icons: displays small icons for files.



List: displays files in a list.



Details: displays files in a list along with the details for each file in the associated
columns: Name, Size, Type and Modified.

The following images show the icons displaying differently in the Details window when
different views are selected:

Image shows the Details window: 1) Small Icons view, 2) List view.
You can also change the Details window view by clicking either of the following
on the Standard toolbar:


: displays large icons.



: displays small icons.



: displays a list of files.



: displays file details in a columnar view.
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Arranging Icons in the Details Window
The Manager arranges the icons of files and folders displaying in the Details window. You
can make an arrangement based on the name, size, type or date of modification of a file.
To change the arrangement of icons, select any one from the following options available in
the View, Arrange Icons menu:


By Name: arranges icons in alphabetical order by the file/folder name.



By Type: arranges icons in order of file/folder size.





By Size: arranges icons in order of type. For example, if you have several BMP
images in a folder, these will be arranged next to each other.
By Date: arranges icons in the order that the shortcut was last modified.


Auto Arrange: This feature is currently not functional.
In the Details view, you can also arrange (sort) the files by clicking on the required file
attribute (Name, Size, Type, Modified) in the column-header.

The Details window displaying files sorted according to the file size.

You can line up the icons by right-clicking in the Details window and selecting
Line Up Icons from the pop-up menu.
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Manage Window
The Manage window is docked to the right-side of the workspace by default. It provides
you with various options for packaging the Elixir resources and searching for a resource.
These options are categorized under the following four tabs:


DAT File. See “DAT Files” on page 73.



Resource Search. See “Resource Searching” on page 80.



Resource Package. See “Packaging Resources” on page 87.



Diagnostic Information. See “Collecting Diagnostic Information” on page 91.

You can use these
arrow buttons for
viewing the remaining
tabs.

The Manage window.

Messages Window
The Messages window is located at the bottom of the workspace by default. It displays the
processing/compilation errors, warnings and informational messages generated by the
application in red, blue and black text respectively. You can close the Messages window
from the menu by selecting View, Messages to create more space to work.
You can also press Ctrl + Shift + M to view or hide the Messages window.
However, the Messages window will automatically re-display whenever a
message is generated by the application.
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Clearing Messages
To clear the messages generated by the application, right-click in the Messages window
and select Clear Messages from the pop-up menu.
You can also clear messages in the Messages window by:


Selecting View, Clear Messages from the menu.

or


Pressing Control + D on the keyboard.

Copying Messages
To copy the messages generated by the application:

1

Select the required messages in the Messages window.

2

Right-click the selected messages and select Copy Messages from the pop-up menu.
The selected messages copy to the clipboard and you can paste them wherever
required.

You can also copy messages from the Messages window by selecting the
required messages and pressing Control + C on the keyboard.
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Logging Messages
Logging options enable you to save the information displayed in the Messages window in
a text file.
To log the generated messages:

1

From the Tools menu, select Options.
The Options dialog displays.

2

Select the Messages category.

3

Check Log to File under the Log Options area to enable the associated settings.

4

In the Log to File entry box, enter the destination path where the log file is created.

Options set in the Messages category apply to all DesignPro application
sessions.

The default value of “.\” saves the log file in the same directory as the resource
file.

5

Enter the name of the log file in the next entry box, as shown below:

The default log file name is Msg.log; however, you can change the file name and
save it.

6

Check Unicode to create the log file using the Unicode character set.

Chapter 2: The Manager Environment

39

7

Specify the settings of your choice:
 Overwrite: overwrites any existing log file messages.
 Append: appends messages to the existing log file.
 Append By Date: appends messages to the log file, ordered by date.
You can view the log file at any time by clicking View Log File. The contents of
the log file (with the name and location entered in the Log to File entry boxes)
display in a Notepad window.

8

Click Apply, and then click OK to save the settings.

Displaying Message Time and Date
You can also display the time a message was generated in the Messages window.
To display message time:
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1

From the Tools menu, select Options.
The Options dialog displays.

2

Select the Messages category.

3

Under the Messages to View area, check Information to display informational
messages in the Messages window.

4

Under the Show area, check Message Time to display the message generation time
in the Messages window.

5

Under the Show area, check Message Date to display the message generation time
in the Messages window.

6

Click Apply, and then click OK to save the settings.
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Color Coding Messages
Messages in the Messages window can also be color coded according to the nature of the
message. Color coding is added using colored boxes before the messages. Error messages
display red boxes, warnings display blue boxes and informational messages display
neither. With color coding, critical messages can be located quickly.
To color code messages:

1

From the Tools menu, select Options.
The Options dialog displays.

2

Select the Messages category.

3

In the Messages to View area, make sure Information is checked to display
informational messages in the Messages window.

4

In the Show area, check Use Color to display colored boxes in the Messages
window.

5

Click Apply, and then click OK.

The following image shows the Messages window displaying different informational,
error and warning messages along with the date and time of generation:
Warning messages display with a blue-colored box.
Error messages
display with a redcolored box.
Informational
messages do not
display with a
box.
Date and Time when the message was generated.
You can also set the number of maximum lines displaying in the Messages
window by entering the number in the Lines Maximum entry box, provided in
the Show area.
If the number of messages generated exceeds the value specified in the Lines
Maximum entry box, the new messages overwrite the existing ones from the
top in the Messages window. If Log to File is checked, messages are
overwritten from the top of the log file.
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Status Bar
The Status bar displays along the lower edge of the Manager workspace. When you move
the mouse pointer over a folder (and/or its contents) selected from the Explorer window,
the Status bar displays the number of contents in the folder, size of the selected folder and
the free space available on the hard drive.
In addition, the Status bar displays the description associated with the menu and toolbar
items, along with the currently selected profile. For information on selecting profiles, see
Chapter 9: “Elixir Profile Editor” on page 207.
The Status bar is shown in the figure below:
The active profile is displayed in
the Status bar.

Tool tip

Number of objects contained
in the selected folder.

Size of the selected
folder.

Free space available in the current disk drive.

To show/hide the Status bar, select View, Status Bar from the menu.
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Showing and Hiding Workspace Windows
You can hide the workspace windows to provide more space for displaying resources, and
re-display them whenever required.
To show or hide the workspace windows, select the required options from the View menu:










Messages: displays/hides the Messages window.
You can also display/hide the Messages window by pressing Ctrl + Shift + M on the
keyboard.
Elixir Resources: displays/hides the Resources window.
You can also display/hide the Resources window by pressing Ctrl + Shift + X on the
keyboard.
Explorer: displays/hides the Explorer window.
You can also display/hide the Explorer window by pressing Ctrl + Shift + E on the
keyboard.
Navigation Bar: displays/hides the Navigation window.
You can also display/hide the Navigation window by pressing Ctrl + Shift + N on
the keyboard.
Manage Window: displays/hides the Manage window.

Workspace Tools
The Manager provides a menu and a toolbar for easy access to the most commonly used
application commands. You can perform standard Windows operations to hide or display a
toolbar or dock a toolbar at the edge of the workspace.

Menus
A menu with drop-down menus displays directly below the application title bar. These
drop-down menus provide both standard MS-Windows and application-specific options.
Selecting a menu performs an associated action or displays a sub-menu or a dialog.
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Standard Toolbar
Directly below the menu is the Standard toolbar. The Standard toolbar provides oneclick access to the basic Edit and View menu commands such as copy/paste and icon
display options in the Details window.

To show/hide the Standard toolbar, select View, Standard Toolbar from the
menu.

Customizing the Toolbar Display
You can also specify the toolbars that display in the workspace.
To customize the Manager toolbars:

1

Right-click on the Standard toolbar to open the Customize dialog.

2

Click the Toolbars tab.

3

Check the toolbars you want to display in the workspace from the list of available
toolbars.
The selected toolbar name displays in the Toolbar Name entry box.

You cannot uncheck Menu bar from the list of toolbars.

You can also display a toolbar from the View menu, by selecting
Toolbars, Toolbar name.
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4

To set the appearance of the displayed toolbars, specify the following:
 Show Tooltips: displays the tool tips associated with the toolbar buttons.
 Cool Look: displays the toolbar buttons in the smooth look mode.
 Large Buttons: displays the toolbar buttons in the enlarged mode.
 Reset/Delete: resets a default toolbar to the default settings. This button toggles
to Delete when a custom toolbar is selected; only custom toolbars can be deleted.

5

Click OK and return to the Application window.

Creating a New Toolbar
Using the Manager, you can also create a new toolbar.
To create a new toolbar:

1

Right-click on the Standard toolbar to open the Customize dialog.

2

Click the Toolbars tab.

3

Click New to open the New Toolbar dialog.

4

In the Toolbar Name entry box, enter the name of the new toolbar.
You can modify this name later in the Toolbars tab.

The names of the default toolbars are not editable.

5

Click OK to save the settings.
The new toolbar displays in the workspace. The new toolbar is currently empty. To
add buttons to this toolbar, see “Adding Buttons to Toolbars” on page 46 for details.
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Adding Buttons to Toolbars
You can also add buttons to your toolbar.
To add buttons to a toolbar:

1

Right-click on the Standard toolbar to open the Customize dialog.

2

Click the Command tab.
The list of available command groups display in the Categories list When a
command group is selected, the buttons for each command in the group display in
the Buttons area.

3

Click and drag the required button to any target toolbar displaying in the workspace
and then release the mouse.
While dragging the required button, the mouse cursor changes to
button is then added to the required toolbar at the specified place.

. The selected

You can also create a new toolbar by dragging a button from the Commands
tab, and dropping it anywhere in the workspace. The Manager automatically
creates a new toolbar with the specified button, and displays it in the Manager
workspace. If you then click the Toolbars tab, the newly created toolbar name
(default is Toolbar 1) displays in the Toolbars list box.
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Basic Workspace Functions
The Manager workspace provides some basic functions to help you design your forms.

Using the Right-Click Menu
The right-click menu provides access to the commonly-used functions in the Manager. To
use the right-click menu, position the cursor in any of the windows (Navigation,
Resources, Explorer, Messages or Details) and right-click your mouse. A pop-up menu
displays. This menu is context-sensitive and displays a list of options depending on the
window selected in the workspace. Select the required option from the menu.

Refreshing the Workspace
You can refresh the trees and lists to reflect the latest changes by selecting View, Refresh
from the menu. You can also refresh the workspace by pressing F5 on the keyboard.

Choosing Commands
A command instructs the Manager to perform a specific action. You can choose a
command by either:


Clicking a toolbar button.



Selecting a menu option.



Using a hot key.



Using a shortcut key.

In the chapters that follow, command selection is described using the most common
method for the described task. However, any related command selection can be used to
accomplish the same instruction.
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Saving Application State
DesignPro Manager lets you preserve the application interface state. The application state
involves the current display settings for the workspace windows, currently selected folder
and its contents. This feature retains the application status and settings the next time it is
opened.
The sorting order of files for Details view and the arrangement of files (by
Name, Type, Size or Date) in the Details window is also maintained when
saving the application state.

To save the application state:
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1

From the Tools menu, select Options.
The Options dialog displays.

2

Select the General category.

3

Check Save State on Exit.

4

Click Apply and then click OK to save the settings.
The application interface state will be saved at the time of exit. The application will
open with the same settings in the next session.
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Chapter 3:

DesignPro Manager
Basics
In this chapter...


Browsing the Workspace



Working with Folders



Creating Application Shortcuts

Browsing the Workspace
The DesignPro Manager workspace provides easy access to the installed applications,
tools and utilities along with an Explorer view for all drives with standard MS-Windows
functionality incorporated.
The Manager provides access to two types of folders:




Physical Folders: folders that are created on your computer and can have a number
of other physical sub-folders and files in them.
Virtual Folders: abstract representation of the physical file folder structure
underlying DesignPro Tools. Virtual folders can have a number of virtual sub-folders
in them.

Virtual folders display as a tree structure in the Manager. These are organized by resource
type, then resource format. At the lowest level of each branch, one or more folders are
listed, each representing a physical location on a mapped drive. This feature helps you to
directly access the contents of the physical folder using the virtual folder, providing easy
access to resources in a very organized manner.
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Working with Folders
The Manager provides an Explorer window and a Resources window for easy
management and access of resources.


The Explorer Window (page 33) displays the physical files and folders on your
computer and network.

The Resources Window (page 33) displays the Elixir resource files and folders on
your computer. The resources are displayed according to their resource types, which
is done with the help of virtual folders.
To learn more about Manager workspace, and its associated properties, refer to
Chapter 2: “The Manager Environment” on page 29.


For managing resources using virtual folders, you can perform the following tasks in
order:

1

Defining Virtual and Physical Folders (page 50).

2

Locating Virtual and Physical Folders (page 51).

3

Using Virtual Folders (page 52).

4

Managing Folders (page 56) for easy access to resources.

Defining Virtual and Physical Folders
For the purpose of easy navigation and file management, the Manager provides a directory
structure for:




Virtual Folders: display in the Resources window under the Elixir Resources root
directory to provide a hierarchy or tree view of all Elixir specific resource types.
Windows Explorer Folders: display in the Explorer window under the Desktop
root directory to provide a tree view of the computer contents, including each drive
and folder on your computer, as well as any network connected drives.

The Manager tree structure of folders, sub-folders, and files makes it easy to manage input
and output files during mass conversion operations. It also helps to locate files by keeping
all related folders in a single repository. This directory structure also enables you to view
and edit forms, fonts, and images with different formats.
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The following image shows a virtual folder (Fonts, Xerox, Xerox 1) selected from the
Resources window. The virtual folder name (Xerox 1) and the mapped physical folder
location (drive:\Elixir\Fonts\Xerox) display in the Details window header bar. The Xerox
Fonts (as specified by the Filter drop-down list) in the mapped physical folder display in
the Details window.

Contents of Fonts, Xerox, Xerox 1 virtual folder displaying in the Resources window.

Locating Virtual and Physical Folders
The location of the virtual folder tree is in the Resources window and contains folders that
are organized by resource types, i.e., Document, Fonts, Forms (overlays), Graphics, and
Jobs. These folders are mapped with the actual folders in the hard drive. Underneath the
resource format folders (such as Xerox, Elixir, etc.) there are sub folders representing a
physical location on your drive or network ( Xerox1, Elixir1, etc.). The names for these
folders are automatically generated. However, you can change these names according to
your environment specifications. Placing your cursor over the mapped file folder displays
the full path of the virtual folder references.
The physical folders tree is located in the Explorer window, and shows the Desktop on
your computer. You can navigate in the folders to any location on your computer or
network, as in Windows Explorer. You can also map a physical folder to the virtual folder
to display associated resources in the Resources window.
For details, see Chapter 2: “The Manager Environment” on page 29.

Chapter 3: DesignPro Manager Basics

51

Virtual Folders
System parsers, converters, and editors use the virtual folders to locate resources. The
following images depict the virtual folder organization.

Virtual folder organization.
Virtual folder settings can be changed within any DesignPro application using either the
Manager or the Profile Editor. Changes made are saved in the current application profile.
If settings are changed using the Manager, any active DesignPro application, except
DesignPro Manager, needs to be closed and re-opened for the changes to take effect.
However, changes made using Profile Editor require that all applications, including
DesignPro Manager, be closed and re-opened in order for changes to take effect.
The following sections briefly describe each resource type and their subordinate folders
available in the Resources window:
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Documents Folder (page 53)



Fonts Folder (page 53)



Forms Folder (page 54)



Graphics Folder (page 55)



Jobs Folder (page 55)
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Documents Folder
The Documents folder represents the drive:\Elixir\Docs directory containing fully
composed multi-page documents for Xerox Metacode (*.met, *.mta, *.nor), Elixir (*.gdf),
Elixir Document (*.edf), Elixir DAT File (*.dat), Enhanced Metafile (*.emf), Printer
Command Language (*.pcl; *.prn), Portable Document Format (*.pdf), and PostScript
(*.ps) formats.
To navigate in the Documents folder, click adjacent to the Documents folder in the
Resources window. The folders in the location drive:\Elixir\Docs are displayed in the tree.
Select the required folder to expand and view its resources. The resources are displayed in
the Details window.
Documents subfolders correspond to the following subdirectories:

Document Folder

Subdirectory

Elixir Documents

Elixir\Docs\Elixir\

EMF Documents

Elixir\Docs\Emf\

PCL Documents

Elixir\Docs\Pcl\

PostScript Documents

Elixir\Docs\Ps\

PDF Documents

Elixir\Docs\Pdf\

Xerox Documents

Elixir\Docs\Xerox\

Fonts Folder
The Fonts folder represents the drive:\Elixir\Fonts directory. This directory contains
Xerox Fonts (*.fnt), Elixir Legacy Coded Font (X0*.cdf; X1*.cdf; X2*.cdf; X3*.cdf;
X4*.cdf), Elixir Legacy Font (*.hdr), Elixir Legacy Code Page (*.cod), Type 1 Font
(*.pfm), PostScript Font (*.ps), and Windows fonts (Adobe Type 1 and System).
To navigate in the Fonts folder, click adjacent to the Fonts folder in the Resources
window. The folders in the location drive:\Elixir\Fonts are displayed in the tree. Select the
required folder to expand and view its resources. The resources are displayed in the
Details window.
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Fonts subfolders correspond to the following subdirectories:

Fonts Folder

Subdirectory

Elixir Fonts

Elixir|Fonts|Elixir|

PostScript Fonts

Elixir|Fonts|Atmt3|

Type 1 Fonts

Elixir|Fonts|Atmt1|

Windows Fonts

Displays the fonts installed
in the system.

Xerox Fonts

Elixir|Fonts|Xerox|

Forms Folder
The Forms folder represents the drive:\Elixir\Forms directory containing Xerox Form
Object (*.frm), Xerox Form Source (*.fsl), Elixir Form (*.efr), Windows Elixir Metafile
(*.emf), PCL Page (*.pcl), PDF Page (*.pdf), and PostScript (*.ps).
To navigate in the Forms folder, click adjacent to the Forms folder in the Resources
window. The folders in the location drive:\Elixir\Forms are displayed in the tree. Select
the required folder to expand and view its resources. The resources are displayed in the
Details window.
Forms subfolders correspond to the following subdirectories:
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Forms Folder

Subdirectory

Elixir Forms

Elixir\Forms\Elixir\

EMF Forms

Elixir\Docs\Emf\

FRM

Elixir\Forms\Frm\

FSL

Elixir\Forms\Fsl\

PCL Forms

Elixir\Docs\Pcl\

PDF Forms

Elixir\Docs\Pdf\

PostScript Forms

Elixir\Docs\Ps\
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Graphics Folder
The Graphics folder represents the drive:\Elixir\Pics directory containing Xerox IMG
(*.img), Xerox LGO (*.lgo), Elixir Legacy Graphic (*.lp3), Bitmap File (*.bmp), JPEG
File (*.jpg, *.jpe, *.jpeg), PCX File (*.pcx), TIFF File (*.tif), and PNG File (*.png).
To navigate in the Graphics folder, click adjacent to the Graphics node in the
Resources window. The folders in the location drive:\Elixir\Pics are displayed in the tree.
Select the required folder to expand and view its resources. The resources are displayed in
the Details window.
Graphics subfolders correspond to the following subdirectories:

Graphics Folder

Subdirectory

Elixir Graphics

Elixir\Pics\Elixir\

IMG

Elixir\Pics\Img\

LGO

Elixir\Pics\Lgo\

Jobs Folder
The Jobs folder represents the drive:\Elixir\Jobs directory containing Xerox JSL
Resources (*.jsl) files.
To navigate in the Jobs folder, click adjacent to the Jobs node in the Resources
window. The folders in the location drive:\Elixir\Jobs are displayed in the tree. Select the
required folder to expand and view its resources. The resources are displayed in the
Details window.
Jobs subfolders correspond to the following subdirectories:

Jobs Folder

Subdirectory

Xerox JSL Resources

Elixir\Jobs\Jsl\
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Managing Folders
DesignPro Manager helps to create new physical folders, map physical folders to virtual
folders, and to move/copy folders. You can also create and move/copy resource files.
These basic Manager operations are explained in the tasks below:


Creating a New Physical Folder (page 56)



Creating a New Elixir Resource (page 57)



Creating a New Scout Task (page 57)



Opening a Resource File (page 58)



Mapping a Physical Folder to a Virtual Folder (page 58)



Moving or Copying Files Across Virtual and Physical Folders (page 60)



Deleting Files (page 62)



Unmapping Virtual Folders (page 64)



Viewing Folder Properties (page 64)



Selecting Folder Contents (page 64)



Moving Between Folders (page 65)

Creating a New Physical Folder
To create a new physical folder:

1

Browse to the required location in the Explorer window.

2

Select New, Folder from the File menu.
The new folder is created and displayed in the Details window.

You can also right-click in the Details window to select New, Folder from the
pop-up menu.
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Creating a New Elixir Resource
To create a new Elixir Resource, select New, required resource from the File menu. You
can select from the following options:


Form: opens the Form Editor to create a form/overlay.



Font: opens the Font Editor to create a font.



Image: opens the Graphics Editor to create an image.

You can also right-click in the Details window to select New, required resource
from the pop-up menu. The selected DesignPro application opens.

Creating a New Scout Task
To create a new Scout task (event), select New, Scout Task from the File menu. The Elixir
Scout Manager opens to create the new task. See the Elixir Scout Manager User Guide for
more information.

You can also right-click in the Details window to select New, Scout Task from
the pop-up menu.
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Opening a Resource File
You can open a resource file by selecting it from the Details window and performing one
of the following functions:


Select File, Open from the menu.



Press Enter on the keyboard.

The selected file opens in the associated application. If you select a folder in the Details
window, the contents of the selected folder display.
Only those files open that have an associated program to open them. If a selected
file format does not have an associated program, the Windows dialog displays
for choosing the required program.

You can right-click a file/folder in the Details window to perform any standard
Windows operation available in the pop-up menu.

Mapping a Physical Folder to a Virtual Folder
You can organize the resources anywhere on your computer using the Manager. Instead of
accessing the resources from the default Elixir directory (drive:/Elixir/Resource folders),
you can map these folders in the virtual directory structure to access these folders from the
Resources window.
To map a new physical folder to the virtual folder structure:
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1

In the Resources window, browse to the target resource folder.

2

Right-click the target resource folder and select Map New Folder from the pop-up
menu.
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The Browse for Folder dialog displays.

3

Browse to select the required folder.
You can also create a new folder and map it to a virtual folder. Browse to a
required location in the Browse for Folder dialog, and then click Make New
Folder to create a new folder.

4

Click OK to map the folder.
The virtual folder is named by default. You can change the display name of the
virtual folder; right-click the folder, select Rename from the pop-up menu, and enter
a new display name for the folder. This will not change the name of the physical
folder.

The name of the virtual folder and location of the physical folder mapped to the
virtual folder, both display in the Details window header bar.
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Moving or Copying Files Across Virtual and Physical Folders
You can move/copy files from a physical (or virtual folder) to another physical (or virtual
folder) using a simple drag and drop operation. Similarly, you can move a physical folder
up or down a tree structure by dragging and dropping it from one location to another.
To move/copy a folder or a file from one physical folder to another:

1

Select the required folder/file.

2

Click one of the following buttons on the Standard toolbar:


: moves the selected file to the destination folder. The file is removed from its
source folder. You can also select Edit, Move to Folder from the menu.

: copies the file and pastes the copy in the destination folder. The original file
remains in the source folder. You can also select Edit, Copy to Folder from the
menu.
The Browse for Folder dialog displays in both cases to select the destination folder.



3

Browse to select the required folder.

4

Click OK to perform the selected operation.

You cannot move a virtual folder from its default position in the tree.

You can undo a move or a delete action on files or folders by performing either of
the following functions:
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Select Edit, Undo from the menu.
Right-click in the Details window, and select Undo from the pop-up menu.
Press Ctrl + Z on the keyboard.
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Copying Files
To copy a folder/file:


Select the folder/file, and then click

on the Standard toolbar.



Select the folder/file, and then select Edit, Copy from the menu.



Right-click the folder/file, and then select Copy from the pop-up menu.



Select the folder/file, and then press Ctrl + C on the keyboard.

Cutting Files
To cut a folder/file:


Select the folder/file, and then click

on the Standard toolbar.



Select the folder/file, and then select Edit, Cut from the menu.



Right-click the folder/file, and then select Cut from the pop-up menu.



Select the folder/file, and then press Ctrl + X on the keyboard.

Pasting Files
To paste copied or cut folder(s)/file(s) in another folder:


Select the folder, and then click

on the Standard toolbar.



Select the folder, and then select Edit, Paste from the menu.



Right-click the folder, and then select Paste from the pop-up menu.



Select the folder, and then press Ctrl + V on the keyboard.

Renaming Files
You can rename a folder/file by performing any of the following functions:


Select the folder/file, and then select Edit, Rename from the menu.



Right-click the folder/file, and then select Rename from the pop-up menu.



Select the folder/file, and then press F2 on the keyboard.
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Deleting Files
You can delete a folder/file by performing any of the following functions:


Select the folder/file, and then click

on the Standard toolbar.



Select the folder/file, and then select Edit, Delete from the menu.



Right-click the folder/file, and then select Delete from the pop-up menu.



Select the folder/file, and then press Del on the keyboard.
When deleting Elixir Legacy Font (HDR) files, you can choose to either delete
only the HDR file or automatically delete all files (HDA, GLH, and FLY files)
associated with the selected HDR file. These related files have the same name as
that of the HDR file.
To automatically delete the HDA, GLH, and FLY files along with the selected
HDR file, check Delete Related Elixir Legacy Font Files in the General
category of the Options dialog. When this option is unchecked, only the HDR
file is deleted and the related files remain unaffected.

Deleting Files in Different Formats
DesignPro Manager displays a list of files that have the same name but different formats,
which you can also delete, if necessary.
To view the different formats of a file, and then delete them:
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1

From the Resources window, browse to the directory in which the required file is
located.

2

The resource files in the selected directory display in the Details window.

3

Select the required file from the Details window.
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4

Select View, Formats from the menu.
The File Formats dialog displays.

The File Formats dialog displaying the different formats found for an Elixir Form in
the virtual folders mapped for forms.
Based on the selected file type, the Manager searches all the virtual folders mapped for
that type, and then all files with the same name as that of the selected file are enlisted in
the File Formats dialog. For example, if Waterl.efr (Elixir Form) is selected, all the
virtual folders mapped for Forms (in the Resources tree) will be searched for files with the
name Waterl.
The File Formats dialog lists the files under the following column heads:




File Formats: specifies the format of a file.
Virtual Folders: specifies the parent virtual folder of a file.
Paths: specifies the physical location of a file.

You can also view the file formats by performing either of the following functions:



Right-click the required file and select Formats from the pop up menu.
Select the required file and press Ctrl + F on the keyboard.

5

Check the required format(s) to be deleted.
To delete all the formats displaying in the list, check Delete All.

6

Click Delete.
The selected file(s) in the File Formats dialog are deleted from the directory.
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Unmapping Virtual Folders
To remove a folder from the virtual directory structure:

1

In the Resources window, right-click the required folder and select Unmap Folder
from the pop-up menu.
A message box Unmap Folder displays to confirm the delete operation.

2

Click Yes to unmap the virtual folder.
The required folder is removed from the virtual directory structure. The physical
folder mapped to it is not deleted.

Viewing Folder Properties
DesignPro Manager displays the attributes of the physical folder mapped to a virtual
folder. To view the folder properties, right-click the required virtual folder from the
Resources window, and select Properties from the pop-up menu. The Windows-standard
property dialog for the associated (mapped) physical folder displays. You can view the
folder attributes (such as type, size, location, date and time of creation, etc.), and specify
the various folder settings (such as, sharing and security, etc.) using the property dialog.

Selecting Folder Contents
The following options are available to select/de-select the contents of a folder displaying
in the Details window:
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Select Edit, Select All from the menu to select all of the contents of a folder. You can
also press Ctrl + A on the keyboard to perform this action.
Select Edit, Deselect from the menu to de-select the selected contents.
Select Edit, Invert Selection from the menu to de-select the selected contents, and
select the de-selected contents from a folder. You can also press Ctrl + I on the
keyboard to perform this action.
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Moving Between Folders
To move between the folders, the following options are available on the Standard toolbar:


: moves back to a visited folder.



: moves forward to a visited folder.



: moves to the parent folder.

Creating Application Shortcuts
DesignPro Manager provides a My Shortcuts tab in the Navigation window to create and
maintain custom application shortcuts. These shortcuts are used to quickly open Windows
and DOS based applications from the Manager. Using this tab, you can create a shortcut
icon to open the Elixir web site. You can also delete shortcut icons, and view or edit
shortcut icon properties.

Creating a Shortcut
To create a shortcut in the Manager:

1

Click My Shortcuts tab in the Manager.

2

Right-click in the My Shortcuts view, and select New Shortcut from the pop-up
menu.
The Elixir Shortcut Wizard displays.

3

Click Next to continue creating a shortcut.
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The following image shows the steps involved in creating a shortcut:
1. Open the Elixir
Shortcut Wizard.

2. Click Next to continue.
3. Specify the required application
properties in the General dialog.
4. Specify the
additional
parameters in
the Settings
dialog.

6. The specified
shortcut displays in
My Shortcuts tab.
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5. Click Finish to
create the shortcut.
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The General and Settings properties that you will set in steps 3 and 4 of the image are
explained as follows:
Specifying General Properties
You can specify the following settings in the General dialog:

4

Select the appropriate Application Type option. Either:
 Windows: specifies the shortcut links to a Windows-based application/file.
 DOS: specifies the shortcut links to a DOS-based application/file.
For DOS-based applications, you can check Pause After Execution to let the
Command Prompt window remain open after the application executes until you
close it. Typically, the window closes automatically after the application
executes.

5

In the Link Name entry box, specify a meaningful name for the shortcut.
The name specified here displays in the My Shortcuts tab.

6

In the Target entry box, specify the required application/file based on the selected
Application Type. Click
adjacent to the Target entry box to display the Open
dialog. Browse to the required file, select it, and then click Open. Alternatively, you
can enter the appropriate file name and location in the entry box.
The shortcut will use the specified path to execute the shortcut command.
The following options are available in the Open dialog:





File Name: displays the name of the selected file.
Files of Type: displays the files of the selected type only. You can select the
required file type from the drop-down list. The options available are:
Program Files, Batch Files and All Files.
Open as Read-Only: specifies to open a file in read-only mode. You can
check this option so that the selected file cannot be altered.

7

In the Program Arguments entry box, enter the parameters if required by the
application specified in step 6.
These parameters will be used to execute the application each time the shortcut is
run. For example, if you are creating a shortcut to a web site, you need to specify the
web site name in the Program Arguments entry box.

8

Click Next.
The Settings dialog displays.
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Specifying Additional Parameters
You can specify the following options in the Settings dialog:

9

In the Start In entry box, specify a working directory for the application. The
specified path identifies the location for temporary files when the shortcut runs.
Enter the required path, or click
Folder dialog.

to locate the directory using the Browse for

The DesignPro applications use drive:\Program Files\Elixir Technologies\Bin as the
default working directory. For DesignPro application shortcuts, it is
recommended to use the path where the DesignPro executable reside.

10 Specify the required state of the application window when you run the shortcut. You
can select from the following options available in the Run drop-down list:
 Normal Window: displays the application window in the normal state.
 Minimized: displays the application window minimized in the taskbar.
 Maximized: displays the application window in the maximized state, utilizing
the entire screen area.

11 From the Icon drop-down list, select an icon for the shortcut.
A preview of the selected option is displayed in the Icon Preview area.

12 Click Next to continue creating the shortcut.
The Elixir Shortcut Wizard dialog displays.

13 If you want to modify any settings, click Back or click Finish to create the shortcut.
The shortcut icon and name displays in the My Shortcuts tab.
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Creating a Shortcut to Elixir Web Site
To create a shortcut to the Elixir web site:

1

Right-click in the My Shortcuts tab, and select New Shortcut from the pop-up
menu.
The Elixir Shortcut Wizard dialog displays.

2

Click Next to continue.
The General dialog displays.

3

Select Windows as the Application Type.

4

Enter a name (such as Elixir) for the shortcut in the Link Name entry box.

5

In the Target entry box, enter the location of the required internet browser, for
example, c:\Program Files\Internet Explorer\Iexplore.exe.
You can click

6

to locate the program file.

Enter www.elixir.com in the Program Arguments entry box.

If you do not enter the web site name, the shortcut will open the web page set as
default on your computer.

7

Click Next to go to the Settings dialog.

8

Set the appropriate shortcut preferences from the Run and Icon drop-down lists.

9

Click Next to continue.

10 Click Finish.
The shortcut displays in the My Shortcuts tab of the Navigation window.

Viewing Shortcut Properties
To view the shortcut properties, right-click the required shortcut in the My Shortcut tab
from the Navigation window, and select Properties from the pop-up menu. The
Windows-standard property dialog for the associated application displays. You can view
the application attributes (such as type, size, location, date and time of creation, etc.), and
the shortcut attributes specified at the time of creation. You can also view/edit the shortcut
security settings using this property dialog.
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Deleting a Shortcut
To delete a shortcut:

1

Right-click the required shortcut from the My Shortcuts tab in the Navigation
window.

2

Select Delete from the pop-up menu.
A confirmation message displays.

3

Click Yes to delete the selected shortcut.

Setting Shortcut Preferences
DesignPro Manager opens multiple files by dropping them on the relevant application
shortcuts. You can choose to either open a single instance of the application and all of the
required files in it, or open multiple instances for opening each file.
To specify your preferences:

1

Select Tools, Options from the menu.
The Options dialog displays.

2

Select the General category.

3

Check the following options:
 Launch Single Instance for DOS Shortcuts: opens a single instance of a DOS
application for all files.
If unchecked, multiple instances will be opened for each file.
 Launch Single Instance for Windows Shortcuts: opens a single instance of a
Windows application for all files.
If unchecked, multiple instances will be opened for each file.

4

Click Apply, and then click OK to save the settings.

You can reverse the effect of this setting by pressing ALT on the keyboard, and
then dropping the files onto a shortcut.
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Section II: Managing and Converting
Resources
Chapter 4: Managing Resources
This chapter provides information on DAT files, resource searching and replacement
features, resource packaging functions, and gathering resource settings for diagnostic
purposes.
Chapter 5: Using Converters
This chapter explains how to convert resource files to different formats, including steps
for opening and saving setup (*.epm) files and converting Windows fonts.
Chapter 6: Automating the Conversion Process
Describes command line parameters and methods for setting up and running the
Command Line Converter, and automating the Converters using Elixir Scout Manager.
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Chapter 4:

Managing Resources
In this chapter...


DAT Files



Resource Searching and Replacement



Packaging Resources



Collecting Diagnostic Information

DAT Files
A DAT file is an ASCII file containing form (overlay) references and additional script
commands for composing Normalized data streams. Each DAT file has to contain at least
one form. Script commands are not used with every printer, and are not required to
complete a DAT file.
The following sections describe the operations that you can perform on a DAT file:

1

Creating a DAT File (page 73)

2

Working with DAT Files (page 76)

Creating a DAT File
DesignPro Manager creates DAT files containing form references and script commands.
To create a DAT file in Manager, click the DAT File tab in the Manage window. The DAT
File tree displays with the parent node DAT File. You can add form references and script
commands to the DAT File node, and then export them to a DAT file (*.dat).
Topics in this section explaining the above mentioned features are:


Adding Form References to a DAT File (page 74)



Adding Script Commands to a DAT File (page 75)
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Adding Form References to a DAT File
To add a form reference to a DAT File:

1

Click the DAT File tab in the Manage window.

2

Right-click the DAT File node and select Insert Form from the pop-up menu.
The Open dialog displays.
You can also add another form by right-clicking an already added form from the
DAT File tab, and then selecting Insert Form from the pop-up menu. You can
select the required form from the Open dialog that displays.

3

Search Look In for the required target folder.

4

Select one of the following formats from the Files of Type drop-down list:
 Elixir Form (*.efr)
 Elixir Legacy Forms (*.elx)
 Elixir PrintDriver Forms (*.ep)
 Windows EMF Files (*.emf)
 Xerox Form Object Files (*.frm)
 Xerox Form Source Files (*.fsl)
The Open dialog displays the list of available forms in the selected format.

5

From the Insert As drop-down list, select either of the following options:
 Filename Only: saves only the selected filename with the resource. On opening
the file again, the resource is retrieved from the locations given in the related
converter settings.
 Relative Path To ProfileServer Root: saves the path for the resource, relative to
the path defined in the current profile being used in the application.

For information on profiles, refer to Chapter 9: “Elixir Profile Editor” on page 207.
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Absolute Path: saves the absolute path where the resource is located.
Embedded: embeds the resource in the project. Using this option, you can
include the resource in your project without having to refer it from another
location.
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6

Select the required form, and then click Open.
The form reference displays as a child node of the DAT File node in the Manage
window.
You can open multiple forms by pressing Ctrl and clicking on the forms you want
to select in the Open dialog. Click Open and the form references are displayed
as sub-nodes of the DAT File node.
You can also add a form reference using the following steps:
Browse to the required folder from the Resources window or the
Explorer window, such that the required forms display in the Details
window.
 Select the required form(s) from the Details window, drag, and then drop
them in the Manage window (DAT File tab).
The required forms are added as sub-nodes under the DAT File node. The subnode name indicates the file path, name, and extension.


Adding Script Commands to a DAT File
To add a script command to a DAT File:

1

Click the DAT File tab in the Manage window.

2

Right-click the DAT File node, or an overlay (form) node and select
Insert Command from the pop-up menu.
A secondary pop-up menu displays.

Image shows the options available for adding script commands.
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3

Select the required script commands:
 Simplex: prints a form on single side; required for some duplex-only printers.
 Input Tray: adds a form to the Input Tray. Once added, you can edit the tray
name and/or number as necessary to match your printer specifications.
 Output Tray: adds a form to the Output Tray. Once added, you can edit the tray
name and/or number as necessary to match your printer specifications.
 Copies: makes copies of a form. Once added, you can modify the number of
copies required.
The specified script command is added to the DAT file.

4

Export the DAT file.
For information on exporting the DAT file, see “Exporting a DAT File” on page 77.

Working with DAT Files
You can perform operations with DAT files, such as opening referenced forms from a DAT
file, reordering form references and script commands, and deleting required form
references or script commands from a DAT file. Operations for exporting or importing
DAT files are also supported in the Manager.

Opening a Form from a DAT File
Referenced forms can be opened directly from the DAT File tab.
To open a referenced form, right-click the required form node from the DAT File tree and
select Open Form from the pop-up menu. The form opens in the Form Editor.

Reordering Form References or Script Commands in a DAT File
To reorder existing form references or script commands in a DAT file, click and drag a
selected form reference or script command to the required location within the DAT File
tree. The selected form reference or script command moves up or down the DAT File tree
as placed.

Deleting Form References or Script Commands in a DAT File
To delete a form reference or script command added to a DAT file, right-click the required
form reference or script command node and select Delete from the pop-up menu. The
selected node is deleted.
You can delete all of the forms and commands from the DAT file by right-clicking the
DAT File node and selecting Delete All from the pop-up menu.
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Exporting a DAT File
After you have added all of the required form references and script commands to the DAT
File tree, you can export it to the DAT File format for conversion.
To export a DAT file:

1

Right-click the DAT File node in the Manage window.
A pop-up menu displays.

2

Select Export.
The Save As dialog displays.

3

Select Dat File (*.dat) from the Save As drop-down list.

4

Browse to the target folder from the Save In drop-down list where you want to save
the DAT file.

5

Specify the DAT file name in the File Name entry box.

6

Click Save.
The DAT file (*.dat) is exported to the target location.

Importing a DAT File
DAT files can be imported into the Manager for viewing, editing and exporting. An
imported DAT file does not merge with an open DAT file.

Export any changes made to an open DAT file before importing a new DAT file.
Changes made to an open DAT file are saved only when it is exported.
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To import an existing DAT file:

1

Select Import from the File, DAT File menu.
The Open dialog displays.

2

Select DAT Files (*.dat) from the Files of Type drop-down list.

3

Browse to the target folder from the Look In drop-down list and select an existing
DAT file.
The File Name entry box updates with the name of the selected file.

4

Click Open.
The specified DAT file is imported in the Manager.
You can also import a DAT file using the Manage window. Right-click the DAT
File node and select Import from the pop-up menu. Select the required file
from the Open dialog that displays.

Resource Searching and Replacement
DesignPro Manager helps to search for linked or embedded fonts/images being used in a
form. Options to replace the resources (image or fonts file) used within the form(s) are
also available. Manager also helps to simultaneously replace a resource used in multiple
files. These features are available in the Resource Search tab of the Manage window.

You can display or hide the Manage window by selecting View, Manage
Window from the menu.

Topics included in this section explaining the above mentioned features are:
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Resource Searching (page 80)



Configuring Resource Search (page 83)



Image Replacing (page 84)
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The Manage window displaying the Resource Search options:

Options available for specifying the
required resource search criteria.

The search result obtained.

Options available for
replacing resource(s).
Configuration options.

To look for a resource (font or image) used in a form, Manager requires the resource name
and/or type; format, and usage type as the search criteria. Search results then display the
list of paths and form name(s) that include the specified font and/or image resource
name(s).
Once the search result is obtained, you can perform the following functions:


Generate a search report.



Replace the settings (EPM) file for selected resource(s) in the form.



Replace the selected image resource(s) in the form.

The resource searching functionality is made easier by an indexing service operating in
the background. You can also configure the indexing service parameters to suit your
needs.
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Resource Searching
The resource searching feature in the Manager enables you to specify a resource search
criteria and look for the required resource in forms located at a given path. You can specify
the required path by setting the resource search preferences. For details, refer to
“Configuring Resource Search” on page 83.
Forms of the following formats are included in the search operation:


Xerox Object Overlays (*.frm)



Xerox Source Overlays (*.fsl)



Elixir Overlays (*.efr)



Elixir Legacy Overlays (*.elx)

Searching a Resource
To search for a resource:

1

Click the Resource Search tab in the Manage window.

2

Specify the required resource search criteria.
For details, refer to “Specifying the Resource Search Criteria” on page 81.

3

Click Search.
The search result displays in the list box. For details on viewing the search result,
refer to “Viewing the Search Results” on page 82.

You can discontinue the search operation at anytime by clicking Stop.
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Specifying the Resource Search Criteria
Various options for specifying the resource search criteria are available under the
Resource Search Criteria area. These are as follows:


Resource Name: specifies the stem name of the resource to be searched. Enter the
required name in the associated entry box.

A name entered in the Resource Name entry box for searching.
You can also click
adjacent to the Resource Name entry box. The Open dialog
displays to specify the required resource. File name and path of the selected resource
displays in the Resource Name entry box. However, for search operation, only the
resource name is considered.






Usage Type: specifies how the resource is used in a form. You can select any one of
the following options:
• Linked: searches for resources that are linked to a form.
• Embedded: searches for resources that are embedded in a form.
• All: searches for both linked and embedded resources in a form.
Format: specifies the file format of the resource to be searched. You can select from
one of the following options:
• Elixir: searches for Elixir resources only.
• Xerox: searches for Xerox resources only.
• All: searches for resources of all types (such as Xerox and Elixir).
Resources to Search: specifies the type of resource to be searched. Check the
following options, as appropriate:
• Fonts: searches for fonts only.
• Images: searches for images only.
You can check both the options to search for both fonts and images.
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Viewing the Search Results
After clicking Search, a list of forms that use a font and/or image resource matching the
specified criteria displays in a list box in the Manage window.
The list box contains the following columns:


Files: displays the name and location of the form. You can click
adjacent to the
file name, to open the input format property dialog associated with the file format.
For example, the Xerox LPS Resource Parser dialog displays for Xerox Object
Overlay (*.frm) and the Elixir dialog displays for Elixir Form files (*.efr).

For information on all the options available in the selected input format property
dialog(s), click



on the top-right corner of the dialog.

Setting Files: displays the settings file (EPM) associated with the form.
For specifying a different setting file, see “Replacing the Settings File” on page 86.
The search result is grouped by the resource types that are identified by their
respective icons:
: identifies the form path and name containing the specified image resource.
: identifies the form path and name containing the specified font resource.

Generating a Search Report
To generate and export the search results to a Web Page (HTM) file:
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1

Click Save Report.
The Save As dialog displays.

2

Select Web Page (*.htm) from the Save As drop-down list.

3

Browse to the target folder from the Save In drop-down list where you want to save
the search report file.

4

Specify the file name in the File Name entry box.

5

Click Save.
The Web Page file containing the search result is created at the specified location.
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Configuring Resource Search
DesignPro Manager monitors the forms by maintaining an indexed record of all of the
forms located at a given path. The images and fonts used in each form are stored in this
record. An indexing service runs in the background for creating and updating this record.
The indexing service performs the following operations:


Indexes new file(s) and records the font and image resources in that file.



Re-indexes the updated file(s).



Deletes the files (from the indexed record) that have been deleted from the path
being monitored.

To configure the indexing service for resource searching:

1

Click Configure in the Resource Search Configuration area of the Manage
window.
The Elixir Resource Index Service Configuration dialog displays.

You can select
or enter the
monitoring
interval in
minutes.

2

Click this button
and browse to
the required
path.
Specify the
required EPM
file.

Specify the following options:
 Path to Monitor: specifies the directory in which the forms to be monitored
reside. At the time of installation, this path is set to drive:\Elixir by default. Enter





the location of another directory if required, or click
to open the Browse for
Folder dialog. You can then select the required directory and click OK.
Monitoring Interval: specifies the time interval after which to monitor the
configured directory for any new or changed files. The time is specified in
minutes.
Settings File: specifies the settings file that is used while opening and searching
the forms. By default, the settings file for Manager (drive:\Documents and
Settings\username\Application Data\Elixir Technologies\DPTManager.epm) is
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used. Enter the location of another settings file if required. Alternatively, you can



click
to display the Open dialog, and then select the required settings file
(EPM) and click OK.
Enforce ReIndexing (Ignore Date Time Stamp): specifies to re-index all of the
supported forms in the specified directory, every time indexing executes as per
the schedule. You can uncheck this option to re-index the changed files only. The
Manager recognizes the changed files by checking the date-time stamp of each
file.

To change format settings in the specified settings (EPM) file:

3

Click Set adjacent to the Settings File entry box.
A pop-up menu displays that contains file format options associated with the settings
file.

4

Select any one of the format options to open the associated property dialog.

5

Review the dialog selections and make changes as required.

6

Click Apply, and then click OK to update the settings file.

7

Click Save to return to the Manage window.
The specified configurations are applied to the indexing service.

Image Replacing
DesignPro Manager helps you to replace an image used in multiple forms with another
image. This removes the need to open each form in the Form Editor, and then replace the
image manually for each required file. For example, if your company changes its logo, it is
required to replace the old logo (image) with the new logo in the company documents. In
such cases, you can make use of the image replacing feature in the Manager to replace all
of the logo images simultaneously.
Topics included in this section explaining the above mentioned features are:
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Replacing Image(s) (page 85)



Generating Backups (page 86)



Replacing the Settings File (page 86)
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Replacing Image(s)
To replace an image(s):

1

Check the required form(s) from the search result list box.
The Image Replacing Options become enabled.

2

Click

3

Select an image type from the Files of Type drop-down list. You can choose from
any of the following file types:
 Xerox IMG and Xerox LGO (*.img, *.lgo)
 Elixir Legacy Graphic (*.lp3)
 Image files (*.bmp, *.jpg, *.jpeg, *.tif, *.pcx, *.png)

4

Select one of the following options from the Insert As drop-down list:
 Filename Only: saves only the selected filename in the form. On opening the
form again, the resource is retrieved from the locations given in the related
converter settings.
 Relative Path to ProfileServer Root: saves the path for the resource, relative to
the path defined in the current profile being used by the application.

adjacent to the New Image entry box to display the Open dialog.

For information on profiles, refer to Chapter 9: “Elixir Profile Editor” on page 207.




5

Absolute Path: saves the absolute path where the resource is located.
Embedded: embeds the resource in the resource. Using this option, you can
include the resource in your form without having to refer it from another
location.

Browse to the target folder from the Look In drop-down list and select the required
image.
The File Name entry box updates with the name of the selected file.
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6

Click Open.
The New Image entry box updates with the name of selected image. You can also
directly enter the required image name and extension in the New Image entry box.

7

Click Replace Image.
The required image(s) in the checked form(s) is replaced with the new image
resource. Messages generated during the replacement display in the Messages
window.

Generating Backups
Before you replace image(s), it is recommended to create a backup of the forms involved.
To generate a backup, check Backup Files in the Image Replacing Options area. A
backup file for each form being changed is created in the same directory where the
original file is located. Backup files are created with the BAK extension.

Replacing the Settings File
To replace a settings file (EPM):
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1

Check the required form(s) from the search result list box.
The Image Replacing Options become available.

2

Click

3

Select Settings File (*.epm) from the Files of Type drop-down list.

4

Browse to the target folder from the Look In drop-down list and select the required
file.
The File Name entry box updates with the name of selected file.

5

Click Open.
The selected file name displays in the Settings File entry box. You can also directly
enter the required settings (path, file name and extension) in the Settings File entry
box.

6

Click Replace.
The setting file(s) associated with the selected form(s) is replaced with the new
settings file. You can view the updated file name in the Settings File column.

adjacent to the Settings File entry box to display the Open dialog.
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Specifying Converter Settings
After specifying a new file in the Settings File entry box, you can change the conversion
parameters defined in the file (if required).
To change the converter settings in the specified EPM file:

1

Click Set in the Image Replacing Options area.
A pop-up menu displays.

2

Select any one of the following options:
 FRM: displays the Xerox LPS Resource Parser dialog.
 FSL: displays the Xerox FSL Parser dialog.
 ElixirGDF: displays the ElixirForm dialog.
 Native: displays the Elixir dialog.

3

Review the dialog selections and make changes as required.

4

Click Apply, and then click OK to return to the Manage window.
The Settings File (EPM) is updated.

Packaging Resources
Manager provides the facility to package your required resource files in a single Zip File
(*.zip). You can specify the required resources simply by using drag and drop. For
supported file formats, all of the dependent resources of the specified resource can also be
included. For example, if you specify to package an Elixir Form (.efr), the images, fonts,
and other resources used in the form are automatically included in the package.
The supported formats for packaging are as follows:


Xerox Object Overlays (*.frm)



Xerox Source Overlays (*.fsl)



Elixir Overlays (*.efr)



Elixir Legacy Overlays (*.elx)



Data Files (*.dat)



Printer Command Language (*.pcl)
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Resource packaging involves the following steps:


Creating a Package (page 88)



Generating a Package Report (page 90)

Creating a Package
To create a package of resources:

1

Click the Resource Package tab in the Manage window

2

Browse to the required directory using the Resources window or the Explorer
window.
The resources available in the directory display in the Details window.

3

Check Parse for Dependencies for also including the dependent resources in the
package as separate files.

4

Check Show Embedded Resources for displaying the embedded resources in the
Resource Package list box. Embedded resources are a part of the file itself and
therefore, will be a part of the package automatically.

5

Drag the required resource file from the Details window, and drop it in the Resource
Package list box.
The specified resource node is added to the package list and identifies the path from
where it is specified.
 For supported formats, the dependent resources (both referenced and embedded)
are also added to the package list as sub-nodes of the parent resource. The
dependent resources are categorized on the basis of their types (fonts, images,
palettes, etc.). The sub-nodes representing the embedded resources in a form are
marked as Embedded. A check box is available with each node in the package
list.
 Files of a non-supported format are simply added in the package list (without any
dependencies/sub-nodes).
The package list is maintained in the ascending order.

You can also select multiple files and drop them on to the Resource Package
list box.
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6

Expand the resource nodes and check the required resources to be included in the
package.
You can check a node and click Remove to delete a required resource from the
Resource Package list box. Click Remove All to clear the list box completely.

7

Click

8

Select Zip Files (*.zip) from the Files of Type drop-down list.

9

Browse to the required destination directory from the Look In drop-down list, and
specify a name for the package in the File Name entry box.

to open the Select Package File Name dialog.

10 Click Open.
The Package Path entry box updates with the specified file name and path. You can
also directly enter a name and destination path for the package in the Package Path
entry box.

Specify the required
options for dependent
resources.

Identifies the resources
to be packaged.

Specifies the path where the
package is created.

The Resource Package list box displaying the Xerox resources to be packaged for
EFR and FRM forms.
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11 Click Create Package.
The package is created at the specified path.
Generating a Package Report
To generate and export the list of package resources as a Web Page (HTM) report.
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1

Click Save Report.
The Save As dialog displays.

2

Select Web Page (*.htm) from the Save As drop-down list.

3

Browse to the target folder from the Save In drop-down list where you want to save
the package report file.

4

Specify a file name in the File Name entry box.

5

Click Save.
The Web Page file containing the package list is created at the specified location.
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Collecting Diagnostic Information
DesignPro Manager helps to gather your system information, along with all of the
DesignPro application settings and configurations. This information that you provide
assists our customer support to recreate your PC environment, which might be required in
order to replicate any application issues occurring at your end.
The information collected by Manager is packaged into a Zip File (*.zip) and contains the
following:










System Information: includes processor, memory, operating system and service
pack information. The version number and file size of the enlisted Bin files is also
included.
Elixir Directories Settings: includes Elixir directory information and a listing of
files in the Bin directory (drive:\Program Files\Elixir Technologies\Bin). The
version number and file size of the enlisted Bin files is also included.
An XML file (DPTDiagnosticXML.xml) is generated that contains the system
information, and the Elixir directory settings.
Elixir Setting Files: includes all setting files (EPM) located at dirve:\Documents
and Settings\username\Application Data\Elixir Technologies\.
Elixir Registry Settings: includes all Elixir related registry settings from the
Current User and Local Machine paths. These settings are exported to Registry Files
(REG) that are packaged.
Elixir Log Files: includes information about the various Elixir applications installed
on your PC and their version numbers. This also includes information about the older
versions installed previously and patch information. The two Log Files (Install.log,
and Version.log) contain this information. Elixir product license information is also
included in the form of Password Files (*.epw).
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Packaging Diagnostic Information
To package the system diagnostic information:

1

Click the Diagnostic Information tab in the Manage window.
The Manage window - Diagnostic Information tab displays:

Displays a list of the
information contained in a
package.

Specifies the destination
directory and name of
package.
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2

Click
adjacent to the Package Path entry box in the Options area.
The Select Diagnostic File Name dialog displays.

3

Select Zip from the Files of Type drop-down list.

4

Browse to the required directory from the Look In drop-down list where you want to
create the packaged file.

5

Specify a name for the packaged file in the File Name entry box.

6

Click Open to return to the Manage window.
The Package Path entry box displays the specified file name and location.

7

Click Create Package.
A packaged file (ZIP) is created at the specified location and contains the required
diagnostic information.
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Chapter 5:

Using Converters
In this chapter...


Converting Files to Different Formats



File Types Supported by Converters



Print File Conversion Process



Customizing the Converters

Converting Files to Different Formats
DesignPro Manager, Converters provides the facility to convert varying input file formats
including documents, images, forms, and fonts to different supported output file formats.
You can also convert resources from the Tools menu of all DesignPro applications like
Form Editor, Graphics Editor, and Font Editor.
Converting resources is necessary when resources used in a design are needed but they are
not in the required format. Conversion is often required while printing, when you need all
of the resources in the same format as the target format. For example, while converting a
Xerox document to PDF format, all of the Xerox resources such as overlays (forms),
images, fonts, documents need to be converted to PDF format in order for the finished
document to match with the original.
You can create resources for Xerox printers by coding or by using an application that
creates those formats. You can also change the default file format property options for
supported file types before conversion.

For information on all of the options available in the Converter dialog(s), click
on the top-right corner of the dialog.
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Converters can create multiple target formats from a single resource. You can also convert
multiple resources with the same file extensions simultaneously to single, or multiple
target formats. This helps in converting several resource types without using each
DesignPro Editor individually.

File Types Supported by Converters
Converters can convert any of the following supported input formats to any of the
supported output formats, as required:

Input Formats
Converters support conversion of the following input formats:
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Document Files: the supported input formats for Documents are listed below:
• Elixir Dat Files (*.dat)
• Elixir Document Files (*.edf)
• Elixir Legacy Document Files (*.gdf)
• Elixir PrintDriver Document Files (*.epl)
• PCL Files: HP Print Control Language Document Files (*.pcl, *.prn)
• Xerox LCDS/Metacode (*.met, *.mta, *.nor)
Font Files: the supported input formats for Fonts are listed below:
• Elixir Legacy Font Files (*.hdr)
• ATM Type 1: Adobe Type Manager Type 1 fonts
• PCL: HP Print Control Language Font Files (*.flj, *.pcl)
• True Type: Windows-based outline fonts
• Xerox Font Files (*.fnt)
Form Files: the supported input formats for Forms are listed below:
• Elixir Form Files (*.efr)
• Elixir Legacy Form Files (*.elx)
• Elixir PrintDriver Form Files (*.ep)
• Xerox Form Object Files (*.frm)
• Xerox Form Source Files (*.fsl)
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Image Files: the supported input formats for Image types are listed below:
• Elixir Legacy Graphic Files (*.lp3)
• BMP Files (*.bmp)
• JPEG Files (*.jpg; *.jpe; *.jpeg)
• PCX Files (*.pcx)
• PNG Files (*.png)
• TIFF Files (*.tif)
• Xerox IMG and Xerox LGO (*.img, *.lgo)

Output Formats
Converters support conversion of files in the following output formats:






Document Files: the supported output formats for Documents are listed below:
• Elixir Document Files (*.edf)
• Elixir Legacy Form Files (*.elx)
• PCL: HP Print Control Language Document Files (*.pcl, *.prn)
• Adobe PDF Files (*.pdf)
• PostScript: Postscript Files (*.ps)
• Xerox Metacode Files (*.met, *.nor, *.mta)
Font Files: the supported output formats for Fonts are listed below:
• Elixir Legacy Font Files (*.hdr)
• PCL Font: HP Print Control Language Font Files (*.flj, *.pcl)
• PostScript Font Files (*.ps)
• Xerox Font Files (*.fnt)
Form Files: the supported output formats for Forms are listed below:
• Elixir Form Files (*.efr)
• Elixir Legacy Form Files (*.elx)
• Image Files (*.tif, *.lp3, *.img, *.seg)
• PCL Page Files (*.pcl)
• PDF Page Files (*.pdf)
• PostScript Files (*.ps)
• VIPP Files (*.vip)
• Xerox Form Object Files (*.frm)
• Xerox Form Source Files (*.fsl)
• Xerox Metacode Files (*.met, *.mta, *.nor)
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Image Files: the supported output formats for Image files are listed below:
• Image Files (*.tif, *.lp3, *.img, *.seg)
• Tile to Font Files (*.hdr)
• Xerox IMG and Xerox LGO Files (*.img, *.lgo)

Print File Conversion Process
Converters is an efficient file conversion program that provides a central location for
converting all data and resource types (documents, forms, fonts, and images). You can
convert resources for your application to single or multiple supported formats without
leaving DesignPro Manager. For example, you can convert more than one Elixir Legacy
fonts to Xerox fonts in a single go, using the Converters in the Manager. This saves you
from converting each resource individually using the Font Editor.
A typical file conversion process includes the following phases in the given sequence:
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1

Identify, Prepare, and Stage the Resources (page 97)

2

Opening a Setup (EPM) File (page 97)

3

Setting Up the Conversion (page 99)

4

Changing Input Format Properties (page 101)

5

Changing Output Format Properties (page 103)

6

Specifying the Output File Path (page 104)

7

Starting the Conversion (page 104)

8

Saving the Setup File (page 105)
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Identify, Prepare, and Stage the Resources
Converters emulate printing systems used to process supported data streams; therefore, it
must have access to all resources used by the printing device. These resources can be in
either the Elixir Legacy format (for existing users upgraded from earlier Elixir Desktop
and Converters versions) or printer device native format. Each resource must be identified
before staging to the Converters.
Identify and examine each resource before staging to the Converters. Resources include
all files embedded in the input resource such as documents, fonts, forms, and images.
Resources can vary depending on the input data format specified for conversion. Some
resource types, based on the input formats, are explained as follows:
Xerox Resources
Identify the print file resources, such as forms, fonts, and images and their locations before
conversion when working in the Xerox environment.
The DesignPro Converters does not require specific file extensions for resources;
however, Elixir products traditionally support the following formats:


Forms: *.frm, *.fsl



Fonts: *.fnt



Images: *.img, *.lgo

Opening a Setup (EPM) File
Converters use the EPM file to handle user selected file format options during file
conversion. This setup file can be copied to other PCs or archived for later use.
The setup file (*.epm) is used to store individual input and output property settings and
help the system read the resource settings before and during the conversion process.
The DPTManager.epm is the default EPM file, which is located at the following path:
drive:/Documents and Settings/username/Application Data/Elixir Technologies/.
The default EPM file settings can be changed before starting the conversion process. In
Manager, you can access the required file format property dialogs from the Tools,
Application Format Setting, Input Formats or Output Formats menu options.
Custom input and output conversion settings can be saved in a new setup file, and opened
for use in the appropriate conversion session. For more information on saving a setup file,
see “Saving the Setup File” on page 105.
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After opening the setup file, conversion property options may be changed for both input
and output formats. To overwrite customized conversion settings with default conversion
settings, re-open the default setup file.

Input and Output property options set in the Conversions dialog are
automatically updated in the EPM file opened for the current session.

To open a setup file (*.epm):

1

Select Tools, Application Format Setting, Load from the menu.
The Load Setup File dialog opens.

2

Select Setup Files (*.epm) from the Files of Type drop-down list.

3

Browse the Look In drop-down list to select the required EPM file.
The File Name entry box updates with the selected file name.

4

Click Open to open the selected setup file.
On opening the EPM file, its settings will be copied to the default EPM file. The
Load dialog for EPM files will point towards the last accessed file and folder,
even after re-opening the application.

If some conversion resource paths are not present in the opened setup file
(*.epm), Converters picks the missing resource paths from the paths specified in
the INI file associated with your selected profile. For more information on
profile selection, see Chapter 9: “Elixir Profile Editor” on page 207.

Resetting Customized Conversion Settings to Default
You can revert your customized input and output conversion settings made in the opened
setup file through the Conversions dialog to the default EPM file during or after
conversion by selecting Tools, Application Format Setting, Clear from the menu in the
Manager.
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Setting Up the Conversion
Once the required data and resources are identified and staged, the next phase is to set up
the Converters for file conversion process.
To start up the conversion process, select the required resource file(s) from the Details
window, and perform one of the following functions:





Select File, Convert from the menu.
Drag and drop the file(s) onto the Converters icon,
Navigation window.

in the Applications tab of the

Press Alt + C on the keyboard.

The Conversions dialog opens, displaying the selected input files and the file format. You
can specify the required output formats, and set the input and output conversion settings
before initiating the conversion.
You can specify multiple files for conversion by pressing Ctrl on the keyboard,
and then selecting the required files. You can also press Shift on the keyboard to
select multiple files that are consecutive to each other.
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The following image illustrates the Conversions dialog and the various options:
Type and format of the input resources.

Click this button to specify the settings for
the input file format.

Click this button to
view the specified
input file(s) and file
path(s).

The Outputs area
displays output
formats and paths
available for selection.

When you choose to convert a Windows font, the Registered Font
Properties dialog opens. You can register the Windows fonts by specifying its
settings, and then proceed with the conversion.
For more information on registering and converting Windows fonts, see
“Working with Windows Fonts” on page 105 later in this chapter.

In case of converting multiple resources having the same file extension, input and
output conversion settings defined for one resource are automatically applied to
all resources of the same type. However, you need to initiate a new conversion
process to convert a different resource type.
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Changing Input Format Properties
To change input format properties:

1

Select the required Input Format type from the list of available options.
Options displaying in the input format list depends on the format of the resource that
is dropped onto the Converters.

2

Click
adjacent to the Input Format drop-down list in the Inputs area.
The property dialog for the currently selected input format displays. You can also
select a different format from the Input Format drop-down list, and specify the
properties for that format (if required).
The input format dialog for Elixir:

3

Select a category to view the associated properties.

4

Review the dialog selections and make your changes.

5

Click Apply and OK to save the settings.
For information on all the options available in the selected input format property
dialog(s), click

Chapter 5: Using Converters

on the top-right corner of the dialog.
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Viewing the Input Files
You can view the input file(s) and associated file path(s) for conversion by clicking
under the Inputs area. The button toggles to

and the Inputs area expands to display a

list of selected Input Files and their locations. You can click

to hide the input files.

The list of Input Files displaying in the Inputs area.
You cannot uncheck the specified input files once they are staged onto the Converters in
the current session.
Selecting the Output Formats
The Outputs area of the Conversions dialog populates according to the input file
selection.
The image below highlights different options available in the Conversions dialog for
specifying the required output:

Check the
required output
formats.

Click this button adjacent to an output
format to change its properties.
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Click this
button adjacent
to an output
format to
change the
destination
folder for an
output file.
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In the Outputs area, select one or more available output formats for conversion by using
the check boxes under Output Formats. You can also check All Available Formats to
select all of the output formats.

Changing Output Format Properties
To change output format properties:

1

In the Output Formats list displaying under the Outputs area, click
the required output format.
The property dialog for the respective output format displays.

adjacent to

You can also select multiple output formats simultaneously to convert a single
file to multiple formats in a single step.

The output format dialog for Elixir:
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2

Select a category to view the associated properties.

3

Review the dialog selections and make your changes.

4

Click Apply and OK to save the settings.

For information on all the options available in the selected output format
property dialog(s), click

on the top-right corner of the dialog.

Specifying the Output File Path
The Paths column displays the full path of the destination folder where the generated
output file will be placed. By default, this path is set to the default folders for these
formats at drive:/Elixir. You can click
adjacent to each path individually in order to
specify a different destination folder. The Browse for Folder dialog displays to select the
required folder.

Starting the Conversion
After the required input and output settings are defined in the Conversions dialog, the file
conversion can be initiated. To start the conversion process, click OK in the Conversions
dialog. The conversion status, and informational, error or warning messages (if any)
display in the Messages window of the Manager workspace.
The generated output file is located at the specified output file path. For details of
commonly encountered error and warning messages, refer to
Appendix B: “Error and Warning Messages” on page 337 for details.

104

Section II: Managing and Converting Resources

Saving the Setup File
All input and output conversion settings selected in the Manager or the Conversions
dialog are saved in the default or opened setup file. These settings can be exported or
saved in a new setup file before or at the time of conversion. You can open the customized
setup file for converting selected resources. Any input and output conversion settings
made during conversion are then saved in the customized setup (*.epm) file.
To export or save input and output conversion settings in a new file:

1

Select Tools, Application Format Setting, Save from the menu.
The Export Setup File dialog displays.

2

Enter a file name in the File Name entry box.

3

Select Setup Files (*.epm) from the Save As Type drop-down list.

4

Browse the Save In drop-down list to select the target folder where you want to save
the EPM file.

5

Click Save to save the selected setup file.
You can remove the setup file by selecting Tools, Application Format
Setting, Clear from the menu. A confirmation message is displayed. Click OK
to clear the setup file. The setup (*.epm) file property settings clears, and the
default settings are applied.

Working with Windows Fonts
Converters requires information such as font size, style, orientation and resolution for
converting fonts. Unlike Elixir fonts, Windows fonts do not have the required information
for conversion. Therefore, Manager helps to customize selected Windows fonts to
required output settings before initializing conversion. The required Windows fonts are
customized using the Registered Font Properties dialog.
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Registering Windows Fonts for Conversion
To register Windows fonts for conversion:

1

Select the required Windows font(s), and then select File, Convert from the menu.
The Registered Font Properties dialog opens with the required Windows font(s)
displaying in the Selected Fonts list.

2

Select a font from the Selected Fonts list.

3

Select the required font script from the Script drop-down list.

To set the font specifications:

4

Select the required font size from the Size list. You can also select Custom from the
Size list, and then enter the required font size in the entry box underneath the list.
The font size is specified in points.

5

Select one of the following font styles in the Style area:
 Bold: sets the font style to bold.
 Italic: sets the font style to italics.
 Underline: underlines the selected text.
 Overstrike: draws a line over the selected text.

6

Under the Orientation area, select the required orientation option from the
following:
 Portrait: sets font orientation to portrait.
 Inv. Portrait: sets font orientation to inverse portrait.
 Landscape: sets font orientation to landscape.
 Inv. Landscape: sets font orientation to inverse landscape.

A preview of the selected font with specified size, style, and orientation displays
under the Sample Text area.
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7

Specify a name for the registered font in the Output Name area. Select from the
following options available:
 Custom: sets a custom name for the font. Enter the required name in the Custom
Name entry box.
 Auto: sets an automatically generated name for the font.

The auto-generated
name for a font.

Image shows the Output Name area in the Registered Font Properties dialog.
To specify Character Mapping options:

8

Under the Character Set Mapping area, specify the required start and end character
set range from the Range drop-down lists.

To map a selected Windows character set to another existing/target character set:

9

Check Map Font. For mapping a font to a Keyboard Mapping (KMP) file other than
its original KMP, you need to specify the following:
 Target: select a Keyboard Mapping File from the Target drop-down list
according to the applicable layout (design in which the generated font will be
used). The converted font will be such that it applies to the target layout
appropriately.
 Windows: select a Keyboard Mapping file that is associated with the System
font (being converted). For example, select T100ANSI for a font using the
Western script.
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To set the font resolution in the Resolution area:

10 Select the appropriate font resolution (240, 300 or 600) from the DPI drop-down list.
You can also select Custom from the DPI drop-down list to specify a
resolution other than the available values. Selecting this option enables the
following options in the Resolution area:



Hor: sets font horizontal resolution, in dpi.
Vert: sets font vertical resolution, in dpi.

11 Under the Output Fonts area, click Add to add the font selected in the Selected

Fonts list to the Output Fonts list. The font is added to the list for registration with
the properties specified (explained in the steps above).

You can delete a selected font from the Output Fonts list by clicking Del.

12 Select another font (if any) from the Selected Fonts list, and repeat steps 3 - 11.
13 Click OK to register the fonts added to the Output Fonts list.
The fonts are registered, and the Conversions dialog displays for converting the
registered fonts.

Customizing the Converters
DesignPro Manager provides options to customize the application’s functions. The
Conversion category in the Options dialog provides the default options related to the
conversion process. You can set and review the available options to change the conversion
parameters, as explained in the tasks below:
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Handling Unavailable Output Directories (page 109)



Overwriting Files (page 109)



Error Handling (page 110)



Viewing Parser and Converter Properties (page 110)
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Handling Unavailable Output Directories
DesignPro Converters lets you specify an output directory for placing the file(s) generated
after the conversion process. If a specified directory is not available, the output file does
not generate and an error message displays.
You can set to automatically create an output directory for placing the output file, if the
directory does not already exist. To do so:

1

Select Tools, Options from the menu.
The Options dialog displays.

2

Select the Conversions category.

3

Check Automatically Create Directories that Do Not Exist.

4

Click Apply, and then click OK to save the settings.
The output directory will be automatically created the next time a conversion is run.

Overwriting Files
If a specified output directory already contains a file with the same name as that of the
new file, an informational message displays, and the conversion stops.
To overwrite the existing files:

1

Select Tools, Options from the menu.
The Options dialog displays.

2

Select the Conversions category.

3

Check Overwrite Files.

4

Click Apply, and then click OK to save the settings.
Any existing file(s) with the same name will be overwritten the next time a
conversion is run.
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Error Handling
To stop the conversion process if any of the conversion fails:

1

Select Tools, Options from the menu.
The Options dialog displays.

2

Select the Conversions category.

3

Check Stop All Conversions if One Fails.

4

Click Apply, and then click OK to save the settings.
Conversion process will be cancelled if any of the file conversion fails.

Viewing Parser and Converter Properties
The Manager displays the properties for all of the available parsers and converters
(components) or the resources for a component. You can also register file extensions for a
selected resource using the Info Server category in the Options dialog.
To view the properties of a component or a resource:
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1

Select Tools, Options from the menu.
The Options dialog displays.

2

Select the Info Server category.
The Info Server category shows a tree view displaying all of the parsers and
converters available on the system.
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3

Click adjacent to the required node in the tree to view the associated components.
You can select from:
 Input Parsers
 Output Converters
 Output Data Converters

4

From the View area, click Show All Components to display all of the components
present in your system. The button toggles to Hide Unlicensed Components. You
can click Hide Unlicensed Components for viewing only the licensed components
in the tree.

You can click Refresh to save any changes and refresh the folder tree.

5

Click adjacent to the required component node.
The node expands to display the resources, and the component information displays
under the Component area. The information includes:
 Name: displays the selected component (converter or parser) name.
 ID: displays a unique code identifying the selected component.
 Presentation: displays the text that appears in the file filters of the Open and
Save dialogs corresponding to the selected converter or parser.

6

Select the required resource node.
The resource information displays under the Resource area.
The information includes:
 Presentation: displays a unique name identifying the selected resource node of
the specified component (parser or converter).
 Extensions: displays the extension(s) for the selected resource. You can edit the
file extensions for a resource by specifying the required extension in the entry
box, or click Default to specify the default file extension.
To view the changes in extensions, re-open the Manager. Note that the
Extensions setting applies to the file extensions only, and does not affect the
file formats.

Chapter 5: Using Converters

111

The following image shows steps involved in viewing the information for a
Document resource for DAT Parser:
Select the required node
from the tree view.

The required information displays in the
associated fields. You can view the information
and edit the file-extension (if required).

7

Click Apply, and then click OK to save your changes.
See the DesignPro Manager Online Help for description of remaining categories.
To open Online Help:
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From the Help menu select Contents, or



Click

in an open dialog.

Section II: Managing and Converting Resources

Chapter 6:

Automating the
Conversion Process
In this chapter...


Automation Components



Automating Command Line Converter with Scout

Automation Components
DesignPro Tools provides two components for unattended and automated file conversion.
The components used in the automation process are:
Command Line Converter
DesignPro Tools Suite’s conversion component is the Command Line Converter; a
command line executable version of the Converters application. A series of command line
options/parameters can be passed to this program to perform all conversions supported by
the Converters.
More details on the Command Line Converter and associated parameters are discussed in
“Using DPTCLCu.exe” on page 114.
Elixir Scout Manager
Elixir Scout is the automation component. Scout runs as a Windows service and “watches”
for specified files in one or more disk folders; when files of that type are placed in a
watched folder, Scout runs a user-defined process.
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Elixir Scout Manager provides the interface for configuring Scout, selecting watched
folders, defining processes to be performed, and specifying criteria for activating these
processes.
Information in this chapter assumes familiarity with the Elixir Scout component.
For a detailed description of Scout, see the Elixir Scout Manager User Guide
included in the DesignPro Tools documentation package.

You can configure Elixir Scout to run the Converters with command line parameters to
provide complete automation facilities.
See “Automating Command Line Converter with Scout” on page 124 for details.

Using DPTCLCu.exe
The DesignPro Tools Command Line Converter is specially designed for automated batch
operation. The program file (DPTCLCu.exe) is installed as part of DesignPro Tools.




The default location of Command Line Converter is:
drive:\Program Files\Elixir Technologies\Bin.
Syntax for executing Command Line Converter is:
drive:\Program Files\Elixir Technologies\Bin\DPTCLCu.exe [parameters]

The following sections describe associated command line parameters, and provide usage
examples.
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Command Line Parameters (page 115)



Command Line Examples (page 120)
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Command Line Parameters
Command line parameters can either be passed on the command line immediately
following the program name or placed in a text file whose file name is then passed as a
parameter.
In this section, individual command line parameters are listed.




Detailed descriptions of input and output property parameters/settings for associated
input and output files and Elixir property parameters are discussed in “Command
Line Parameters” section of DesignPro Manager Online Help.
Examples of command line usage are provided in “Command Line Examples” on
page 120.

-I InputFormat “InputFileName” [property1=value] [property2=value]
where:


InputFormat: input file format (FRM, FSL, PCL, etc.).



“InputFileName”: fully qualified name of an input file.



[property1=value][property2=value]: property settings for InputFormat. The
detailed descriptions of input property parameters are discussed in the
“Command Line Parameters” section of DesignPro Manager Online Help.

-T InputType
where:


InputType: input type supported by the InputFormat used.

-EPSPNAME [ProfileName]
Where


ProfileName: specifies the profile name to be used during conversion.
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The following table lists supported format types for each input format:

Input Format Format

Supported Types

ElixirDoc

Elixir Form (.efr)

Form

Elixir FormDef (.efd)

FormDef

Elixir PageDef (.epd)

PageDef

Elixir Legacy Coded Font (.cdf)

Coded Font

Elixir Legacy Code Page (.cod)

Code Page

Elixir Legacy Font (.hdr)

Font

Elixir Legacy Form (.elx)

Form

Elixir Legacy Graphic (.lp3),
bmp, jpeg, tif, pcx, png

Image

Xerox FRM (.frm)

Form

Xerox FNT (.fnt)

Font

ElixirGDF

FRM

Xerox IMG and LGO (.img, .lgo)

Image

FSL

Xerox FSL (.fsl)

Form

PCL

HP-PCL (.pcl, .flj)

Font

ElixirPDW

Enhanced Meta Files list (.epl)

Document

Enhanced Meta File (.ep)

Form

For more information on input formats and the supported input types, see
Chapter 5: “Input Formats” on page 94 in Chapter 5: "Using Converters".

-O OutputFormat “OutputFileName” [property1=value] [property2=value]
where:
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OutputFormat: output file formats. Supported options are ElixirGDF, FRM, FSL,
Image, PCL, PDF, and Postscript.
“OutputFileName”: fully qualified output file name.
[property1=value][property2=value]: property settings for the OutputFormat.
The detailed descriptions of output property parameters/settings for the associated
output files are discussed in “Output Property Parameters” section of DesignPro
Manager Online Help.
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If auto naming of the output file is required, the -A parameter (described later) must be
specified. The auto name symbolic characters can be used in “OutputFileName.”
The following table lists supported format types for each output formats:

Output
Format
ElixirDoc

ElixirGDF

FRM

Format

Supported Types

Elixir Form (.efr)

Form

Elixir FormDef (.efd)

FormDef

Elixir PageDef (.epd)

PageDef

Elixir Legacy Coded Font (.cdf)

Coded Font

Elixir Legacy Code Page (.cod)

Code Page

Elixir Legacy Font (.hdr)

Font

Elixir Legacy Form (.elx)

Form

Elixir Legacy Graphic
(.lp3, .bmp)

Image

Xerox FRM (.frm)

Form

Xerox FNT (.fnt)

Font

Xerox IMG and LGO (.img, .lgo)

Image

FSL

Xerox FSL (.fsl)

Form

Image

Elixir Legacy Graphic (.lp3), BMP,
IOCA, JPEG, PCX, PNG, TIFF

Image

PCL

HP-PCL

Font, Form

PDF

PDF

Form

PostScript

Postscript

Form

TileToFont

Tile to font

Not supported.

Image output type is determined by either the commands passed at the
Command Line or from the EPM file. Converter do not explicitly determine the
image type produced.
For more information on output formats and the supported output types, see
“Output Formats” on page 95 in Chapter 5: "Using Converters".
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-C “ConfigFileName.EPM”
where:


“ConfigFileName”: fully qualified name of Settings file (.epm).

-E[option] “ErrorLogFileName”
where:




[option]: specifies the overwrite option:
-E: appends new information to existing information in the log.
-Eo: overwrites existing information.
-Ed: appends new information to existing information on a daily basis. After
midnight, the next day’s information overwrites information from the previous day.
-Em: appends new information to existing information on a monthly basis. After
midnight on the first day of a new month, the new information begins overwriting
information from the previous month.
“ErrorLogFileName”: is the fully qualified name of an error log file.

-P
where:


-P: sets Parallel Mode Conversion.
This command converts a document to two or more output formats simultaneously.
For instance, while converting a DAT file to Elixir and PDF formats, the converter
will convert each page of the DAT file to Elixir format, and then convert the same
page to the PDF format. The converter will then proceed on to convert the next page
in the file. If this option is not set, then the converter will convert the whole file to
one output format at a time.

-A
where:
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-A: sets Auto Rename of output files.
If auto naming of the output file is required, the “-A” parameter must be specified.
Specifying this parameter automatically generates the name of the output file (e.g.,
form1.afp will be converted to form10.pdf) when the file is converted. The auto
name symbolic characters can be used in “OutputFileName” (see description for
the “-O” parameter).
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-D [property1=value] [property2=value]
where:


-D: specifies resource handling options as specified on Elixir Properties dialog in
form of Property = Value pairs. You can view these options from Tools, Application
Format Setting, Elixir Properties in the DesignPro Manager. [property1=value]
[property2=value]: specifies the Elixir Property Descriptions of Property = Value
pairs. For information on corresponding values for the Elixir properties, refer to
“Elixir Property Parameters” in DesignPro Manager Online Help.

-S
where:




-S: opens the property page for specified Input Format and saves the settings to
“ConfigFileName.”
-U: takes settings from the Converters user interface.

@FileName
where:


FileName: fully qualified name of a file containing the command line parameters.
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Scout Parameters
The table below provides a brief description of Scout parameters used as part of arguments
in the Arguments entry box, located in the Action tab of the properties dialog in Elixir
Scout Manager. Scout parameters are used in command line parameter file as well.

Parameters

Description

%INPUT

Sets the file path and name of input file used in conversion.
It also sets the names of output folders/files using input
names. For example, for the input file name "John.afp", the
output folder/file created will be drive:\Elixir\John.

%INPUT_NAME

Sets the input file name used in conversion. It also sets the
names of output folders/files using input names. For
example, for the input file name "John.afp", the output
folder/file created will be drive:\Elixir\John.

%FNAME

Specifies the original file name and the path.

%OUTPUT

Specifies the output file name.

%!OUTFILE!%

Sets the variable that returns output file name; should be
defined in the Archive.ini file.

%FNAME_NAME

Specifies the original file name.

See “Automating Command Line Converter with Scout” on page 124 for details
on using Scout Parameters.

Command Line Examples
This section explains the following methods (with examples) used for specifying
parameters using the Command Line Converter:
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Specifying Parameters Directly on a Command Line (page 121)



Specifying Parameters in an Unstructured File (page 122)



Specifying Parameters in a Structured File (page 122)
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Specifying Parameters Directly on a Command Line
Example 1:
Conversion of Elixir form to Xerox form:



Use default options for FRM output.
DPTClCu.exe –I ElixirDoc drive:\Elixir\Forms\Elixir\Myform.efr –
O FRM drive:\Elixir\Forms\Frm\

Example 2:
Conversion of Elixir Legacy Graphic to Xerox IMG using properties passed in the
command line:


IMG will be compressed.



Output file will be renamed.

DPTClcu.exe –I ElixirGDF drive:\elixir\pic\elixir\myimage.lp3 –T Image –
O FRM drive:\elixir\pics\IMG\myimg.img IMGCompress=1
Example 3:
Conversion of multiple Elixir Legacy forms to FSL:


All Elixir Legacy forms.



Name of original form is used for all FSL forms.





Elixir Settings file (.epm) used to specify conversion parameters for the
output FSL files.
Conversion results will be written to a log file.

DPTClCu.exe – I ElixirGDF drive:\Elixir\Forms\Elixir\*.elx -O FSL
drive:\Elixir\Forms\FSL\ -C drive:\Elixir\MySettings.epm -E
drive:\Elixir\Conversion.log
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Specifying Parameters in an Unstructured File
Command line parameters can be placed in a simple text file. The name of the command
line parameters file is then passed to the Command Line Converter.
Example 1:
Conversion of an Elixir Legacy Font to Xerox FNT using external command line
parameters:







All input and output settings are created using Manager and saved to a
single EPM file.
Errors and messages written to Conversion.log.
FNT file is created using the stem name of the input file and .fnt as the
extension.
All parameters are stored in command line parameter file called
MyCommandFile.txt.

MyCommandFile.txt contains:
-T Font –I ElixirGDF drive:\Elixir\Fonts\Elixir\MyFont.hdr –O FRM
drive:\Elixir\Fonts\Xerox\ –C drive:\Elixir\MySettings.epm –E
drive:\Elixir\Conversion.log
Command line syntax:
DPTCLCu.exe @drive:\MyFiles\MyCommandFile.txt

Specifying Parameters in a Structured File
All command line parameters can be placed in a simple text file using comments and
labels to structure the file for improved readability.
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Comments: consist of text strings enclosed within /* and */ pairs. Comments cannot
span lines; Command Line Converter ignores them.
Labels: can be used to structure the file into organized blocks. Labels consist of text
strings enclosed within bracket pairs ( [ and ] ). Labels cannot span lines; Command
Line Converter ignores them.
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Example
Conversion of Elixir Legacy Graphic (.lp3) to multiple image formats (IMG, TIFF,
BMP and JPG) using a structured parameters file:




All parameters are stored in a command line parameter file called
MyCommandFile.txt.
The AutoDetectFormatFromExtension option is used for TIFF, BMP and
JPG outputs to trigger creation of default file extension for each format.

MyCommandFile.txt contains:
/* Sample job
*/
/* Default settings for inputs and
*/
/* outputs are defined under
*/
/* [initial settings]. The properties */
/* listed for the inputs and outputs */
/* override the initial settings
*/
[Input]
-I ElixirGDF drive:\Elixir\Pics\Elixir\*.lp3 –T Image
[Outputs]
-O FRM drive:\MyImages\Xerox\ /* Xerox IMG */
IMGCompress=1
ImageDitheringMethod=65536 /* Floyd-Stein dithering */
-O Image drive:\MyImages\TIFF\
CreateTIFF=TRUE
AutoDetectFormatFromExtension=FALSE
-O Image drive:\MyImages\BMP\
CreateBMP=TRUE
AutoDetectFormatFromExtension=FALSE
-O Image drive:\MyImages\JPEG\
CreateJPEG=TRUE
AutoDetectFormatFromExtension=FALSE
[Default Settings]
-C drive:\Elixir\MySettings.epm
[Message Log]
-E drive:\Elixir\Message.log
Command line syntax:
DPTCLCu.exe @drive:\MyFiles\MyCom
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Automating Command Line Converter with
Scout
This section describes suggested methods for using Scout with the Command Line
Converter. Each method listed includes general directions for Scout options and Converter
setup. For further details about Scout options and operation, refer to the
Elixir Scout Manager User Guide.
To configure Scout for using the Command Line Converter, follow steps in the order listed
below for setting up normal Scout operation:


Setting up the Watched and Working Directory (page 125)



Setting URL Watched Directory Source Settings (page 126)



Defining Action Settings (page 126)



Creating an Event (page 128)

Three suggested methods for configuring watched folders for use with Scout and
Command Line Converter are discussed in the following topics:


Method 1 (page 124)



Method 2 (page 129)



Method 3 (page 131)

Method 1
The simplest method is to set up a single watched folder for a single input data format, and
then pass the command line parameters on the Arguments line in the Scout Manager.
This method assumes that:


Input file structure and settings are always the same.



Output format and settings are always the same.



Input data files are dropped into a watched folder.

The steps involved in configuring the Scout Manager to use Command Line Converter are
explained in detail below. In this method, we have taken an example of a sample input file
converted to a PDF document. All the settings needed to run automated conversion of a
sample file to PDF document are also mentioned in each step in detail.
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Setting up the Watched and Working Directory
A watch directory is a folder on a local or network drive where Scout watches for an event
to happen.
To set up a watched directory:

1

Create required watch folders to receive input data files.
In this example, the following folders are used:
 c:\Elixir\Scout.
The input file in this example will be placed in this folder.
 c:\Elixir\Scout\Working.
The working directory is where the designated action takes place. This keeps the
input directory free from additional files.

2

Set up Scout to move the file to the working directory. We recommend using the
working directory for processing input files because if the file is simply copied,
Scout will continually reprocess the original file since it will be found in the watched
folder. In this example, the working directory is located at the above mentioned path.

Always create the directories and folders before setting up the Scout Manager;
folders are not automatically created.

To add a new source, or a new watch directory:

3

Open Elixir Scout Manager from Start, All Programs, Elixir Applications, Scout
Manager.
The Elixir Scout Manager window displays.

4

Click
on the Standard toolbar.
The Add New URL Source dialog displays. Here you will enter the watch directory
path and name.

5

Enter the watch directory path and name (in this example: c:\Elixir\Scout) in the
URL Source Name entry box and click OK.
The c:\Elixir\Scout dialog displays for setting the source and action settings.

You will now specify the type of file(s) to watch for, what actions are to be taken on the
watched file(s), where to process them and what to do with these files once the processing
completes. See “Setting URL Watched Directory Source Settings” on page 126 for details.
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Setting URL Watched Directory Source Settings
To set the URL watched directory source:

6

Click the Source Settings tab, and select URL Directory as the input source type
from the Source Type drop-down list.

7

Select the URL directory by clicking Browse in front of the Checking URL
Directory entry box, locate and select the c:\Elixir\Scout file path from the Browse
for Folder dialog. Click OK to set the URL directory path in the Checking URL
Directory entry box.

8

Select Move File to the Temporary Directory and specify the temporary directory
c:\Elixir\Scout\Working in the entry box right below the Move option.
This option moves the file from the watched directory to the temporary directory.

9

Enter the source file format (such as *.afp) in the File Filters entry box as the type of
file to watch for in the watch directory.
In this example, you are converting an AFP file to PDF.

For more information on other available options in this dialog, refer to
“Chapter 3: Setting Up Watched Directory” of Elixir Scout Manager User Guide.

Now that you have set up the source settings, you will specify what action to take when
the input file arrives in the watch directory.
Defining Action Settings
After adding a directory to the watched directory list and setting directory properties,
define the action to take when a file is written to the watched directory.

10 Click the Action tab and select the Executable category.
Elixir Scout Manager enables you to automatically run EXE files when a file is
written to a watched directory by defining an executable action.

11 Select the executable file by clicking Browse in front of the File Name entry box,

locate and select the required file from the Open dialog. You can select files with
either *.exe or *.com extension. Click Open to set the file path of executable file in
the File Name entry box. In this example, the path set in the File Name entry box is
c:\Program Files\Elixir Technologies\Bin\DPTCLCu.exe.

Once the executable file has been selected, the next step is to define the executable action.
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12 Specify the command line argument(s), which will be passed to the executable
application in the Arguments entry box, as follows:


-T InputType -I InputFormat “%INPUT” [Property1=Value]
[Property2=Value] …[additional parameters as required]
Scout will substitute the input file name for %INPUT. The parameters provide
complete automation help to run the executable application. For more
information on arguments/parameters, refer to “Command Line Parameters” on
page 115.

13 Select the directory containing the file(s) required by the executable file at run time

by clicking Browse in front of the Start In entry box, locate and select the required
directory from the Browse for Folder dialog. Click OK to select the directory.
In this example, the directory path selected is c:\Elixir\Scout\Working.

14 Specify the required executable window display method from the Run drop-down
list:
 Normal: opens the application window with default display settings.
 Minimized: opens the application window minimized.
 Maximized: opens the application window maximized.
 Hidden: application window is not displayed.

The options in Run drop-down list control the display of conversion status
window during the conversion.

15 Set Check Timeout to the default value -1. This option indicates the action time-out
duration.

16 Enter the time-out value in the After entry box.
This option is enabled only if Check Timeout is selected. The value can be between
1 and 2147483647 milliseconds. The -1 value in Timeout entry box specifies that
there is no timeout check on the start of action execution.
Details on other available options in this dialog are explained in
“Chapter 4: Setting Elixir Scout Manager Action” of the
Elixir Scout Manager User Guide.
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17 Click Apply and OK to save the changes.
Scout automatically starts the service, and displays the watch directory in the
workspace.
The process of automating the conversion process using Scout Manager is complete. The
next step is to create an event to start the conversion process.
Creating an Event
An event is defined as the arrival of the input source file in the specified watched
directory. To create the event in this example, you will manually drop an input file into the
c:\Elixir\Scout watch directory. Scout will then open the Command Line Converter
application to convert the file to the specified format (PDF in this example), and deliver
the output file to the default path specified. This file is specified in the Arguments entry
box in the Action tab of the properties dialog.
To create an event:
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1

Open the Windows Explorer.

2

Browse to the location of the required input file, and copy the sample input file.

3

Copy the file, and manually drop it into the watched directory.
The DOS window of the Command Line Converter automatically displays, and the
conversion process takes place in the background.

4

Browse to the specified output file path in Windows Explorer, and open the
converted file, such as PDF in this example.
The output file opens in the associated viewer.
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Method 2
In this method, instead of specifying all conversion parameters in Scout (Arguments
entry box in the Action tab of the properties dialog) as done in “Method 1” on page 124,
the parameters are placed in a command line parameter file. The command line parameter
file is an external file that is used for reference during the execution of the Command Line
Converter.
This method assumes that:


Input file structure and settings are always the same.



Output format and settings are always the same.



Setting file is stored in a single location.



Input data files are dropped into a watched folder.

The next step is to create the command line parameters file.
Creating the Command Line Parameter File
To create a command line parameter file for the conversion process:

1

Open Notepad by clicking Start, and then select All Programs, Accessories,
Notepad.
An untitled text file opens.

2

Enter the input and output property settings, and the output file paths in the text file.
For details on input and output property settings specified in command line
parameter file, refer to “Scout Parameters” on page 120.

Do not include the input file Path or Name in the command line parameter file.
Scout Manager picks up the input file name and path from the watched folder.

3

Select File, Save from the menu.
The Save dialog displays.

4

Browse to the required directory, enter the name of the command line parameter file,
and select Text Document (*.txt) from the Save As Type drop-down list.
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5

Select appropriate text encoding from the Encoding drop-down list.

6

Click Save.
The command line parameter file saves at the defined location.

Save the command line parameter file in the folder defined in Scout Manager as
the command line parameter file location.

After creating the command line parameters file, follow steps in the task
“Specifying Command Line Parameters” on page 130 to create the watched folder, set the
source settings, and executable action settings in the properties dialog.
Specifying Command Line Parameters
To specify the command line parameters in Scout Manager for Method 2:
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1

Create a folder to receive the input data files.

2

Add a watched folder to the Scout Manager.
Refer to “Setting up the Watched and Working Directory” on page 125 for adding a
directory.

3

Click the Source Settings tab in the properties dialog, and set the appropriate
properties.
Refer to “Setting up the Watched and Working Directory” on page 125 for specifying
the rest of the Source Settings.

4

Click the Action tab, and then the Executable category from the properties dialog.

5

Browse for Command Line Converter program by clicking Browse adjacent to the
File Name entry box.
The default path is: drive:\Program Files\Elixir Technologies\Bin\DPTCLCu.exe.
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6

In the Arguments entry box, enter the following command line parameter:
 -I %INPUT drive:\Path\File Name.ext.
Where drive:\path\filename.ext is the path and name of the command line
parameter file.

When Scout detects an input data file in the watched folder, it substitutes
%INPUT with the name of the data file.

7

Click Apply, and then OK to close the dialog.

The last step in the automated conversion of the input file using the Command Line
Converter is to create an event. See “Creating an Event” on page 128 for details on
creating an event. The output file delivers after conversion in the designated folder.

Method 3
This method uses a command line parameter file placed in a single watched folder. The
command line parameter file activates the conversion process on a data file, stored in a
different folder. Since, the command line parameter file contains all the conversion
parameters, data files in any supported input format can be processed.
This method assumes that:




User defined front-end process generates a unique command line parameter file for
processing each data file.
Command line parameter files are dropped into a watched folder.
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As the front-end process generates an input data file, it also creates a command line
parameter file for placement in a watched folder.

The data file must be written to the target folder before the command line
parameter file is dropped into a watched folder.

The command line parameter file should contain:


Full path and file name of the input data file, and the full path of output file(s).



All property settings for input, and each required output.
When using a command line parameter file, create a text file containing all input
and output property settings (including paths for output files). Do not supply
input file path or name, as these are provided when Scout picks up the data file
from the watched folder. Save the file to the folder defined to Scout as the
command line parameter file location.

Specifying Command Line Parameters
To specify the command line parameters in Scout Manager:
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1

Create a folder to receive the command line parameter files.

2

Add a watched folder to the Scout Manager.
Refer to “Setting up the Watched and Working Directory” on page 125 for adding a
directory.

3

Click the Source Settings tab in the properties dialog, and set the appropriate
properties.

4

Enter the extension in the File Filter entry box that matches the extension used for
the command line parameter file.
Refer to “Setting URL Watched Directory Source Settings” on page 126 for
specifying the rest of the Source Settings.

5

Click the Action tab, and then the Executable category from the properties dialog.

6

Browse for the Command Line Converter program by clicking Browse adjacent to
the File Name entry box.
The default path is: drive:\Program Files\Elixir Technologies\Bin\DPTCLCu.exe.
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7

Enter @drive:\Path\File Name.ext in the Arguments entry box:
where @drive:\Path\File Name.ext is the path and filename of the command line
parameter file.

8

Click Apply, and then OK to close the dialog.

For automated conversion of the input file using Command Line Converter, you have to
create an event. For details on creating an event, see “Creating an Event” on page 128. The
output file delivers after conversion in the designated path and folder.
The “Command Line Parameter” section in the DesignPro Manager Online Help
details the following parameters you can use on the command line for setting:




Elixir Property Parameters.
Input Property Parameters.
Output Property Parameters.
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Section III: File Transfers
Chapter 7: File Transfers for Xerox
This chapter describes how to transfer files between your PC and host computer. It also
explains how to configure host connections, specify font libraries, and download and
upload files for subsequent processing.
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Chapter 7:

File Transfers for
Xerox
In this chapter...


Moving Online Xerox-Labeled Files



Uploading Metacode Files to the Host



DataWare Card PC to Printer Interface

Moving Online Xerox-Labeled Files
Files for printing on channel-attached Xerox production or distributed printers can
compile and reside on a host computer. Several popular file transfer packages are used to
transfer files between your PC and a host computer running the IBM MVS operating
system. FRM, FSL, logos, images, and fonts are also referred to as Xerox-labeled files
because the files contain 128-byte Xerox headers (or labels).
This section includes procedures for transferring Xerox-labeled files from a PC (through
an IBM host running MVS) to a production printer.
To upload FSL files, first run the PACK utility on the files to convert them to the Xerox
128-byte format. For information on the PACK utility, refer to“Pack” on page 176 in
Chapter 8: "Stand-Alone Utilities".

1

Configuring the File Transfer Package (page 138)

2

Uploading Files to the Host (page 138)

Download all files from the host computer to your production printer using one of the
following methods:


The HOSTCOPY utility.



The DJDE FILE command in the job JSL.
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Configuring the File Transfer Package
To upload Xerox-labeled files from your PC to an MVS host, we recommend one of the
following file transfer packages:


IBM 3270



IRMA FT/3270



IRMA FT/TSO

Make sure the card for the appropriate file transfer package resides on your PC, and that
you installed the corresponding file transfer software on your PC and on the MVS host.

Uploading Files to the Host
The methods to upload Xerox-labeled files and text files from your PC to an MVS host
using IBM 3270, IRMA FT/3270, and IRMA FT/TSO are described in the following
sections:


Uploading Xerox-Labeled Files with IBM 3270 or IRMA FT/3270 (page 138)



Uploading Text Files with IBM 3270 or IRMA FT/3270 (page 139)



Uploading Xerox-Labeled Files with IRMA FT/TSO (page 140)

Uploading Xerox-Labeled Files with IBM 3270 or IRMA FT/3270
The IBM 3270 and IRMA FT/3270 file transfer packages are similar. Both require that
you first prepare the host for receiving Xerox-labeled files by allocating a data set with the
following DCB specifications:
DCB=(LRECL=128,BLKSIZE=128,RECFM=FB)
This specifies a Xerox-labeled file with a record length of 128 bytes, block length of 128
bytes, and fixed-block (FB) record format.
Upload a Xerox-labeled file by typing the following command at the DOS prompt:
SEND [Path] Pcfilename 'Hostfilename' <Enter>
Where:

138



Path: is the optional DOS pathname.



Pcfilename: is the name of the Xerox-labeled file on your PC, including extension.
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Hostfilename: is the host dataset receiving the file (you must enclose hostfilename
in single quotes).
The 'hostfilename' can refer to either a physical sequential or a partitioned dataset.
For example, if transferring to a physical sequential dataset, 'hostfilename' may be as
follows:
'CM.EIO.DATA.UPLOAD'
If transferring to a partitioned dataset, 'hostfilename' can include the stem name of
the files being transferred, enclosed in parentheses, as part of the dataset name as
follows:
'CM.EIO.DATA.UPLOAD(filename)'

Uploading Text Files with IBM 3270 or IRMA FT/3270
To upload a text file:


Allocate a dataset on your host with the following DCB parameters:
DCB=(LRECL=255,BLKSIZE=3000,RECFM=VB)
Add the ASCII and EBCDIC statements to the end of SEND and RECEIVE
commands, respectively, for FSL files only.

To send a text file to an MVS host:


Enter the following command from the DOS prompt by using the Dispatcher icon or
the DOS menu:
SEND [Path] Pcfilename 'Hostfilename' ASCII <Enter>
This command uploads the Xerox-labeled file pcfilename to the host dataset
hostfilename. A DOS directory path before pcfilename is optional. The ASCII
parameter at the end of the command string translates the file from ASCII to
EBCDIC.

To download a text file from the host:


Enter the following command:
RECEIVE [Path] Pcfilename5 'Hostfilename' EBCDIC <Enter>
This command downloads the Xerox-labeled file Hostfilename to the PC file
Pcfilename. A DOS directory path before pcfilename is optional. The EBCDIC
parameter at the end of the command string translates the file from EBCDIC to
ASCII.
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Uploading Xerox-Labeled Files with IRMA FT/TSO
To upload a Xerox-labeled file with IRMA FT/TSO:


Type FT/TSO <Enter> at the DOS prompt to start the FT/TSO software and
display the IRMA FT/TSO screen.

To change the file transfer parameters:
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1

Use the Tab key on the keyboard to move the cursor into the data entry field
following [Transfer Type:].

2

Enter a name for saving the Xerox-labeled file transfer parameters (described in
step 4).
The example in the above figure shows XEROX.

3

Press F5 to display the Transfer Parameters menu.
The Transfer Parameters menu displays on the bottom right corner of the screen.
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4

Use the Tab key to move between transfer parameter fields and enter the following
values:

Parameter

Value

Block size

128

Record size

128

Record format

FB

Line numbers

Position:0 Length:0

Code table

STD

Transfer mode

BINARY

Expand TABs

NO

Truncate spaces

NO

U/L case

ASIS

Space Units

TRKS

Primary QTY

1

Secondary QTY

2

To transfer text files, you must use different values for some parameters. Since you
can store text files on host computers in datasets with different DCB parameters, you
must tailor the transfer parameters to match the text file DCB parameters used at
your site.

Parameter

Value

Block size

3000

Record size

255

Record format

VB

Line numbers

Position:0 Length:0

Code table

STD

Transfer mode

TEXT

Expand TABs

NO

Truncate spaces

NO

U/L case

ASIS

Space Units

TRKS
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Parameter

Value

Primary QTY

1

Secondary QTY

2

To upload files with IRMA FT/TSO:

1

Enter the name of the PC file you want to upload and press Tab.
Optionally, precede the file name with a DOS directory path.

2

Enter the name of the host dataset that you want to upload.

3

Press Tab.

4

Enter the appropriate Transfer Type for sending Xerox-labeled files (binary).

5

Press F1 to upload the file.

Downloading Files from the Host to the Printer
Download files from the host computer to the production printer using one of the
following methods:


The HOSTCOPY utility.



The DJDE FILE command.

The following sections describe the two downloading methods and also compare the
differences between them.

HOSTCOPY and FILE Comparison
Using the FILE command requires that you add the FILE command to the JSL file that
will dynamically download all files at print time.
Using the HOSTCOPY utility involves the following steps:
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1

Make sure that all of the files used in the job reside on the printer.

2

Reboot the printer.

3

Download the files using HOSTCOPY.

4

Reboot the printer.

5

Start the print job.
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The advantages of using the FILE command rather than HOSTCOPY to download files
are:







Using the FILE command frees up disk space on the printer.
You can maintain an additional level of security since files do not have to reside on
the printer.
Using the FILE command does not require switching the printer from production
mode to HOSTCOPY mode and saves valuable printer time.
As files download during print time, the current and correct versions of the files
download. When using HOSTCOPY, it is important to check that all files resident
on the printer and used for the job are the correct versions.

Using the HOSTCOPY Utility
To use the HOSTCOPY utility, use the following procedure:

1

Uploading ENDFILE.END (page 143).

2

Preparing the JCL File (page 143).

3

Placing the Printer in HOSTCOPY Mode (page 145).

4

Copying Xerox-Labeled Files to the Printer (page 146).

5

Using the FILE Command (page 146).

Uploading ENDFILE.END
After uploading Xerox-labeled PC files, upload the ENDFILE.END file (copied to the
drive:\Elixir directory during installation) to the host. Use the procedure described in
“Uploading with IBM 3270 or IRMA FT/3270” on page 148.

Preparing the JCL File
After uploading Xerox-labeled files and the ENDFILE.END files to the host, use the IBM
IEBGENER utility to build a JCL dataset for sending the files to a channel-attached
9700 series printer.
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Example of a JCL dataset:
-------------------------//00D42DA JOB (8200,Z200-Z20001),'LARACEY 7-1994',CLASS=A
//MSGCLASS=J,NOTIFY=00D42D,USER=00D42D,PRTY=4
/*JOBPARM L=9999
//*
//* JCL to send a Xerox-labeled file to a 9700 series printer
//*
//XRX9700 OUTPUT DEST=R269
//*
//* This step copies the file UN110E.FNT
//* to the Xerox printer's output destination
//* class
//*
//STEP1 EXEC PGM=IEBGENER
//SYSPRINT D SYSOUT=*
//SYSUT1 DD UNIT=DISK,DISP=OLD,
//DSN=00D42D.0Z200.UN110E.FNT.DATA,
//DCB=(LRECL=128,BLKSIZE=128,RECFM=FB)
//SYSUT2 DD SYSOUT=O
//*
//* This step copies the ENDFILE.END file
//* to the Xerox printer's output destination
//* class to terminate the HOSTCOPY procedure
//*
/STEP2 EXEC PGM=IEBGENER
//SYSPRINT D SYSOUT=*
//SYSUT1 DD UNIT=DISK,DISP=OLD,
//DSN=00D42D.0Z200.ENDFILE.END.DATA,
//DCB=(LRECL=128,BLKSIZE=128,RECFM=FB)
//SYSUT2 DD SYSOUT=O
//OUTPUT=*.XRX9700
//SYSIN DD DUMMY
//*
------------------------You must modify the JCL file to include the names of the files you want to send to the
printer.
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Placing the Printer in HOSTCOPY Mode
To place a channel-attached, production printer in HOSTCOPY mode, follow these steps:

1

Switch the printer to OFF-LINE.
The printer status displays OFF-LINE IDLE at the printer console.

2

Press the printer BOOT switch.
The printer console displays a command menu with the following system prompt:
ENTER COMMAND

3

Enter the following command:
HOSTCOPY <Enter>
The following message displays:
*SYSGEN RUNNING FOR HOSTCOPY ONLY* THIS IS A FILE COPYING
PROCEDURE, NOT A SYSGEN CONTINUE OR ABORT? ENTER 'C' OR
'A'

4

Enter:
C <Enter>
The printer displays the following message:
WAITING TO READ FILES FROM HOST
The printer is now in HOSTCOPY mode and ready to accept files from the host.
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Copying Xerox-Labeled Files to the Printer
To copy Xerox-Labeled files to the printer:

1

After placing the printer in HOSTCOPY mode, run the JCL job to send the Xeroxlabeled and ENDFILE.END files to your printer.
The ENDFILE.END must be the last file you send to the printer.

2

The following message displays at the printer console, indicating that files are being
received:
CREATING FILE xxxxxx.yyy

3

When the printer detects the ENDFILE.END file, the following message displays:
END OF TAPE FOUND
IS ANOTHER TAPE TO BE SENT? Y OR N
If you want to send more files, type Y <Enter>.

4

When you finish transferring files, press N <Enter> on the keyboard to display:
VARY OFFLINE AT HOST, THEN ENTER C

5

Enter C to stop the copy-to-printer operation.

6

Reboot the printer.
The Xerox-labeled files now reside on the production printer.

Using the FILE Command
This requires that you embed the DJDE FILE command in the job JSL. With the FILE
command, files dynamically download to the printer at print time.
The command syntax is as follows:
FILE=Filename, Filetype [,[f][,[s][,n]]]]
Where:



Filename: is a one to six character file name.
Filetype: is a three character file symbol for the appropriate file, like LGO, IMG,
FSL, FNT, or FRM.



f: is C (for card-image format) or L (for tape format, the default).



s: is D (to delete files after printing) or P (to keep the files after printing, the default).

n: is the maximum number of card-images (default = 120).
After adding the FILE command to your JSL statements, compile the JSL and START the
compiled JDL at the printer console to run the print job. See your Xerox Laser Printing
System Reference Manual for more information.
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Uploading Metacode Files to the Host
To upload metacode files from your PC to an MVS host, use file transfer packages such as
IBM 3270, IRMA FT/3270, or IRMA FT/TSO.
Make sure the card for the appropriate file transfer package resides on your PC, and that
the corresponding file transfer software resides on your PC and the MVS host.
You can also transfer files from your PC to a floppy diskette using the XDisk32 utility.
The XDisk32 is a third party utility provided by Xerox that supports moving files from
machines having Windows NT or Windows 2000 to a floppy diskette.
The Xdisk32 utility is available at the Elixir home page. To download this utility:
Go to http://www.elixir.com/support.htm and select Patches.
Click Download Patches Here and enter your login information.
 From the drop down list, select Elixir Application Suite and click
Proceed to Download.
Select XDisk32 from Select Release/Patch drop down list. Read the terms
and conditions carefully and click I Agree to download the utility and its
associated documentation.



To open the Xdisk32 utility, your machine needs to be configured as per the
instructions provided in the document available with the Xdisk32 utility.

Chapter 7: File Transfers for Xerox

147

Uploading with IBM 3270 or IRMA FT/3270
The IBM 3270 and IRMA FT/3270 file transfer packages require that you first prepare the
host for receiving metacode files by allocating a data set with the following DCB
specifications:
DCB= (LRECL=540,BLKSIZE=540,RECFM=FB)
This specifies a file with a record length of 540 bytes, block length of 540 bytes, and
fixed-block (FB) record format.
You then upload a metacode file by typing the following command at the DOS prompt:
SEND [path]pcfilename 'hostfilename' <Enter>
Where:


Path: is the optional DOS path.



Pcfilename: is the name of the metacode file on your PC, including extension.



148

Hostfilename: is the host dataset receiving the file (you must enclose hostfilename
in single quotes).
'hostfilename' can refer to either a physical sequential or a partitioned dataset. For
example, if transferring to a physical sequential dataset, 'hostfilename' may be as
follows:
'CM.EIO.DATA.UPLOAD'
If transferring to a partitioned dataset, 'hostfilename' can include the stem name of
the files being transferred, enclosed in parentheses, as part of the dataset name as
follows:
'CM.EIO.DATA.UPLOAD(filename)'
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Uploading with IRMA FT/TSO
Use the following procedure to upload a Xerox-format file with IRMA FT/TSO:
Type FT/TSO <Enter> at the DOS prompt to start the FT/TSO file transfer software and
display the IRMA FT/TSO screen shown in the previous figure.
To change file transfer parameters:

1

Use the Tab key to move the cursor into the data entry field following
[Transfer Type:].

2

Enter a name under which you want to save Xerox-labeled file transfer parameters
(described in step 4).
The example in the previous figure shows XEROX.

3

Press F5.
The Transfer Parameters menu displays in the bottom right corner of the screen.

4

Use the Tab key to move the cursor between transfer parameter fields.

Parameter

Value

Block size

540

Record size

540

Record format

FB

Line numbers

Position:0 Length:0

Code table

STD

Transfer mode

BINARY

Expand TABs

NO

Truncate spaces

NO

U/L case

ASIS

Space Units

TRKS

Primary QTY

1

Secondary QTY

2
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To upload files with IRMA FT/TSO:

1

Enter the name of the PC file you want to upload and press Tab on the keyboard.
Optionally, precede the file name with a DOS directory path.

2

Enter the name of the host dataset to which you want to upload and press Tab.

3

Enter the appropriate transfer type for sending Xerox-labeled files (binary).

4

Press F1 to upload the file.

Uploading with 871
Use the following procedure to upload a Xerox-format file with an 871 device. The
MET2871 utility reformats metacode files for correct processing through an 871 device
that connects a Xerox mainframe computer and printer.
MET2871 Filename <Enter>
Where:


Filename: is the full path name of the file you want to upload including the
extension.
Issue the command from the directory in which MET2871 resides (drive:\Elixir).

DataWare Card PC to Printer Interface
The DataWare PC interface card connects a PC directly to a Xerox production printer
using bus and tag connectors and helps you to send online metacode files and Xerox files
with 128-byte header records generated by Elixir software to your Xerox printer.
The following topics explain the use of DataWare card:
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DataWare CONFIG.SYS Device Drivers (page 151)



Copying Files to the Printer (page 151)
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DataWare CONFIG.SYS Device Drivers
To use the DataWare card, add the following device driver in your PC CONFIG.SYS file.
DEVICE=CHANNEL.SYS unit address
Where:



Unit: is the DataWare I/O port you are using (0 - 3), normally 0.
Address: is the hexadecimal value of the address of the printer on the I/O channel
(between 0 and FE), normally 0F.

Make sure you specify the full DOS pathname for CHANNEL.SYS in your CONFIG.SYS
file (for example, C:\DATAWARE\CHANNEL.SYS 0 0F).
For proper DataWare card operation, the Config.sys file may require other parameters. For
details, see your DataWare Documentation.

Copying Files to the Printer
To copy files to the printer through the DataWare card, type:
COPY /B [ Path] Filename CHAN <Enter>
Where:




Filename: can be any Elixir-generated online Metacode or Xerox file with a
128-byte header record.
Path: is the optional fully qualified DOS directory search path for Filename.

Copying Online Metacode Files to the Printer
If you copy online metacode files to the printer, make sure you code your default and
Elixir.jsl files properly. The printer should be online and waiting to receive data before
you begin the copy operation. For details on configuring your printer in an online
environment, see your Xerox Production Printer Reference Manual.

Copying Xerox 128-Byte Header Files to the Printer
If you copy a 128-byte header file to the printer, make sure the printer is in HOSTCOPY
mode before you begin the copy operation. For further details on the HOSTCOPY mode,
see your Xerox Production Printer Reference Manual.

Chapter 7: File Transfers for Xerox

151

152

Section III: File Transfers

Section IV: Utilities
Chapter 8: Stand-Alone Utilities
Describes tools to access Windows and DOS-based utilities.
Chapter 9: Elixir Profile Editor
Explains the Elixir Profile Editor workspace, associated customization options and tasks
for creating new user profiles.
Chapter 10: Elixir Viewer
Provides an overview of the functions and features of the Elixir Viewer.
Chapter 11: Resource Map
Explains using the Elixir Resource Map to map font and character resources between the
supported print and display formats.
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Chapter 8:

Stand-Alone Utilities
In this chapter...


Tools and Utilities



Additional Utilities

Tools and Utilities
DesignPro Manager provides a number of DOS-based and Windows-based stand-alone
utilities. Utilities are service programs designed to perform various tasks, such as
verifying the validity of your product license, etc. This version of Manager installs utilities
at %ElixirBinDir% (drive:\Program Files\Elixir Technologies\Bin). The Manager also
installs shortcut icons to the supplied tools and utilities for easy access from the Manager
workspace.
The following shortcuts are available in the Tools and Utilities tab of the Navigation
window in the Manager workspace:

Shortcut Name

Executable

Product Registration

Password.exe

Display Password File

Disppw.exe

Display Key

Showbd32.exe

Display PC Serial Number

Showpc.exe

Update Key

Updkey.exe

Printers

ElxVieweru.exe

Icon
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To run these utilities, click the utility icon available in the Tools and Utilities tab of the
Navigation window in the Manager.

Product Registration
When you connect to the Internet after installing the software, running Password.exe
triggers the online registration process and generates a soft key based on the supplied user
information. On successful completion of the registration process, a Password.epw file is
created at drive:\Elixir.
To run the Password Registration utility:


Click

in the Tools and Utilities tab.



Select Tools, License Wizard from the menu.

The Elixir Product Registration dialog opens and guides you through the complete
registration process.

Display Password File
Display Password File displays information about your PC and Elixir applications after
successful completion of the online registration process.
To run the Display Password File utility, click

in Tools and Utilities tab.

The Disppw.exe window opens displaying the required information.
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Display Key
Display Key shows information about any Elixikeys attached to your PC and Elixir
applications that you have the authorization to run.
To run the Display Key utility, click

in the Tools and Utilities tab.

The DOS window opens showing the soft key security details of the machine.

Display PC Serial Number
Display PC Serial Number is a licensing utility that generates your PC’s serial number for
password file creation.
To generate the PC Serial Number, click

in Tools and Utilities tab.

The serial number is generated as a text file (Showpc.txt) at the following path:
drive:\Program Files\Elixir Technologies\Bin.
The Showpc.exe window displays the progress of generating the file.
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Update Key
Update Key updates the hard key (only if it is plugged into your computer) by copying all
of the key codes from the Password.epw file to the hard key.
To update the hard key, click

in the Tools and Utilities tab.

The DOS window displays the progress (status).

Printers
DesignPro Manager enables you to print multiple forms and documents in a single step.
Drop the required files onto
available in the Tools and Utilities tab to display the
Print dialog. You can select the printer type and customize its settings. You can also
specify page horizontal (X) and vertical (Y) shift values in DPI.
Printing EFR and ELX Format Files
DesignPro Tools enables you to print EFR and ELX format files to an installed Windows
printer using drag and drop method. For this, you first have to associate the EFR and ELX
file types with Elixir Viewer executable (ElxVieweru.exe) from the Windows Explorer by
following the steps below:
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1

Open Windows Explorer.

2

From the Tools menu, select Folder Options, and click the File Types tab.

3

In the Registered File Types area, scroll to the EFR file type and click Advanced.
The Edit File Type dialog displays.

4

In the Edit File Type dialog, click New.
The New Action dialog displays.
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5

In the New Action dialog, enter Print in the Action entry box.

6

For Application Used to Perform Action entry box, specify the path of Elixir
Viewer executable in the following format:
drive:\ProgramFiles\Elixir Technologies\Bin\ElxVieweru.exe /p "%1".
or
"drive:\ProgramFiles\Elixir Technologies\Bin\ElxVieweru.exe" /p "%1".

7

Click OK to associate the Print text with the specified path.

8

Repeat step 5.

9

Enter PrintTo in the Action entry box.

10 In the Application Used to Perform Action entry box, specify the path of Elixir

Viewer executable, followed by a space and the following text:
drive:\ProgramFiles\Elixir Technologies\Bin\ElxVieweru.exe /pt "%1" "%2"
"%3" "%4".
or
"drive:\ProgramFiles\Elixir Technologies\Bin\ElxVieweru.exe" /pt "%1" "%2"
"%3" "%4".
The specified files will now be printed at the required location.

11 Click OK.
12 For specifying the same properties for ELX format, repeat from step 3.
To print files, select the required ELX or EFR format file(s) and drop them onto the
installed Windows printer. The installed printers are usually located in the Control Panel.
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Additional Utilities
In addition to the utilities that are immediately accessible from the Manager workspace,
DesignPro Tools also provides additional utilities to make it more efficient.
DesignPro Tools includes the following additional utilities:


FixElxOr (page 162)



Barr (page 163)



Bcheck (page 165)



Charmapupdt (page 166)



Disp (page 167)



Fontcvt (page 169)



Formprn (page 171)



Metainw (page 174)



Pack (page 176)



ReBlock (page 177)



Strip (page 178)



XDisk32 (page 179)



Elixir CodePage Editor (page 180)



ElixiTag (page 195)



Makepub (page 200)



PDF Plug-In (page 204)

Accessing the Additional Utilities
The executable files for these utilities are located at: drive:\Program Files\Elixir
Technologies\Bin.
You can access the DOS-based utilities by using the DOS Command Prompt. For
information on opening the DOS Command Prompt window.
Refer to “Opening the DOS Command Prompt Window” on page 161.
You can also access certain utilities (that do not require input parameters) by running the
utility executable (*.exe) from the Bin directory. For accessing these utilities from the
Manager, create a shortcut in the My Shortcuts tab in the Navigation window, and then
use the shortcut to run the utility.
For more information, refer to Chapter 3: “DesignPro Manager Basics” on page 49.
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Opening the DOS Command Prompt Window
To open the Command Prompt window, click Start and then select All Programs,
Accessories, Command Prompt.
To open a DOS environment, you can also select Run from the Start menu to
display the Run dialog, and then enter either cmd or command in the Open
entry box.

Tips for Running DOS Utilities
The following tips can be useful for running DOS utilities:








To display parameters required to run a utility, select the appropriate Program Files
folder, and then enter the name of the utility (without using keywords).
To run a utility, select an appropriate Program Files folder and enter the utility name,
filename (including path and extension), and utility parameters. To use defaults, omit
all parameters. Otherwise, enter all parameters.
For optional utility parameters, enter the appropriate option parameter. Most utilities
accept DOS wild card characters.
For running DOS utilities, add the Elixir Technologies\Bin folder to the Windows
PATH environment variables. This will enable running utilities from any folder
without adding the full path to the utility location.
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FixElxOr
FixElxOr is a DOS-based utility that is used to preserve the orientation of ELX forms.
This utility saves the landscape or portrait orientation information as originally specified
in the ELX forms. Using this utility, you can open an ELX form in the Xerox toolset with
portrait or landscape orientation information preserved and easily add more text to these
forms without creating text orientation problems.
Usage: FixElxOR Filename [Filename2] [-o Required Orientation Mode]
Where:






Filename: identifies the input ELX filename and path, including extensions.
Wildcards are permissible.
Filename2: identifies the output ELX filename (optional). If a file name is not
specified, then STEM.ori is created by default.
Orientation Mode: specifies the orientation mode. Specify one of the following:
• -OS: swaps orientation (default).
• -OP: sets to portrait.
• -OL: sets to landscape.

To run the FixElxOr utility:
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1

Open the Command Prompt window.

2

Change directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter FixElxOR <Filename> followed by the appropriate record options. For
example:
 FixElxOr C:\Elixir\Forms\Elixir\Form.elx
Swaps the orientation of the input file and creates an output namely Form.ori
 FixElxOr C:\Elixir\Forms\Elixir\Form.elx -OL
Sets the orientation to landscape.
 FixElxOr C:\Elixir\Forms\Elixir\Form.elx -OP
Reverts back to portrait, in case a file is mistakenly processed using FixElxOr.

4

Press Enter on the keyboard.
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The FixElxOr utility reformats the text orientation.

5

Close the window.

Barr
The Barr utility reformats S-370 Byte and word-length record format files from a Barr
systems processor. The variable-length records are reformatted to fixed-length records
with a default length of 150. The default value can be overridden via the command line
parameters while running the utility.
Usage: Barr FileName [RecordSize] [SkipRecords] [StripLastPage] [StripFirstPage]
[OutDir=Path] [-Scan:nnnnn] [-ASCII]<Enter>
Where:














FileName: specifies the DOS filename, including extensions. Wildcard characters
are permissible.
Recordsize: specifies the size of the fixed output records. The default size is 150. 0
indicates the variable record size.
SkipRecords: specifies the number of records to skip at the start. The default value
is 0.
StripLastPage: indicates an optional parameter to strip the last page.
StripFirstPage: indicates an optional parameter to strip the first page (after the skip
records).
OutDir=path: specifies the output directory path (includes trailing backslash).
-Scan:nnnnn: indicates an optional command to continue scanning the directory
and wait nnnnn seconds.
-ASCII: adds ASCII spaces to the reformatted file.
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To run the Barr utility:

164

1

Open the Command Prompt window.

2

Change directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter Barr <FileName> followed by the appropriate record options.

4

Press Enter on the keyboard.
The Barr utility reformats the CAL1.MET file to the specified output directory.

5

Close the window.
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Bcheck
The Bcheck utility is a diagnostic utility that checks the formatting of variable-length
Xerox resources.
Usage: Bcheck FileName [V###|F###|R###|D###] [-Cutoff:######]
Where:





FileName: specifies the required file name, including the path and extension.
V####|F####|R###|D###: identifies either of the Variable, Fixed block, Record only
or Disk format and optional block length. V#### is default.
-CUTOFF:######: identifies an optional parameter to cut down file to ######
pages.

To run the Bcheck utility:

1

Open the Command Prompt window.

2

Change directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter BCheck <FileName> followed by the appropriate options.

4

Press Enter on the keyboard.
The Bcheck utility checks the formatting of lifenet.met.

5

Close the window.
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Charmapupdt
Charmapupdt is a back-end utility. It is used to update Elxmap.mdb at the time of
installation.
Usage: Charmapupdt <Enter>
To run the Charmapupdt utility:
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1

Open the Command Prompt window.

2

Change the directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter Charmapupdt.

4

Press Enter.
The Elxmap.mdb file is updated.

5

Close the window.
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Disp
The Disp utility is a diagnostic utility used for displaying the Xerox resoures in
Hexadecimal, EBCDIC and ASCII formats.
Usage: Disp FileName [Count][Pausing] [Both|Ascii|Ebcdic|Hex] <Enter>
Where:







FileName: specifies the file name, including the path and extension.
Count: specifies the number of characters displayed per line.
The default value is 15.
Pausing: specifies whether or not to pause after displaying a screen of data.
Use Pause or NoPause.
Both|Ascii|Ebcdic|Hex: specifies the format for displaying the Xerox resource.
Either:
• Both: displays both ASCII and EBCDIC formats (Default).
• Ascii: displays the ASCII format.
• Ebcdic: displays the EBCDIC format.
• Hex: displays the HEX format.

To run the Disp utility:

1

Open the Command Prompt window.

2

Change directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter Disp <FileName> followed by the appropriate options.
The DISP utility will display the specified Xerox font file in ASCII format.
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4

Press Enter on the keyboard.
The selected Xerox resource is displayed in the specified format, as shown below:

5

Press the Esc key to exit, or press Space bar to go to the next file.

6

Close the window.
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Fontcvt
The FontCvt utility converts form and XES files between 4075FRM, 4075FSL,
9700FRM, 9700FSL, COLORFRM, COLORFSL, XES, Elixir, 4050FRM, and 4050FSL
formats. This utility strips any text with tags or variable graphics when making FSL and
FRM files.
To use the FontCvt utility without any issues, it is recommended to install
DesignPro Tools using the default settings (in drive:\Elixir), and default folders
should be used to store the resources. For example, all Elixir fonts should be
saved in drive:\Elixir\Font\Elixir. If these default settings are not used, the user will
have to manually create the entire Elixir folder structure for proper operation of
these utilities.

Usage: FontCvt StemName [Input Format] [Output Format] [Vertical] [Monitor]
[Id] [Confirm] [Disk | Tape] [Color] [HpCmd] [TableName] [-Shift] [-NullSpaces]
[-ElixirDir: ElixirDirectory]
Where:






StemName: identifies any DOS filename, without extensions or paths.
Wildcard characters are permissible.
Input Format: includes 9700, 4045, 2700, 3700, 4235, 4075, HP, 9700LGO,
COLORLGO, 5WORD or ELIXIR.
Output Format: includes SCREEN, ELIXIR, 9700, 4045, 2700, 3700, 4235, 4075,
HP, 9700LGO, 5WORD or COLORLGO.



Vertical: select either NO or YES for vertical proofing.



Monitor: includes VGA, SIGMA, WYSE, SUPERVGA, MVGA, NONE.



Id: identifies HPPCL printer font id number to use for font.



Confirm: select either NO or YES.



Disk | Tape: generates output to either DISK or TAPE. DISK is default.



Color: identifies color name (RED, GREEN, BLUE, NONE, etc.).



HpCmd: identifies HP Cartridge command string.



TableName: identifies Language table name.



-Shift: identifies an optional parameter to shift the font by the amount of kerning.



-NullSpaces: identifies an optional parameter to include null spacing characters.



-ElixirDir:ElixirFontDir: identifies an optional Elixir font directory.
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To use the FontCvt utility:

1

Create a new folder with the name Printer at the location drive\Elixir\Fonts\.

2

Open the Command Prompt window.

3

Change directory to drive:\Program Files\Elixir Technologies\Bin.

4

Enter FontCvt <StemName> followed by the appropriate options.

5

Press Enter on the keyboard.
The FontCvt utility converts the Elixir font to the specified output format.

The converted font file(s) are placed at the location drive:\Elixir\Fonts\Printer\.

6
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Close the window.
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Formprn
The FormPrn utility is used to convert Elixir forms to XES 2700, 4045, 4235, and 4700
forms respectively. The utility also prints Elixir overlays in batch mode using
MS-DOS commands.
To use the FormPrn utility without any issues, it is recommended to install
DesignPro Tools using the default settings (in drive:\Elixir), and default folders
should be used to store the resources. For example, all Elixir fonts should be
saved in drive:\Elixir\Font\Elixir. If these default settings are not used, the user will
have to manually create the entire Elixir folder structure for proper operation of
these utilities.

Usage: FormPrn [Path] FileName [4045 | 2700 | 4235 | 4700 | HP] [Printer | Disk]
[Copies] [Ascii | Ebcdic | SmartBox] [MacroNumber | Priority] [TrayNumber]
[LPT1 | LPT2 | LPT3] [Print | Store | StorePrint | Constant] [InterWord | InterChar]
[Once | Always | Never] [XShift] [YShift] [-Port] [-NoExpand] [-DoTags]
[-DoTagName] [-XESOnly] [-FIX4235] [-HPESC:TableName] [-PrintDirection]
[-SplitFiles] [-Exclude]
Where:

Path: identifies optional DOS pathname.



FileName: identifies any DOS filename. Wildcards are allowed.
4045 | 2700 | 4235 | 4700 | HP: creates output to any one of the selected printer type.
4045 is default.



Printer | Disk: generates output to printer or disk. PRINTER is default.



Copies: indicates the number of copies to print. Default is 1.



Ascii | Ebcdic | SmartBox: specifies any one of the formats: ASCII (Default) for
locally attached printers; EBCDIC for host attached printers; SMARTBOX for host
attached printers using smartbox or agile.



MacroNumber | Priority: identifies macro number or Plane Priority (0 = NONE).



TrayNumber: indicates the tray number to use (0 = DEFAULT TRAY).



LPT1 | LPT2 | LPT3: uses any one of the printer ports. LPT1 is default.






Print | Store | StorePrint | Constant: specifies any one of the options: print form,
constant page or storage to printers disk.
InterWord | InterChar: indicates interword or intercharacter spacing.
Once | Always | Never: specifies any one of the font downloading options: once
(default), Always or Never.
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XShift: specifies the amount to shift in horizontal direction. Supports negative
values for horizontal shift as well.
YShift: specifies the amount to shift in vertical direction. Supports negative values
for vertical shift as well.
-Port: identifies an optional parameter to force page to be portrait.
-NoExpand: identifies an optional parameter to NOT expand X0 fonts to X1-4
fonts.



-DoTags: identifies an optional parameter to print the tags as replacement characters.



-DoTagName: identifies an optional parameter to print the tag names.









-XESOnly: identifies an optional parameter that specifies not to send JOB control
commands.
-FIX4235: identifies an optional parameter to change order of fonts for 4235
problem.
-HPEsc:TableName: identifies an optional parameter to specify an ESCAPE table
name.
-PrintDirection: identifies an optional parameter to use the print direction
command.



-SplitFiles: identifies an optional parameter to split the fonts into a separate file.



-Exclude: identifies an optional parameter to exclude page settings.

To use the FormPrn utility:

1
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Create the following new folders:
 Demo: creates the Demo folder at the location drive:\Elixir\Forms\Elixir.
 Prints: creates the Prints folder at the location drive:\Elixir\.
Also create the following sub-folders in the Prints folder:
X27Print: stores the files converted to 2700 XES format.
X45Print: stores the files converted to 4500 XES format.
X42Print: stores the files converted to 4200 XES format.
X47Print: stores the files converted to 4700 XES format.

Section IV: Utilities

2

Open the Command Prompt window.

3

Change directory to drive:\Program Files\Elixir Technologies\Bin.

Convert the fonts used in the forms to the appropriate output format before
converting the form and place them in drive:\Elixir\Fonts\Printer folder.

4

Enter FormPrn <FileName> followed by the appropriate conversion options.

5

Press Enter on the keyboard.
The form is converted to the specified output format.

6

Close the window.
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Metainw
The Metainw utility converts a normalized metacode file to ELX format. It creates one
ELX file for every page in the metacode file.
Usage: Metainw FileName [Auto | Port | Land | First] [Letter | A4 | 14 | 17 | A3 |
######] [Monitor] [V#### | F#### | R####] [Offset] [Skip]
[Ident][FontList:FontListFileName] [-FontIndex] [-FirstPage:######]
[LastPage:######] [-ReportOnly] [-LongName] <Enter>
Where:










Auto | Port | Land | First: specifies the orientation of the document.
• Auto: autodetects the orientation of the document.
• Port: sets the orientation to portrait.
• Land: sets the orientation to landscape.
• First: uses the first font.
Letter | A4 | 14 | 17 | A3 | ######: specifies the page size. You can enter one of the
options or specify custom page size, where ###### specifies WWWHHH in inches
* 10 (085110). LETTER is default.
Monitor: specifies any one of the options: NONE, VGA, SIGMA, WYSE,
SUPERVGA, MVGA (NONE=No Graphics).
V#### | F#### | R#### | C: specifies any one of the record formats for the input file:
Variable or Fixed or Record or CRLF block format and optional block length. V####
is default.



Offset: uses an Offset (from jsl) to the start of the DJDE ident.



Skip: uses a Skip (from jsl) to the start of the DJDE command.



Ident: specifies the DJDE (Dynamic Job Descriptor Entry) prefix that is used to
identify the DJDE records in the input file.



-FontList:ListName: specifies an optional external PDE font list (stem name only).



-FontIndex: specifies an optional parameter to use a font index.



-GraphicOrient:Orient: specifies an optional parameter P, L, A.



-FirstPage:######: specifies an optional parameter for the starting page number.



-LastPage:######: specifies an optional parameter for the ending page number.
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FileName: specifies any DOS filename, including extensions. Wildcard characters
are permissible.

ReportOnly: specifies an optional parameter to display only the input file
information in detail in the console window, and the file is not actually converted.
-LongName: specifies an optional parameter for using 8 character names.
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To run the Metainw utility:

1

Open the Command Prompt window.

2

Change directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter Metainw <filename> followed by the appropriate conversion parameters.

4

Press Enter on the keyboard.
Metainw utility starts the conversion.

The details of the file conversion are displayed in the Notepad window.

5

Close the window.
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Pack
The Pack utility converts JSL, FSL, and other ASCII format files to standard Xeroxlabeled files. Pack places the standard Xerox header on ASCII files and strips off text
beyond column 80 and packs data into 512-byte blocks. Pack also converts the Xeroxformat files to 80-byte record length ASCII format.
See “Moving Online Xerox-Labeled Files” on page 137 in Chapter 7: "File Transfers for
Xerox" for more information.
Usage: Pack <FileName.ext> [convert] <Enter>
Where:




FileName.ext: identifies an 80-byte record format file name, including the file
extension. Wildcard characters are permissible.
Convert: specifies one of the following options for conversion:
• Block: converts 80-byte record length ASCII files to Xerox format with
a 128-byte header followed by 512-byte blocks of data (default).
• UnBlock: converts Xerox files from 512-byte blocks to ASCII format.

To run the Pack utility:
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1

Open the Command Prompt window.

2

Change directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter Pack <FileName> followed by the appropriate conversion options

4

Press Enter on the keyboard.
Pack utility converts the file to the required format.

5

Close the window.
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ReBlock
The Reblock utility reformats the record length structure of any file. This utility can read
and write BDW/RDW, RDW, Fixed, and CRLF structures.
Usage: Reblock FileName [V####|F####|R####|CRLF|X####|PRU]
[V####|F####|R####|CRLF] [-OutputName:FileName] [-InrdwLength:##]
[-OutrdwLength:##] [-Reverse]
Where:






FileName: identifies DOS file name including the file extension. Wildcard
characters are permissible.
V####|F####|R####|CRLF|X####|PRU: specifies either of the Variable, Fixed,
Record or CRLF block format and optional block length. V#### is default.
V####|F####|R####|CRLF: specifies either of the Variable, Fixed, Record or
CRLF block format for output format and optional block length. V#### is default.



- OutputName:FileName: specifies the name of the output file.



- InrdwLength:##: specifies the inter-word length.



- OutrdwLength:##: specifies the outer-word length.



- Reverse: prints records in reverse order.

To run the ReBlock utility:

1

Open the Command Prompt window.

2

Change directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter Reblock <FileName> followed by the appropriate conversion options

4

Press Enter on the keyboard.
The Reblock utility converts the file according to the options provided in command
prompt.
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5

Close the window.
If you donot specify [- Outputname:Filename] along with other Reblock
parameters, the output files will be placed in the same location as that of the
input file, and with an REB extension.

Strip
The Strip utility adds and removes a 128 or a 512-byte header from Xerox resources.
Usage: Strip FileName [HeaderFormat] [KeepName][-Strip][-Pad] <Enter>
Where:




FileName: identifies any DOS file name including the file extension. Wildcard
characters are permissible.
HeaderFormat: specifies any one of the Xerox header formats:
• NONE: does not add a Xerox header.
• 128: adds a 128-byte Xerox header.
• 512: adds a 512-byte Xerox header.



KeepName: keeps the original file header name.



-Strip: strips the line numbers and trailing spaces from text files.



-Pad: adds line numbers and trailing spaces to text files.

To run the Strip utility:
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1

Open the Command Prompt window.

2

Change directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter Strip <FileName>, followed by the required header format options.
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4

Press Enter on the keyboard.
The Strip utility places 512-byte header records on all files with FRM extensions in
the specified directory.

5

Close the window.

XDisk32
The DesignPro Tools package includes the XDisk32 utility, which is a third party utility
provided by Xerox that is used for moving files from machines having Windows NT or
Windows 2000 to a floppy disk.
The Xdisk32 utility is available at the Elixir home page.
To download this utility:

1

Go to http://www.elixir.com/support.htm and select Patches.

2

Click Download Patches Here and enter your login information.

3

From the drop down list, select Elixir Application Suite and click Proceed to
Download.

4

Select XDisk32 from Select Release/Patch drop down list.

5

Read the terms and conditions carefully and click I Agree to download the utility
and its associated documentation.

To open the Xdisk32 utility, your machine needs to be configured as per the instructions
provided in the document available with Xdisk32 utility.
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Elixir CodePage Editor
A Code Page is a font file that associates code points and graphic character identifiers. It
might be required to modify this association in some cases. The DesignPro Tools provides
the Elixir Code Page Builder utility (ElxCPBuilderu.exe) to associate code points with
GCID identifiers. This utility operates in two different modes: AFP mode and the Normal
mode.




The AFP mode is used to define Unicode to GCID mapping for an existing AFP
coded font.
Normal mode provides full functionality for creating or modifying a code page.

Opening Elixir Code Page Editor
To open the Elixir Code Page Editor:
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1

Open the Command Prompt window.

2

Change the directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter ElxCPBuilderu.

4

Press Enter.
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The Elixir Code Page Editor opens.

Sample font
selected

Unmapped/ Coded
Font

Splitter

Sample Font

The Code Page Editor is split into two panes. When you open the editor, a sample font is
displayed in both the panels. On opening a font in the editor, the left panel displays the
unmapped font opened along with its mapping to the sample font, and the right panel
displays the sample font only.

Working Modes
This Code Page Builder operates in two different modes:




AFP Mode: used to define Unicode to GCID mapping for an existing AFP coded
font. You can choose to work in the AFP mode by checking View, AFP Mode from
the menu.
Normal Mode: provides full functionality for creating or modifying a code page.
You can choose to work in the Normal mode by unchecking View, AFP Mode from
the menu.

Working in both the modes is similar with slight differences. The differences are
mentioned explicitly in the documentation wherever applicable.
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Working with the Sample Font
The sample font displays in the right pane of the Elixir Code Page Editor window, and
assists you in the font mapping process by displaying the sample glyphs and their
corresponding code point values (in unicode). The sample font will have no impact on the
code page created.
The following sections explain working with the sample font:

Changing a Sample Font
Select the required font from the drop-down list of fonts available in the toolbar. The
selected sample font is displayed in the right pane of the Elixir Code Page Editor
window.

To show/hide the toolbar, select View, Toolbar from the menu.

Viewing the Sample Font
Each character in the sample font displays in a separate box in the right pane. You can map
these to the code points for the font opened in the right pane.

A character glyph in the sample font.
It displays colored if mapped to any
character in the left pane.

Unicode value for the code point
displaying in hexadecimal format.

Each codepoint displays options in different colors.
Sample font characters that are not mapped to any character in the left pane (opened font)
display in black color.
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You can adjust the sample font view as required by selecting the following options
available in the Sample Font menu:


Zoom In: magnifies the selected sample font area.



Zoom Out: decreases the magnification.

Customizing the Sample Font Display
To customize the sample font display:

1

Select View, Options from the menu.
The Elixir Code Page Editor Options dialog displays.

2

Click the Sample Font tab to display the associated options.

3

Select the required font size from the Pointsize drop-down list.

4

To display all characters in black color, uncheck Colorize Mapped Positions. You
can specify a color for mapped glyphs in the sample font by checking Colorize
Mapped Positions, and then clicking the color box adjacent to it.
The Color dialog displays.

5

Choose the required color, and then click OK.

6

To hide the Unicode character values, uncheck Show Unicode Values. You can
specify a color for Unicode character values by checking Show Unicode Values, and
then clicking the color-box adjacent to it.
The Color dialog displays.

7

Choose the required color, and then click OK.

8

To display the Unicode values in Hexadecimal format, check Hexadecimal Display.
When this option is unchecked, the Elixir Code Page Editor displays the Unicode
values in Decimal format.

9

To display the tool tips for each code point, check Show Tooltips.

10 Click Apply, and then click OK.
The settings apply to the sample font displaying in the Code Page Editor window.
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Creating a New Code Page
To create a new code page using a Windows code page:

1

Select File, New from the menu.
The New Code Page dialog displays.
You can also create a new code page by performing either of the following
functions:



2

Click
on the toolbar.
Press Ctrl + N on the keyboard.

Select or review the following options:
 Use Selected Windows Code Page as Template: specifies that a Windows code
page is used. Select an appropriate option from the adjacent drop-down list.
 Simple Direct Code Page (with 256 Code Points): specifies that a simple direct
code page is used.
 Blank Code Page (with No Code Points): specifies that a blank code page with
no prior mapping is used.

The Simple Direct Code Page and the Blank Code Page options are
available in the Normal mode only.

3

Click OK to return to the Elixir Code Page Editor window.
The newly created code page displays in the left pane of the window. You can now
create/map the required entries.

For more information, refer to “Mapping a Code Point” on page 187 and
“Saving the Code Page” on page 190.
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Opening an Unmapped Font
You can also open unmapped Elixir Font Files (HDR) and Xerox Font Files (FNT) in the
Elixir Code Page Editor, and then map each code point individually, as required.
To open an unmapped font:

1

Select Unmapped Font, Load from the menu.
The Open dialog displays.

2

Select the required file type from the Files of Type drop-down list. The available
options are:
 Elixir Font Files (*.hdr)
 Xerox Font Files (*.fnt)
 All Files (*.*)
The files of the selected type display in the dialog.

3

Browse to the required directory from the Look In drop-down list, and select the
font file.
The name of the selected file displays in the File Name entry box.

4

Click Open.
The selected font displays in the left pane of the Elixir Code Page Editor window.
The name of the font file currently displaying in the left pane appears in the field
adjacent to the fonts drop-down list in the toolbar.
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Viewing the Unmapped/Coded Font
Each character displays in a separate box (symbolizing a code point) in the left pane. You
can map these to the sample font characters from the right pane.
While working in Normal mode, the font in the left panel is referred to as
Unmapped Font in the menu, where as in the AFP mode, the font in the left
panel is referred to as Coded Font in the menu.

The following image shows a code point from the Normal mode:

Glyphs of the sample font.

Unmapped/coded font.

Code point numbers.

Each codepoint displays options in different colors.
In AFP mode, the coded font is displayed in green boxes, as shown in the following
image:
Gray boxes represent the
unused code points.

Green boxes represent the
standard GCIDs.

The selected font opens on the left side of the Elixir Code Page Editor window.
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While working in the AFP mode:


: The gray boxes represent the unused code points.



: The green boxes represent the standard GCIDs in the code page.



: White boxes represent the non-standard GCIDs in the code page.
The mapping will be according to the template code page selected earlier for a
non standard GCID. For a standard GCID, it will be according to the code page
associated with it.

You can zoom in and zoom out the fonts in the Elixir Code Page Editor window. Select
the following menu options from the Unmapped Font (in Normal mode) or the Coded
Font (in AFP mode) menu:


Zoom In: magnifies the selected font area.



Zoom Out: reduces the magnification of the selected font area.



Native Size: brings the selected font back to the native size.

Mapping a Code Point
You can map a Code point in the opened font (for example ‘2’), to a Code point in the
Sample font area (for example, the character, ‘b’). This will result in replacing ‘2’ in the
code point selected in the left panel with ‘b’ and will change the coded font glyph (in
blue).
To map a code point in the left panel to a code point in the sample font:

1

Select the code point you want to edit in the left pane.

2

Locate the sample character you want to map in the right pane. Right-click the
sample character, and then select Map to Code Page from the pop-up menu. You
can also double click the sample character to map it to the opened font.

Chapter 8: Stand-Alone Utilities

187

The following image illustrates the steps involved:
1. Select a code point for mapping
from the left pane.

2. Right-click the sample character to
be mapped from the right pane, and
select Map to code page.

3. The mapping is defined.

Mapping a Code point in the left panel to a Code point in the Sample font.
You can also map a code point by displaying the properties of a code point in the opened
fonts area, and entering the Unicode value of the required character in the Unicode entry
box of the Code Point Properties dialog. See task below that explains the mapping in
detail.
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Setting Properties of a Code Point
To set properties for a code point:

1

In the left pane, select a code point that you want to edit.

2

Select Code Point, Properties from the menu.
The Code Point Properties dialog displays.
The Position box displays the position (value) of
the Code point in the Code page.

You can also right-click the code point and select Properties from the pop-up
menu, to display the Code Point Properties dialog.

3

In the Unicode entry box, specify the Unicode value of the code point (from sample
font) that is to be mapped. This value is unique for every character and can be
changed. You can view the Unicode values for sample font characters from the right
pane.

4

Specify a Graphics Character Identification value for the character in the GCID
entry box. Refer to the applicable keyboard mapping files (KMPs) for appropriate
values.
If a code point is not required, check Code Point Unused in the Code Point
Properties dialog. Similarly, to use an unused code point, uncheck Code point
Unused. The unused code points display in gray colored boxes in the left pane.
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5

Click OK to return to the Elixir Code Page Editor window.
You can also specify the mapping by performing either of the following functions:



Select the required code point in the left pane,
Right-click the code point to be mapped in the right pane, and then select
Map to Code Page from the pop-up menu.

Saving the Code Page
To save the code page:
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1

Select File, Save from the menu.
The Select Resource Library for Writing dialog displays.

2

Select Elixir Resource Libraries (*.erc, *.erc32) from the Files of Type drop-down
list.

3

Browse to drive:\Elixir from the Look In drop-down list and select Lib.erc.
The File Name entry box updates with the selected file name.

4

Click Open.
The drive:\Elixir\ lib.erc dialog displays.

5

Expand the Library Root tree structure, and select the Code Pages sub-node.

6

Specify a name of the Code Page in the Resource Name entry box.
The read-only Resources of Type drop-down list indicates that the resource being
saved in the library is a code page.

7

Click OK.
The new code page is added to the Code Pages tree node. You can view the Code
pages in Lib.erc using the Elixir Resource Librarian.
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Reviewing Code Page Properties
To review the properties of a code page:

1

Select Code Page, Properties from the menu.
The Elixir Code Page Properties dialog displays.

2

Select the Entries category to display a tabular list of the Code Page Position,
Unicode, and GCID mappings shown in decimal values.

3

You can perform the following operations on the table:
 Create a new entry by specifying the required Position, Unicode, and GCID
settings under the Current area, and then clicking Add. Position values are
unique in a code page and cannot be repeated.
 Select an entry in the table, and view/edit its properties under the Current area.
 Select an entry, and click Remove to remove the entry from the table.
A preview of the selected entry (character) displays in the Glyph Preview area.
You can change the preview font by clicking Demo Font. The Font dialog
displays to select the required font.

4

Select the Default category, and specify the unicode value for a required default
character in the Default Character entry box.
The specified default character displays whenever the character defined in the
character is not available.

5

Click Apply, and then click OK to save the settings.
The Code Page displaying in the left pane reflects the changes.
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Exporting the Code Page to Resource Map
While working in AFP mode, if you want to use the defined mapping, you need to export
it to the Resource Map. The Resource Map has a table of pre-defined mappings available.
To export the mapped code page to the Resource Map, select File, Export to Resource
Map from the menu.
The Unicode values you mapped with the characters (GCIDs) here will now become
effective for using in Form Editor.
Elixir Code Page Editor provides an option for changing from the Normal to AFP
mode during the application session. However, before changing the mode, you
need to save the code page that you are currently working on.

Customizing Elixir Code Page Editor
You can customize the Elixir Code Page operations and appearance by changing the
default options. The Elixir Code Page Editor Options dialog in the Code Page Editor
displays the available options in four category tabs. You can select the appropriate options
in checkboxes in each category page.
Setting General Preferences
To set the general preferences in the CodePage Editor:
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1

Select View, Options from the menu.
The Elixir Code Page Editor Options dialog displays.

2

Click the General category tab.

3

Check Show Error Messages on Status Bar to display the error messages on the
Status bar of the Elixir Code Page Editor.

4

Check Show Selected Code Points on Status Bar to display the properties of the
selected code point in the Status bar. The properties are displayed when you click on
the required code point.

5

Click Apply, and then click OK to apply the settings in the Code Page Editor.
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Setting Code Page Preferences
To set the code page preferences in the Code Page Editor:

1

Select View, Options from the menu.
The Elixir Code Page Editor Options dialog displays.

2

Click the Code Page category tab.

3

Select either of these options from the Show Mapping as Area to specify the
mapping display options:
 Glyphs of the Sample Font: displays glyphs of the sample font.
 Unicode Values: displays Unicode values of the code page.
Clicking the color box in Show Mapping as Area opens the Color dialog; you
can select the required color for displaying the sample font mappings from this
dialog.

4

Check Show Unmapped Font to display all of the unmapped fonts in the Code page
Editor.
Clicking the color box adjacent to Show Unmapped Font opens the Color dialog;
you can select the required color for displaying the unmapped code points from this
dialog.

5

Check Show Code Point Numbers to display the numbers below the code points in
the fonts.
Clicking the color box adjacent to Show Code Point Numbers opens the Color
dialog, you can select the required color for displaying the code point numbers from
this dialog.

6

Check Show Tooltips to enable the tooltips for the code points and code pages in the
Code Page Editor.

7

Check Hexadecimal Display to show the Unicode values for each code point in
Hexadecimal format. When unchecked, the Unicode values display in the Decimal
format.

8

Click Apply, and then click OK to set the code page preferences in the Code Page
Editor.
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Setting Coded Font/Unmapped Font Preferences
In AFP mode, the left pane shows the coded font and in the Normal mode it displays the
unmapped font. Accordingly, the Options dialog displays the Coded Font tab in AFP
mode, and the Unmapped Font tab in the Normal mode.

Image shows: (1) The Coded Font tab in AFP mode (2) interchanged with the Unmapped
Font tab in Normal mode.
To set the Coded Font/Unmapped Font preferences in the Code Page Editor:

1

Select View, Options from the menu.
The Elixir Code Page Editor Options dialog displays.

2

Click the Coded Font or the Unmapped Font category tab (whichever applicable).

3

Check Show Baseline to specify the baselines of the code points in the opened font.
Clicking the color box adjacent to Show Baseline opens the Color dialog; you can
select the required color for displaying the base line from this dialog.

4

Click the color box adjacent to Cell Color for Registered Characters to open the
Color dialog; you can select the required color for displaying the registered
characters from this dialog.

The Cell Color for Registered Characters option is available only in the
AFP mode.

5

Click Apply, and then click OK to set the Coded Font preferences in the Code Page
Editor.

Profile Selection
You can also use the profile selection feature in the Elixir Code Page Builder utility. To
select a profile, select View, Profile Selection from the menu. For information on profile
selection preferences, refer to Chapter 9: “Elixir Profile Editor” on page 207.
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ElixiTag
Data fields have to be defined and added to a form to indicate where specific variable data
will be placed. Adding data fields to a form is called tagging a form. You can tag an Elixir
form or Windows-based document by creating an external tag attribute file and
referencing fields within that file in your document. ElixiTag is a simple utility for
creating Tag Definition lists independent of form creation. You can create, as well as edit
the existing data tags.

Starting ElixiTag
To run ElixiTag:

1

Open the Command Prompt window.

2

Change the directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter ELXTAG.

Image shows the Elxtag command entered in the Command Prompt window.

4

Press Enter.
The ElixiTag dialog displays.
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Working with ElixiTag
ElixiTag dialog enables you to create and edit data tags. You can set various fields of data
tags. These fields are as follows:
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Search by Name: searches for a tag by field name in the tag list to display the tag
attributes. You can enter a field name that exists in the current tag list, and then apply
the same parameters to the current field. If the DataMerge operation finds a match in
the current tag list, the parameters of that field display.
Number: specifies the name of the variable data field. In case you do not specify the
number, ElixiTag increments the default field numbers that are sequential and starts
from 01. The maximum number entry is 700.
Name: specifies the name of the variable data field. The maximum length of the
field name is 30. Use the name prefix to specify different types of tags.
The tag name prefixes are described below:
• CHECK_: the FDF field (Active Objects in Forms) in the PDF file will display
an empty box. When the user selects the checkbox, the character will display.
• CHECKB_: the FDF field in the PDF file will display an empty box surrounded
by a border.
• DROP_: the FDF field in the PDF file will display the list of entries entered in
the Comment field as a drop-down list. See the Comment field for adding
entries to be used by a drop-down selection.
• DROPEDIT_: the FDF field in the PDF file will display the list of entries
entered in the Comment field as a drop-down list and also enables additional text
entry in the FDF field. See the Comment field for adding entries to be used by a
drop-down selection.
• GRAY_: the FDF field in the PDF will be filled with a shade pattern.
• BORDER_: the FDF field in the PDF file will be surrounded by a border and the
color of the border is defined in the Pdf.txt file.
• SUBMIT: identifies a reserved keyword.
• COMPLETE: identifies a reserved keyword.
• SIGNATURE: identifies a reserved keyword.
• $_: the Forms Data Format (FDF) field in the PDF will display entered data as
right justified using the comma separator and two decimal places. For example,
2004.28 will be displayed in the field as $ 2,004.28.
• #_: the FDF field in the PDF will display entered data as right justified using the
comma separator with two decimal places. For example, 2004.28 will be
displayed in the field as 2,004.28.
• TOTAL$_: totals the data entered in fields listed in the Comment field and
displays the result as dollar currency, right justified using the comma separator
and two decimal places.
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• TOTAL_: totals the data entered in fields listed in the Comment field and
•
•












displays the result as right justified, using the comma separator and two decimal
places.
MULT$_: multiplies the data entered in fields listed in the Comment field and
displays the result as right justified dollar currency amount.
MULT_: multiplies the data entered in fields listed in the Comment field and
displays the result as right justified amount.

Length: specifies the maximum number of characters permissible in the specified
field. If the variable data item requires less than the maximum number of characters,
the paragraph will be formatted so that there are no extra spaces between the variable
data item and any following text. Non-replacement characters are also included in
the field length.
Replacement Char: specifies the replacement character to be used by the data tag.
DocuMerge variable data fields display in the document as a string of replacement
characters. The replacement character is usually a @, !, #, or "character.
Replacement characters should not be characters used in the text data. If you want to
specify your own replacement character, backspace over the default character and
enter a new one.
Mandatory: specifies whether the tagged data is mandatory or optional. It enables
you to tell DocuMerge if the specified variable data field is mandatory or optional
when printing the document. If you specify it as M (mandatory), DocuMerge flags
the document with an error flag if the variable data is missing. If it is specified as O
(optional), the document prints with blank spaces in place of the replacement
characters if the data is missing.
Delete After Use: indicates whether to delete the tagged data or not after its use in a
replacement field to keep it from being used in a subsequent reference to the same
tag name. The valid values are Y (yes) or N (no). Specify Y if you use the same field
name in multiple forms, but require different values for each use. Specify N if you
use the same field name in multiple forms with the same data value for each use. The
default is N.
Field End: specifies the character that matches the field end character found in the
DocuMerge variable data. The default is $. Only those field end characters can be
specified that are not passed as variable data by DocuMerge.
Multi-Data: specifies the number of line skips to be issued between elements during
merging into a block. This option links two different data fields when printing. N
specifies there is only one variable data item associated with the tag name (the
default). 0 through 9 indicates the number of line feeds you want generated between
line breaks.
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Align: specifies a two-digit code to link the specified field name with another for
printing purposes.
Depth: specifies the number of lines in the specified variable data field. The default
is 01.
Field Gen: specifies the non-replacement characters to be used in the middle of a
string of replacement characters. This is useful when formatting date fields or
telephone numbers. For example, to separate the month, day, and year in the date
field with slashes, enter **/**/** (where * is the replacement character you
specified).
Comment: enables you to enter a comment relating to the field (up to 31 characters).
For example, you may want to enter a comment to distinguish the field from another
field that is similar.
Scroll by Number: enables you to scroll through the current tag list by clicking on
the left or right arrow in the Scroll by Number option. If the tag list contains many
fields, press and drag the scroll box forward or backwards.

Set Delete After Use to YES when specifying a value for Multi-Data field,
and specify the Length for the number of line feeds generated.

Saving a Tag File
You can save an external tag attribute file with the same name or with a different name. To
save the file with the same name, select File, Save from the menu.
Select File, Save As from the menu to save the file with a different name.

The tag file is saved at the location drive:\Elixir by default.
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Editing an Existing Tag
ElixiTag enables you to edit the existing tag files.
To edit a tag file:

1

Select File, Open from the menu.
The Open dialog displays.

2

Select the file that you want to edit.

3

Use Scroll by Number to display the data field you want to edit.

4

Edit an option by backspacing over the current parameter and entering a new
parameter.

5

Save the file with the same name or with a different name.

Adding a Tag
To add a tag:

1

Click Add New Tag.
An empty tag is added at the end of the file.

2

Fill in the required fields.

3

Save the file.

By default, the tags are added to the file Dttags.tag.

Deleting a Tag
To delete a tag:

1

Select the required tag using the Scroll by Number scroll bar.

2

Click

3

Click Delete Tag.
The selected tag is deleted.

or

to scroll through the list of tags.
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Copying a Tag
To copy an ElixiTag to a Windows-based document:

1

Click Copy to copy the tag information to the clipboard.

2

Open the document you want to tag.

3

Position the cursor on the document where you want to place the tag and click the
left mouse button.

4

Press Ctrl + V or select the Paste option in your application.

The control characters, field number, and any tag replacement characters display in the
document. It takes five characters to define a tag. Replacement characters are added in the
tag if the field length is more than five characters so that the tag is approximately the
length of the field.

Exiting ElixiTag
To close the ElixiTag utility, select File, Exit from the menu.

Makepub
The Makepub utility zips and unzips the resources in a file/folder into a single file with a
PUB extension. This is useful while creating or moving forms when users have to keep
track of all of the resources being used (such as fonts, images, etc.). It helps to reduce the
file size and time for file transmission. This utility can archive and extract Elixir Legacy
Documents (ELX), Elixir Forms (EFR), and Data Files (DAT) including their resources.
You can also extract files from an existing pub file.
MakePub enables you to perform the following:


Archive: creates a pub file by zipping the resources into one file.



Extract: extracts files from an existing pub file.

By default, Makepub uses Elixir default paths; however, you can set the paths of the
resources being used in the pub file.
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Usage: Makepub <ZipName> <FileSpec> [-x] [-u] [-l] [-o] [-f:FontDir] [-d:FormDir]
[-p:PicsDir] [-e:ElixirDir] [-t:TextsDir] [Enter]
Where:






ZipName: specifies the path, name, and extension of the pub file to be created (for
example drive:\Elixir\Forms\Afp\O1test.pub).
In case of extracting files, the zipname specifies the name of the PUB file to be
extracted.
FileSpec: specifies the name and path of the file or folder for which a PUB file is to
be created. FileSpec can be any file name or wildcard.
[OPTIONS…]: the following options are available when creating a pub file:
• -X: specifies that pub files are to be extracted.
• -L: displays the list of resources in a pub file.
• -O: overwrites resource files while extracting.
• -U: specifies that user-specified command line directories are to be used while
creating the PUB files or while extracting files from pub. The MakePub utility
will search in the user-specified paths for the referenced resources.
The available options are as follows:
-F:FONTDIR: specifies the location for the fonts. The default path for font
directory is drive: \Elixir\Fonts\Elixir.
-D:FORMDIR: specifies the form directory that the pub file will refer to. The
default path for form directory is drive:\Elixir\Forms\Elixir\Demo.
-P:PICSDIR: specifies the directory for image resources to be used in the pub
file. The default path for images directory is drive:\Elixir\Pics\Printer.
-E:ELIXIRDIR: specifies the path for Elixir Folder. The default path is
drive:\Elixir.
-T:TEXTSDIR: specifies a text directory. The default path is drive:\Elixir\Texts.

You can enter more than one option in a single command.
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Running the MakePub Utility
To run the MakePub utility:

1

Open the Command Prompt window.

2

Change the directory to drive:\Program Files\Elixir Technologies\Bin.

3

Enter Makepub <Zipname> <Filespec> [Options].

The <filespec> names can include wildcard characters.

4

Press Enter on the keyboard to create the PUB file.

Creating a PUB file.
Using the MakePub utility, you can specify paths for the resources, both during the
making of a pub file and extracting a pub file. If a pub file is being made, the utility
will search in the user specified paths for the resources referenced from EFR, ELX,
and DAT files. If pub is being unzipped, the files in the pub will be placed in the user
supplied paths.
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5

To change the resource directory path, use the command:
Makepub <Zipname> <Filespec> -u [-f:fontdir] [-d:formdir] [-p:picsdir]
[-e:elixirdir] [-t:textsdir].

6

Press Enter on the keyboard.

The resource directory paths for O1test.pub.

Listing Files
You can use the list option to list the resources added in the pub file.
Enter the command: Usage: Makepub <ZipName> <FileSpec> -L and press Enter.
The command prompt lists the specified files.
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Extracting Files
To extract files:

1

Open the Command Prompt window.

2

Enter Makepub [ZipName] [FileSpec] -X.

3

To overwrite existing resources, use the command:
Makepub [ZipName] [FileSpec] -X –O
The command prompt displays the extracted files.

PDF Plug-In
The PDF Plug-In utility provides the facility of converting PDF files to AFP format using
Elixir Print Driver Pro for printing. This is required because during printing, the Adobe
Acrobat passes temporary font names (for example, Ztr1.tmp) to Elixir Print Driver Pro
for Embedded fonts and Referenced Type1 fonts.
This plug-in modifies the functionality of documents containing embedded True Type
fonts, referenced Type 1 fonts, and embedded Type 1 fonts provided that:
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True Type fonts are being used in a PDF file, they have to be installed on the user
system before conversion.
Type1 fonts are being used in the file (either referenced or embedded), then the
equivalent True Type version of these fonts with exactly the same name have to be
installed on the user machine before conversion.
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Using PDF Plug-In
To use the PDF Plug-In utility:

1

Close all running instances of Adobe Acrobat 6.x (or 7.x).

2

Place Elixiracroplug.api at drive:\Program Files\Adobe\Acrobat 6.x (or
7.x)\Acrobat\Plug_ins.
An option Print with Referenced Fonts is added to the File menu in Adobe Acrobat
6.x (or 7.x).

The Elixiracroplug.api does not come with the DesignPro Utilities. It is provided
on demand.

3

Open Adobe Acrobat 6.x (or 7.x).

4

Open the required PDF file.

5

Select the File, Print with Referenced Fonts from the Adobe Acrobat menu.
The Embedded fonts are converted to Referenced fonts, and then the document is
printed.

To print the document without the effects of the PDF Plug-In utility, select File,
Print from the Adobe Acrobat menu,
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Chapter 9:

Elixir Profile Editor
In this chapter...


Elixir Profile Editor Overview



Profile Editor Environment



Working with Profile Editor



Customizing Elixir Profile Editor

Elixir Profile Editor Overview
Elixir applications can be customized to fulfill the requirements of your specific working
environment by creating and maintaining unique user profiles. Profile is a system file used
to save important file locations and information about Elixir applications. You can
customize the Elixir applications to suit a particular user, workgroup or enterprise by
creating, selecting, and modifying unique user profiles.
Elixir installer creates a Default profile using information provided during the installation
of an Elixir application. This file creates the basic workspace for the current user and is
located in drive:\Documents and Settings\current user\Application Data\Elixir
Technologies\Profiles in SystemData.ini file.
Default profile settings can be overridden by creating a version of the SystemData.ini file
that contains the parameters slated for customization. This file becomes an Elixir user
profile. You can set up multiple profiles to create alternate processing environments or a
single profile can be used to initialize all users in a particular working group.
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The profiles can be used to:

Service bureaus to define the unique resource (forms, fonts, images, etc.) repositories
for each customer.




System administrators to create a single set of resource directories and default
settings for all Elixir users in a working group.
Users to move from workstation to workstation and maintain the same configuration.

Profile Editor is easily accessed in all DesignPro applications to offer the same
capabilities. The Profile Selection feature enables you to select the profile you want to use
within any application. The profile selected for one application is applied separately and
does not result in profile changes for other applications. The changes take effect once the
application is restarted.
The Profile Editor saves the mapping paths of virtual folders to physical folders and
default paths for Elixir resources. Conversion resources are selected from paths specified
in the setup (.epm) file. If the resources are not present at the specified setup file location,
converters and parsers select the required resources from paths specified in the user profile
opened for that session. Any changes made to the virtual folders are also updated in the
profile file, currently in use.
If changes to folders are made through Profile Editor, all applications in the
DesignPro Tools must be closed, and then reopened for the changes to take
effect.
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Profile Editor Environment
When you open Profile Editor, the environment and all associated components in the
workspace display. The environment consists of all application objects created and
maintained in the application.
The following illustration identifies each part of the Elixir Profile Editor environment,
including the Profile window and Messages window.

Menu
Standard toolbar

Details view

Profile Tree

Messages window

Status bar

Image illustrates the components in Profile Editor environment.

Opening Elixir Profile Editor
To open the Elixir Profile Editor:

1

Click Start, and select All Programs, Elixir Applications, DesignPro Tools,
DesignPro Manager.
The DesignPro Manager opens.

2

From the Tools menu, select Elixir Profile Editor.
The Elixir Profile Editor workspace displays.

Chapter 9: Elixir Profile Editor

209

Menu
Elixir Profile Editor has menus to provide easy access to the most commonly used
application commands. The menu displays at the top left corner of the workspace by
default. The menu with drop-down menus displays directly below the application title.
Selecting a menu performs an associated action or displays a sub-menu or dialog.

Toolbar
The toolbar displays directly below the menu with buttons that provide access to the most
commonly used commands. You can hide or display the toolbars by selecting View,
Toolbars from the menu.

Profile Window
The Profile window displays the Profile Tree in the left pane, and the associated details
are displayed in the Details view in the right pane. The title bar in Profile window displays
the name of the node currently selected in the Profile Tree.
The Profile Tree depicts the Default and custom profiles under the current user Windows
login name. By default, under the root node, only the Default profile displays. The Default
profile is the default profile for all Elixir applications. You can add or remove the profiles,
and view or change the required profile properties.

The default Profile Tree displays.

Default profile is associated with SystemData.ini file.
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The Details view displays the contents of the node selected in the Profile Tree. Profile
Editor sorts these profile items by their associated color-coded icons for easy
identification and location:

Symbol

Description
Gray (default, hard coded value): item not defined in selected profile, but
inherited from an ancestor profile.
Green: item defined in currently selected profile.
Yellow: item inherited from parent profile and not re-defined in selected profile.
Yellow: environment variables in default directories inherited from parent profile
and redefined in selected profile.

To sort items in Details view, select View, Available Views from the menu and select the
required view to sort profile items in the following three views:

Flat View
Flat view displays the default environment variables and categorization of profile keys.
These variables are also displayed in the System Data or Symbols category of the
Options dialog in all DesignPro applications.

The Flat view displays the default environment variables in the Details view.
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Default Environment Variables
The Default Environment Variables are listed in the following table:
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Key

Default Value

Description

PATHEXT

.com; .ext; .bat; .cmd;
.vbs; .vbe; .js; .jse;
.wsf; .wsh

Extensions for executable files.

COMPUTERNAME

System specific

Name of the computer.

WINDIR

System specific

Windows system folder.

SYSTEMROOT

System specific

Windows system folder.

PROCESSOR_
REVISION

System specific

Version number of the processor on the
local machine.

ALLUSERSPROFILE

drive:\Documents and
Settings\All Users

Location for application settings stored
under All Users profile.

TMP

System specific

Specifies the location of temporary files.

COMMONPROGRAM
FILES

drive:\Program
Files\Common Files

Location for shared application files.

HOMEDRIVE

drive:\

Primary local drive.

COMSPEC

System Specific

Executable file for the command prompt.

OS

System specific

Installed operating system.

CLIENTNAME

System specific

Name of client.

USERNAME

System specific

User logon name.

USERDOMAIN

System specific

Logon domain.

USERDNSDOMAIN

System specific

Logon domain.

TEMP

System specific

Specifies the location of temporary files.

PATH

System specific

Lookup path for the executable files.

ELIXIRPASSWORD
FOLDER

drive:\Program
Files\Elixir
Technologies\Bin

Location of Elixir password file
(password.epw).

APPDATA

drive:\Documents and
Settings\user logon
name\Application Data

Default path to Application Data files.

PROCESSOR_LEVEL

System specific

Processor level for the local machine.

PROCESSOR_
ARCHITECTURE

System specific

Processor type for the local machine.

PROGRAMFILES

drive:\Program Files

Default path to Program Files.
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Key

Default Value

Description

LOGONSERVER

System specific

Name of the server currently logged into.

NUMBER_OF_
PROCESSORS

System specific

Number of processors in PC system.

SESSIONNAME

Console

Name of current login session.

SYSTEMDRIVE

drive:

Drive containing the MS-DOS system
files necessary to start MS-DOS.

PROCESSOR_
IDENTIFIER

System specific

PC processor size, model, and
manufacturer.

USERPROFILE

drive:\Documents and
Settings\user logon
name

File containing configuration
information for a specific user, such as
desktop settings, persistent network
connections, and application settings.

HOMEPATH

drive:\Documents and
Settings\user logon
name

Location of application settings for
current user.

Resource Type View
This view sorts and displays the profile keys according to the resource types. Resources
are listed under their respective node, as displayed in the figure below. Forms resources
display under the Forms root node.

The Resources Type view displays the profile keys according to the resource types.
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Formats View
This view sorts and displays the profile keys by file format type. For example, AFP
resources display under the AFP node; Metacode resources display under the root node of
Metacode, etc.

The Format view displays the profile keys by the file format type.
Resources and Formats Details
The resource details for different formats are shown in the table below:
OGL Format
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Key

Default Value

Description

SYSTEM_FORMS_OGL_
DIR

%Elixirdir%\Forms\Ogl\

Path to OGL forms.

SYSTEM_OGLOUT_
FORMS_DIR

%Elixirdir%\Forms\Ogl\

Output path of OGL forms.

SYSTEM_OGLIN_
FORMS_DIR

%Elixirdir%\Forms\Ogl\

Input path to source OGL
forms.
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AFP Format

Key

Default Value

Description

SYSTEM_AFPIN_IMAGES
_DIR

%Elixirdir%\Pics\Afp\

Input path to AFP images.

SYSTEM_FONTS_AFP_
DIR

%Elixirdir%\Fonts\Afp\

Path to AFP fonts.

SYSTEM_AFPOUT_JOBS_
DIR

%Elixirdir%\Jobs\Afp\

Output path of AFP files.

SYSTEM_ JOBS_AFP_DIR

%Elixirdir%\Jobs\Afp\

Path to AFP Job files.

SYSTEM_AFPIN_FORMS_
DIR

%Elixirdir%\Form\Afp\

Input path to AFP forms.

SYSTEM_AFPOUT_
FORMS_DIR

%Elixirdir%\Forms\Afp\

Output path of AFP forms.

SYSTEM_AFPOUT_
IMAGES_DIR

%Elixirdir%\Pics\Afp\

Output path of AFP images.

SYSTEM_AFPIN_FONTS_
DIR

%Elixirdir%\Fonts\Afp\

Input path to AFP fonts.

SYSTEM_AFPIN_DOCS_
DIR

%Elixirdir%\Docs\Afp\

Input path to AFP documents.

SYSTEM_GRAPHICS_AFP
_ DIR

%Elixirdir%\Pics\Afp\

Path to AFP graphics.

SYSTEM_FORMS_AFP_
DIR

%Elixirdir%\Forms\Afp\

Path to AFP forms.

SYSTEM_DOCS_AFP_
DIR

%Elixirdir%\Docs\Afp\

Path to AFP documents.

SYSTEM_AFPIN_JOBS_
DIR

%Elixirdir%\Jobs\Afp\

Input path to AFP files.

SYSTEM_AFPOUT_
FONTS_DIR

%Elixirdir%\Fonts\Afp\

Output path of AFP fonts.

SYSTEM_AFPOUT_
DOCS_DIR

%Elixirdir%\Docs\Afp\

Output path of AFP documents.
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Metacode Format

Key

Default Value

Description

SYSTEM_METAIN_
IMAGES_DIR

%Elixirdir%\Pics\Metain\

Input path to Xerox Metacode
images.

SYSTEM_METAIN_
FONTS_DIR

%Elixirdir%\Fonts\
Metain\

Input path to Xerox Metacode
fonts.

SYSTEM_METAIN_DOCS
_DIR

%Elixirdir%\Docs\Meta\

Input path to Xerox Metacode
documents.

SYSTEM_METAOUT_
DOCS_DIR

%Elixirdir%\Docs\Meta\

Output path of Xerox Metacode
documents.

SYSTEM_METAOUT_
IMAGES_DIR

%Elixirdir%\Pic
\Metaout\

Output path of Xerox Metacode
images.

SYSTEM_METAOUT_
FORMS_DIR

%Elixirdir%\Forms\
Metaout\

Output path to Xerox Metacode
forms.

SYSTEM_METAIN_
FORMS_DIR

%Elixirdir%\Forms\
Metain\

Input path to Xerox Metacode
forms.

SYSTEM_METAOUT_
FONTS_DIR

%Elixirdir%\Fonts
\Metaout\

Output path to Xerox Metacode
fonts.

Key

Default Value

Description

SYSTEM_FRMIN_
IMAGES_DIR

%Elixirdir%\Pics\Img\

Input path to Xerox IMG
images.

SYSTEM_FORMS_
FRM_DIR

%Elixirdir%\Forms\Frm\

Path to Xerox FRM forms.

SYSTEM_FRMIN_
FORMS_DIR

%Elixirdir%\Forms\Frm\

Input path to Xerox FRM
forms.

SYSTEM_FRMOUT_
IMAGES_DIR

%Elixirdir%\Pics\Img\

Output path of Xerox IMG
images.

SYSTEM_FRMOUT_
FORMS_DIR

%Elixirdir%\Forms\Frm\

Output path of Xerox FRM
forms.

SYSTEM_FRMIN_
FONTS_DIR

%Elixirdir%\Fonts\Xerox\

Input path to Xerox fonts.

SYSTEM_FRMOUT_
LGOS_DIR

%Elixirdir%\Pics\Lgo\

Output path of Xerox LGO
images.

FRM Format
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Key

Default Value

Description

SYSTEM_FRMIN_DIR

%Elixirdir%\Form\
Frmin\

Input path to Xerox forms.

SYSTEM_FRMOUT_
FONTS_DIR

%Elixirdir%\Fonts\Xerox\

Output path to Xerox fonts.

SYSTEM_FRMOUT_
DOCS_DIR

%Elixirdir%\Docs\
Frmout\

Output path to Xerox FRM
documents.

SYSTEM_FRMIN_
LGOS_DIR

%Elixirdir%\Pics\Lgo\

Input path to Xerox LGO
images.

Key

Default Value

Description

SYSTEM_GRAPHICS_
IMG_DIR

%Elixirdir%\Pics\Img\

Path to Xerox IMG images.

SYSTEM_IMGIN_
GRAPHIC_DIR

%Elixirdir%\Pics\Img\

Input path to Xerox IMG
images.

Key

Default Value

Description

SYSTEM_FSLOUT_
IMAGES_DIR

%Elixirdir%\Pics\Fslout\

Output path to Xerox images.

SYSTEM_FSLOUT_
FONTS_DIR

%Elixirdir%\Fonts\
Fslout\

Output path to Xerox fonts.

SYSTEM_FSLOUT_DOCS
_DIR

%Elixirdir%\Docss\
Fslout\

Output path to Xerox FSL
documents.

SYSTEM_FSLOUT_
FORMS_DIR

%Elixirdir%\Forms\
Fslout\

Output path to Xerox FSL
forms.

SYSTEM_FORMS_FSL_
DIR

%Elixirdir%\Forms\Fsl\

Path to Xerox FSL forms.

IMG Format

FSL Format

Chapter 9: Elixir Profile Editor

217

LGO Format

Key

Default Value

Description

SYSTEM_GRAPHICS_
LGO_DIR

%Elixirdir%\Pics\Lgo\

Path to Xerox LGO images.

SYSTEM_LGOIN_
GRAPHIC_DIR

%Elixirdir%\Pics\Lgo\

Input path to Xerox LGO
images.

SYSTEM_FRMOUT_
LGOS_DIR

%Elixirdir%\Pics\Lgo\

Output path of Xerox LGO
images.

SYSTEM_FRMIN_LGOS_
DIR

%Elixirdir%\Pics\Lgo\

Input path to Xerox LGO
images.

Key

Default Value

Description

SYSTEM_HPOUT_FORMS
_DIR

%Elixirdir%\Docs\Pcl\

Path to PCL pages.

SYSTEM_HPIN_FORMS_
DIR

%Elixirdir%\Docs\Pcl\

Input path to PCL pages.

SYSTEM_HPOUT_
IMAGES_DIR

%Elixirdir%\Pics\Hpout\

Output path of PCL pages.

SYSTEM_HPIN_FONTS_
DIR

%Elixirdir%\Fonts\Pcl\

Input path to PCL fonts.

SYSTEM_HPOUT_FONTS
_DIR

%Elixirdir%\Fonts\Pcl\

Output path of PCL fonts.

SYSTEM_HPIN_DOCS_
DIR

%Elixirdir%\Docs\Pcl\

Input path of HP/PCL
documents.

SYSTEM_HPIN_IMAGES_
DIR

%Elixirdir%\Pics\Hpin\

Input path to PCL images.

SYSTEM_HPOUT_DOCS_
DIR

%Elixirdir%\Docs\Pcl\

Output path of HP/PCL
documents.

PCL Format
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PostScript Format

Key

Default Value

Description

SYSTEM_PSIN_FONTS_
DIR

%Elixirdir%\Fonts\Atmt3\

Input path to PostScript fonts.

SYSTEM_PSJOB_
DATABASE_DIR

%Elixirdir%\Psjobs\Elixir\

Path to DesignPro Tools
database.

SYSTEM_PSOUT_DOCS_
DIR

%Elixirdir%\Docs\Ps\

Output path of Postscript
documents.

SYSTEM_PSIN_DOCS_
DIR

%Elixirdir%\Docs\Ps\

Input path to Postscript
documents.

SYSTEM_DOCS_PS_DIR

%Elixirdir%\Docs\Ps\

Path to Postscript documents.

SYSTEM_PSOUT_FORMS
_DIR

%Elixirdir%\Docs\Ps\

Output path to Postscript forms.

SYSTEM_PSIN_FORMS_
DIR

%Elixirdir%\Docs\Ps\

Input path to Postscript forms.

SYSTEM_PSOUT_
IMAGES_DIR

%Elixirdir%\Pics\Psout\

Output path to Postscript
images.

SYSTEM_PSOUT_FONTS
_DIR

%Elixirdir%\Fonts\Atmt3\

Output path of Postscript fonts.

SYSTEM_PSIN_IMAGES_
DIR

%Elixirdir%\Pics\Psin\

Input path to Postscript images.

TIFF Format

Key

Default Value

Description

SYSTEM_TIFFOUT_
GRAPHIC_FONTS_DIR

%Elixirdir%\Fonts\
Tiffout_graphic\

Output path to TIFF fonts.

SYSTEM_ TIFFOUT_GRAPHIC_
IMAGES_DIR

%Elixirdir%\Pics\
Tiffout_graphic\

Output path to TIFF images.

SYSTEM_TIFFOUT_
GRAPHIC _DIR

%Elixirdir%\Pics\Tiff\

Input path to TIFF images.

SYSTEM_TIFFOUT_
GRAPHIC _FORMS_DIR

%Elixirdir%\Forms\
Tiffout_graphic\

Output path to TIFF forms.
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PDF Format

Key

Default Value

Description

SYSTEM_PDFIN_IMAGES
_DIR

%Elixirdir%\Pics\Pdfin\

Input path to PDF images.

SYSTEM_PDFIN_FORMS_
DIR

%Elixirdir%\Docs\Pdf\

Input path to PDF forms.

SYSTEM_PDFOUT_
IMAGES_DIR

%Elixirdir%\Pics\Pdfout\

Output path of PDF images.

SYSTEM_PDFOUT_
FORMS_DIR

%Elixirdir%\Docs\Pdf\

Output path of PDF forms.

SYSTEM_PDFIN_FONTS_
DIR

%Elixirdir%\Fonts\Pdfin\

Input path to PDF fonts.

SYSTEM_PDFIN_DOCS_
DIR

%Elixirdir%\Docs\Pdf\

Input path to PDF documents.

SYSTEM_DOCS_PDF_DIR

%Elixirdir%\Docs\Pdf\

Path to PDF documents.

SYSTEM_PDFOUT_DOCS
_DIR

%Elixirdir%\Docs\Pdf\

Output path to PDF documents.

SYSTEM_PDFOUT_
FONTS_DIR

%Elixirdir%\Fonts\
Pdfout\

Output path of PDF fonts.

Messages Window
The Messages window is displayed behind the main window initially and can be moved to
any position. This window displays the processing and compilation errors, warning, and
informational messages generated by the application.
To customize message display settings, select View, Options from the menu and select the
Messages tab.
For details on working with the Messages window, and commonly encountered error and
warning messages, see:
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Messages Window (page 37)



Error and Warning Messages (page 337)
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Working with Profile Editor
You can add new profiles for use in DesignPro applications, and modify or remove the
existing profiles. Profile item properties can also be changed and new ones created.
The following tasks details the features provided in the Profile Editor.


Creating Custom Profiles (page 221)



Changing Profile Properties (page 227)



Opening a New Profile (page 231)

Creating Custom Profiles
A customized user profile is based on the structure of the SystemData.ini file. System
Data.ini contains the default directories, Resource Maps and Resource Libraries used by
Elixir applications, as well as various system settings.
When you create a new profile, Profile Editor automatically creates a corresponding INI
file on the following path in the system:
drive:\Documents and Settings\username\Application Data\Elixir Technologies\Profiles.
Removing a profile deletes the corresponding INI file from the hard disk. Profiles can be
of three types:






New Default Profile: uses all system defined profile items to create a new profile.
This profile does not directly inherit its values from any existing profile file. The
values defined in this profile are predefined by the system. After creating the Default
profile, you can customize the profile items, as required.
Derived Profile: inherits the missing profile item values from its parent profile.
Profile Editor adds a reference from the parent profile in the derived profile file. Any
updates to the parent profile are automatically inherited by the derived profile.
However, changes to the derived profile (add, remove, and edits) are not reflected in
the parent file; changes are only reflected in the INI file for the derived profile.
Cloned Profile: an exact replica of the parent profile. Unlike derived profile, this
profile is not dependent on the parent profile for any of its profile item values.
Therefore, changes made in either the parent or child profile do not affect the other
profile.
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Adding a New Default Profile
To add a new Default profile to the Profile Tree:

1

In the Profile Tree, right-click the root node denoting your Windows user name,
then select Add New Default Profile from the menu.
The Profile Properties dialog displays.

To add a new default profile to the Profile Tree, you can also press Ctrl + N on
the keyboard.

2

Enter a unique name identifying the profile in the Profile Name entry box.

If you enter a profile file name that does not exist, Profile Editor automatically
creates an associated INI file at the specified location.
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3

Click
adjacent to the Profile INI File Path entry box.
The Open Profile Configuration File dialog displays.

4

Select your required file type from the Files of Type drop-down list in order to
display all of the files of that type present in the selected directory.
The file type is selected as Profile Configuration File (INI) by default.

5

From the Look In drop-down list, browse to the required directory and select the
file.
The name of the selected file displays in the File Name entry box.

6

Click Open.
The Profile INI File Path entry box displays the specified path.

You can enter a brief narrative about the profile item in the Description entry
box.

7

Check Only For Current User to make the profile available for the local user only
on a machine. Unchecking this option will create the profile as shared/global, and
will be available to all the users on a machine.

8

Click OK to create a new profile and return to the Profile Editor workspace.

Adding a Derived Profile
To add a derived profile:

1

Right-click the parent profile from which you are deriving the new profile in the
Profile Tree.

2

Select Add Derived Profile from the pop-up menu.
The Profile Properties dialog displays.

To add a new derived profile to the Profile Tree, you can also press Ctrl + D
on the keyboard.
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3

Enter a unique name identifying the profile in the Profile Name entry box.

If you enter a profile file name that does not exist, Profile Editor automatically
creates an associated INI file at the specified location.

4

Click
adjacent to the Profile INI File Path entry box.
The Open Profile Configuration File dialog displays.

5

Select your required file type from the Files of Type drop-down list in order to
display all of the files of that type present in the selected directory.
The file type is selected as Profile Configuration File (INI), by default.

6

From the Look In drop-down list, browse to the required directory and select the
file. The name of the selected file displays in the File Name entry box.

7

Click Open.
The Profile INI File Path entry box displays the specified path.

You can enter a brief narrative about the profile item in the Description entry
box.

8
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Click OK to add the new Derived profile to the tree, and return to the Profile Editor
workspace.
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Cloning a Profile
To add a clone profile:

1

Right-click the parent profile from which you are cloning in the Profile Tree.

2

Select Clone Profile from the pop-up menu.
The Profile Properties dialog displays.

To add a clone profile to the Profile Tree, you can also press Ctrl + L on the
keyboard.

3

Enter a unique name identifying the profile in the Profile Name entry box.

If you enter a profile file name that does not exist, Profile Editor automatically
creates an associated INI file at the specified location.

4

Click
adjacent to the Profile INI File Path entry box.
The Open Profile Configuration File dialog displays.

5

Select your required file type from the Files of Type drop-down list in order to
display all of the files of that type present in the selected directory.
The file type is selected as Profile Configuration File (INI), by default.

6

From the Look In drop-down list, browse to the required directory and select the
file. The name of the selected file displays in the File Name entry box.
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7

Click Open.
The Profile INI File Path entry box displays the specified path.

You can enter a brief narrative about the profile item in the Description entry
box.

8

Click OK to add a new Clone profile to the tree, and then return to Profile Editor
workspace.

Deleting a Profile
To delete a profile, right-click the required profile node from the Profile Tree and select
Remove Profile from the pop-up menu. A confirmation message displays. Click Yes to
delete the selected profile and the corresponding INI file.

To delete a profile from the Profile Tree, select the required profile and press
Del on the keyboard.

The Remove Profile option is not available for the Default profile.
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Changing Profile Properties
The Profile Editor enables you to specify multiple symbol values (paths/file name) against
one profile item. You can set the profile item type to any of the four supported options,
Single, Multiple, File or Path. The first two options are used for the display purposes. The
last two Profile item types, File and Path, enables you to specify a directory or a file for a
particular profile item.
Before changing a profile, it is suggested that you create and modify a new INI file to
specify any customized resource locations rather than modify the default System data.ini
file. The following tasks detail how to add a new profile item or modify an existing one.


Adding a Profile Item (page 227)



Modifying a Profile Item (page 230)



Deleting a Profile Item (page 231)

Adding a Profile Item
To add a profile item:

1

Select the required profile node from the Profile window.

To add a profile item to the Details view, you can also press Ins on the
keyboard.
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2

Right-click the required root node in Details view, and select New Item from the
pop-up menu.
The Properties of Profile Item dialog displays.

3

Enter the unique name identifying the symbol of the profile item in the Symbol ID
entry box.

4

Select the required profile item from the Type drop-down list.
Selecting item type enables the associated options in this dialog. You can select from
the following options:
 Single: displays the values in a single row in the Details window.
You can specify multiple symbol, these values are displayed in a single row in the
Value(s) list separated by a semi-colon. The search order is determined by the
order of display.
 Multi: displays all of the values in separate rows in the Details window. The
values are displayed in the Value(s) list.
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Path: sets the directory path.You can choose this option to specify a path for the
profile item. You can specify multiple symbol values. The image below displays
the process of adding paths:
2. Click an empty line once in the
Value(s) entry box to select it,
clicking it twice makes it editable.

1. Select Path
from the Type
drop-down list,



3. Click
, and
browse to the
required directory.
Click OK to set the
path in selected line.

File: selects the appropriate file. File type enables you to choose a specific file
for the profile item. You can select multiple files for symbol values, as shown in
the image below:
2. Click an empty line once in the Value(s)
entry box to select it, clicking it twice
makes it editable.

1. Select File
from the
Type dropdown list,

5

3. Click
, and
browse to the
required directory.
Click OK to set the
file in selected line.

Enter the unique name identifying the profile item in the Name entry box.

You can enter a brief narrative about the profile item in the Description entry
box.

You can use

or

to move the selected value either one level up or one

level down. You can also delete the selected value by clicking
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6

Click OK to add the newly defined profile item.
The profile item displays in the Details view.

Modifying a Profile Item
To modify a profile item:

1

Right-click the required profile item in the Details view.

2

Select Properties from the pop-up menu.
The Properties of Profile Item dialog displays.
To open the properties of a profile item, you can also perform either of these
functions:



3

Click
on the Standard toolbar.
Press Alt + Enter on the keyboard.

You can modify the properties of the selected profile item, and then click OK to
apply the modified settings.

You can modify all of the properties of a profile item except the SymbolID.

Modifying a Default profile is not recommended. The environment variable,
represented by
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, cannot be modified.
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Deleting a Profile Item
To delete a profile item:

1

Right-click the required profile item in the Details window, and then select Delete
Item from the pop-up menu.
A confirmation message displays.

To delete a profile item, you can also press Del on the keyboard.

2

Click Yes to delete the selected profile item.

Opening a New Profile
To open a new profile:

1

Select View, Options from the menu.
The Options dialog displays with the Profile Selection tab selected.

You need to have a registered profile to select it from the Profile Name dropdown list in this dialog.
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2

Click the Profile Selection tab.

3

Select the required profile from the Profile Name drop-down list.

4

Click Apply, and then OK to open the profile in Profile Editor.

To create or register a new profile, refer to “Adding a New Default Profile” on
page 222.

Setting Profiles for All DesignPro Applications
DesignPro Manager helps you to apply a selected profile to all of the DesignPro
applications (Form Editor, Font Editor, Graphics Editor, Elixir Viewer, and Elixir
Resource Map) in a single step.
To apply a selected profile to all of the DesignPro applications:

1

Click Start, and select All Programs, Elixir Applications, DesignPro Tools,
DesignPro Manager.
The DesignPro Manager opens.

2

From the Tools menu, select Profile Selection.
The Profile Selection dialog displays.

3

Check Apply to All DesignPro Applications.

4

Click Apply and OK.

5

Restart the application to apply the selected profile to all DesignPro applications.

This option is selected by default.

If the selected profile is shared or global, it will also be applied to PrintDriver Pro.
Currently, the active profile displays on the status bar in applications including
Design Pro Manager, Form Editor, Font Editor, Graphics Editor, Elixir Viewer, and
Elixir Resource Map.

232

Section IV: Utilities

Customizing Elixir Profile Editor
In Profile Editor, you can review, enter, and change the default settings that control the
operations and appearance of the application.
The Options dialog provides three tabs. You can set the preferences from these tabs by
using check boxes, and entering or changing the field information. New settings take
effect when you either select another tab or close the Options dialog. They remain in
effect until changed.

Setting Profile Selection
Profile Selection is available in all DesignPro applications and enables you to select the
required profile for the current application. You can also review the INI file path that is in
use for the currently opened profile.

1

From View menu, select Options.
The Options dialog displays.

2

Select the Profile Selection tab, if not already selected.

3

In the Current Profile area, select the required profile from the Profile Name list.
The INI file path entry box displays the path of the selected profile. The Description
entry box provides a brief narrative describing the selected profile.
You can view the list of pre-defined profile symbols used to identify various
application objects in the Symbols list. The Symbol Value entry box displays
the pre-defined symbol path of the selected profile specifying the location of
application objects. See “Setting Symbol Properties” on page 234

4

Click New to specify a new profile.
The Register New Profile dialog displays. For more information on the available
options, refer to “Creating Custom Profiles” on page 221.

5

Click Apply to save the settings, and click OK.
You can also view the properties of a particular parser or converter using the
Profile Editor. See “Viewing Parser and Converter Properties” on page 110 in
Chapter 5: "Using Converters" for details.
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Setting Symbol Properties
You can set the default properties for items in the System Data.ini file and also view the
predefined symbols along with the user-defined symbols. Each item represents a Key
(variable) and associated Value (path). Key and Value pairs indicate where to find certain
types of computer information. Keys identify application objects; Values indicate
associated object paths and types.
To set properties for Symbols:

1

From the Tools menu, select Options.
The Options dialog displays.

2

Select the Symbols category to display the available options.
The various options for Xerox are illustrated in the figure below:
Displays objects
key path and type.

Displays objects
key string.

Displays selected
Key strings.
Browse to
select the
path.

Sets objects key
path and type.

Sets real value for
selected objects key.

Sets selected objects
key path and type.

Each item represents a Key (variable) and associated Value (path). Key and Value
pairs indicate where to find certain types of computer information.
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3

Review the options and set the object key path and type in the Value entry box. You
can click

to display the Browse for Folder dialog for selecting the required path.

Adding the entry by clicking
may append the new name to the old entry; if
this occurs, delete the old entry name from the Value box.

4

The value for the selected object key is displayed in the Real entry box.

5

Click Set to set the selected object key path and type.

You can define new symbols using Elixir Profile Editor and use them in the
Resource category in parsers property pages.

The System Data category of the Options dialog is a subset of the Symbols
category. It includes information on the system symbols that are predefined by
Elixir, however, the list of information for System Data comes from the same file,
i.e. SystemData.ini file.
See “Changing the Default Directory Structure (SystemData.ini File Options)”
on page 236.

New settings take effect when you either select another tab or close the
Options dialog after applying the changes. The new settings remain in effect
until changed.
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Changing the Default Directory Structure (SystemData.ini File
Options)
In DesignPro Manager, you can set and change the default properties for items in the
System Data.ini file.
To change System Data.ini File options:

1

From the Tools menu, select Options.
The Options dialog displays.

2

Select the System Data category.
Each Key and its associated value is displayed in the Options dialog. Keys identify
application objects such as SYSTEM_ELIXIR_DOCS_DIR etc.; Values identify the
associated application paths. In this case, the associated path for the above
mentioned object is %ElixirDir%\DOCS\ELIXIR\.

3

To change an objects key path, select the required object key from the list of
available Key Strings.
The selected object key displays in the Key area.
When an objects key is selected, the path of the object, as defined in the System
Data.ini file, displays in the Value entry box. The real path of the objects key
displays in the Real entry box. You can reset the path for a selected object key
by clicking
dialog.

4
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and selecting the required path from the Browse for Folder

Click OK.
The specified changes are saved.
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Chapter 10:

Elixir Viewer
In this chapter...


Elixir Viewer Overview



Elixir Viewer Environment



Using Elixir Viewer



Reviewing a Document



Printing and Previewing Documents

Elixir Viewer Overview
While working with Elixir resources, you encounter documents with different formats like
(.elx, .efr, .dat, etc.). The Elixir Viewer provides an on-screen viewing and test-printing of
documents and forms to check object and text placement before final printing.
Supported Formats


Elixir Document (*.edf)



Elixir Form (*.efr)



Xerox Form Object (*.frm)



Xerox LCDS/Metacode (*.dat, *.met, *.mta, *.nor)



Xerox Form Source (*.fsl), pcl (*.pcl;*.prn)



Elixir GDF (*.gdf)



Elixir Legacy Form (*.elx)



Postscript (*.PS)



Windows EMF (*.emf)



Elixir Dat files (*.dat)



Elixir PrintDriver Document (*.epl)



Elixir PrintDriver Form (*.ep)
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Elixir Viewer uses the same configuration and conversion capabilities as Elixir input
parsers to display pages on-the-fly. Elixir setup files (.epm) configured can be opened in
Elixir Viewer to set up the properties for input formats.
Most configuration operations performed in Elixir Viewer are identical to those in the
DesignPro Tools Converters. Refer to Chapter 5: “Using Converters” on page 93 for
information on Converters.

Opening Elixir Viewer
To open Elixir Viewer, click Start, and then select All Programs, Elixir Applications,
DesignPro Tools, Elixir Viewer.
The Elixir Viewer workspace opens.

Elixir Viewer Environment
When you open a document in Elixir Viewer, the workspace and all associated
components are displayed. The application environment is where all the documents,
forms and other files are viewed. Using the Elixir Viewer environment, you can view and
preview the documents before sending them for conversion.
Menu
Standard
toolbar

Go toolbar

Zoom toolbar

Ruler
Application window

Messages window
Status bar

Image shows the components and windows in Elixir Viewer environment.
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The workspace consists of two windows:



Application window: displays all files supported by Elixir Viewer.
Messages window: displays processing and compilation errors, warning, and
informational messages generated by the application.

Menu
Elixir Viewer provides menus to provide an easy access to the most commonly used
application commands. The drop-down menus displays directly below the application title
bar. These menus provide both standard MS-Windows and application-specific options.
Selecting a menu performs an associated action or displays a sub-menu or dialog.

Toolbars
Directly below the menu are toolbars with buttons that provide access to the most
commonly used commands and tools. You can hide or display the toolbars by selecting
View, Toolbars, Go To from the menu.
The following topics are explained in this section:


Standard Toolbar (page 240)



Go Toolbar (page 240)



Zoom Toolbar (page 241)



Status Bar (page 241)



Customizing the Toolbar Display (page 242)



Creating a New Toolbar (page 243)



Adding Buttons to Toolbars (page 244)

Chapter 10: Elixir Viewer

239

Standard Toolbar
The Standard toolbar provides one-click access to the commands provided in File and
Edit menus.

Image shows the Standard toolbar.

Button

Purpose
Opens the file to view.
Prints the file.
Displays the Print Preview of the
document.
Searches for the first occurrence of
specified string in the document.
Searches for the next occurrence of
specified string in the document.
Opens the Online Help.

Go Toolbar
The Go toolbar enables you to quickly traverse pages in the document. This toolbar
provides quick access to the commands provided in Go menu.

Image shows the Go toolbar.

Button

Purpose
Displays the first page of multi-page
document.
Displays the previous page of multipage document.
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Button

Purpose
Displays the page numbers of multipage document.
Displays the next page of multi-page
document.
Displays the last page of multi-page
document.

Zoom Toolbar
The Zoom toolbar provides the shortcuts to workspace viewing commands. Buttons and
drop-down lists in this toolbar provides access to the commands provided in View menu.

Image shows the zoom toolbar.

Button

Purpose
Increases the Application window object
magnification.
Reduces the Application window object
magnification.
Sets the zoom percentage of the document.
Sets the window display to predefined
measurement unit.
Shows or hides the graphical ruler in Application
window.
Shows or hides the grid in Application window.
Sets the page display to the selected predefined
rotation.

Status Bar
Status bar displays along the lower edge of the Application window to provide
information about the file opened within the Application window.

Chapter 10: Elixir Viewer

241

Customizing the Toolbar Display
You can also specify the toolbars that display in the workspace. To customize Elixir
Viewer toolbars:

1

From the View menu, select Toolbars, Customize to open the Customize dialog.

The Customize dialog showing the Toolbars tab.

2

Click the Toolbars tab.

3

Check the toolbars you want to display in the workspace from the list of available
toolbars.
The selected toolbar name displays in the Toolbar Name entry box.

You cannot uncheck Menu bar from the list of toolbars.

You can also display a toolbar from the View menu by selecting Toolbars,
Toolbar name.
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4

To set the appearance of the displayed toolbars, specify the following:
 Show Tooltips: displays the tool tips associated with the toolbar buttons.
 Cool Look: displays the toolbar buttons in the smooth look mode.
 Large Buttons: displays the toolbar buttons in the enlarged mode.

The Standard toolbar with Large Buttons. (1) Cool Look unchecked and (2) Cool
Look checked.


5

Reset/Delete: resets a default toolbar to the default settings. This button toggles
to Delete when a custom toolbar is selected; only custom toolbars can be deleted.

Click OK and return to the Application window.

Creating a New Toolbar
Using Elixir Viewer, you can also create a new toolbar.
To create a new toolbar:

1

From the View menu, select Toolbars, Customize to open the Customize dialog.

2

Click the Toolbars tab.

3

Click New to open the New Toolbar dialog.

4

In the Toolbar Name entry box, enter the name of the new toolbar.
You can modify this name later in the Toolbars tab.
The names of the default toolbars are not editable. To edit the name of toolbar
you have created, select the required toolbar from the Toolbars tab, and enter
a new name in the Toolbar Name entry box.

5

Click OK.
The new toolbar displays in the workspace. The new toolbar is currently empty. To
add buttons to this toolbar, see “Adding Buttons to Toolbars” on page 244.
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Adding Buttons to Toolbars
You can also add buttons to your toolbar.
To add buttons to a toolbar:

1

From the View menu, select Toolbars, Customize to open the Customize dialog.

2

Click the Command tab.
The list of available command groups displays in the Categories list. When a
command group is selected in the Categories list, the buttons for each command in
the group display in the Buttons area.

The Customize dialog showing the Command tab.

3

Click and drag the required button to any target toolbar displaying in the workspace,
and then release the mouse.
While dragging the required button, the mouse cursor changes from
to
selected button is then added to the required toolbar at the specified place.

. The

If you drag a button and drop it anywhere in the workspace other than the
target toolbar, Elixir Viewer automatically creates a new toolbar with the
specified button, and then displays it in the workspace. If you click the Toolbars
tab, the newly created toolbar name (default is ToolBar1) displays in the
Toolbars list box.
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Ruler
Elixir Viewer provides horizontal and vertical rulers to help view objects in the
Application window. Rulers display along the top and left side of the Application window.
By default, the unit of measurement for the rulers is inches. You can show or hide the
rulers and change the unit of measurement used in the rulers.

Displaying and Hiding the Ruler
You can view/hide the ruler by selecting Ruler from the View menu.
You can also activate the ruler by using one of the following methods:



Click
on the Zoom toolbar.
Select Rulers and Grid, Ruler from the Tools menu.

Applying Grid Settings to Graphical Ruler
The structure of the grid tool is determined by the values specified for sub-divisions and
the spacing between them. In order to keep the grid sub-divisions synchronous with the
ruler measurements, you can use the grid settings for the graphic and/or the digital ruler.
To apply grid settings to the graphical ruler:

1

From the Tools menu, select Options.
The Options dialog displays

2

Select the Ruler category.

3

Check Use Grid Settings for Graphic Ruler.
The grid settings are applied to the graphical ruler

For information on setting grid spacing, refer to “Setting the Grid Spacing” on page 248.
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Changing the Unit of Measurement
You can also change the unit of measurement used for the horizontal and vertical rulers.
This change is applied to both the horizontal and the vertical rulers, and to the digital ruler
as well.

The unit of measurement specified for the rulers is used as a default for viewing
documents and forms in the workspace.

To specify the required unit of measurement:

1

From the Tools menu, select Options to open the Options dialog.

2

Select the Ruler category.

3

Select the required unit of measurement from the Units drop-down list.
The selected unit of measurement is applied to the ruler.

4

Click Apply, and then OK to save the settings.

Grid
The grid feature provides a network of intersecting lines that help in viewing the final
alignment and placement of objects in the Application window, but are not part of the
finished resource. You can specify a major grid spacing value, as well as the number of
subdivisions within each major grid division individually for both vertical and horizontal
directions.
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Displaying and Hiding the Grid
To activate the grid in the Application window:

1

From the Tools menu, select Options to open the Options dialog.

2

Select the Grid category.

3

Check Show Grid to display the grid.
You can also turn the grid on or off by any of the following:


Select View, Grid from the menu.



Click
on the View toolbar.
Pressing F4 on the keyboard.
Select Rulers and Grid, Grid from the Tools menu.




4

Check the required options from the following:
 Hide Major Spacing (+): hides the appearance of the major spacing symbol (+)
in the Application window.
 Hide Subdivisions (.): hides the appearance of the subdivision symbol (.) in the
Application window.

5

Click Apply and OK to save the settings.
The grid will appear in the Application window.
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Setting the Grid Spacing
You can customize the spacing between the grid points as per the specified unit of
measurement. Setting the grid spacing helps analyzing the placement of objects in
accordance with the grid lines. For example, if you want to place text objects vertically at
a distance of 0.5 inches with each other, you can set the spacing to 0.5 inches.
To specify the grid spacing:

1

From the Tools menu, select Options to open the Options dialog.

2

Select the Grid category.

The Grid category in Options dialog.
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3

Specify Major Spacing in both Horizontal and Vertical areas.
This option specifies the space between the horizontal or vertical grid lines, per
specified unit of measurement (default is 1 inch). It is denoted by the symbol (+) in
the Application window.

4

Specify the Number of Subdivisions in both Horizontal and Vertical areas.
This option specifies the number of divisions that are displayed between the
horizontal or vertical grid lines. The divisions are denoted by dots (.) in the
Application window.
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5

Click Apply and OK to save the settings.
The grid displays as per the specified spacing value.

The options provided in Ruler and Grid in the Tools menu are enabled only if
a file is opened in Elixir Viewer.

Messages Window
The Messages window docks at the bottom of the workspace when opened and can be
docked to any other position. This window displays processing and compilation errors,
warnings, and informational messages generated by the application.
To customize message display settings, select View, Options from the menu and select the
Messages category.
For details on working with the Messages window, and commonly encountered error and
warning messages, see:


Messages Window (page 37)



Error and Warning Messages (page 337)
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Arranging Workspace Windows
If you have multiple images opened in the Application window, you can arrange the
opened files using the options provided in the Window menu.
Elixir Viewer lets you arrange the workspace windows in an orderly manner using the
Window menu options explained below:

Aligning Windows
To arrange windows in the Elixir Viewer workspace:

1

Open multiple windows in Elixir Viewer.

2

You can use the following options from the Window menu to arrange the windows:
 Cascade: displays the windows stacked from the upper left to the lower right of
the screen.
 Tile: displays all the windows set edge to edge in the Application window.
 Arrange Icons: displays the windows as icons in the Application window.
 Split: displays a splitter on the screen. You can drag it on screen using mouse
pointer, and then click at required position to split the screen into four active
windows.
Select Remove Split from the Windows menu to undo the split.
The image below displays an illustration of these views:

(1) Cascading example. (2)Tiling example.
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The image displays an active window split into four using the Split option.

Docking Windows
Elixir Viewer enables you to dock the windows in the workspace. The windows can be
docked to either sides of the Application windows using the options provided in the
Window menu.
To dock the windows:

1

Open multiple files in the Elixir Viewer.

2

Select a file in Elixir Viewer as an active window.
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3

Select Window, Dock from the menu, and then select your required docking option.
The active windows dock to the selected side of the Application window.

Image illustrates four files docked to the left, right, top, and bottom of the
Application window.

4
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Select Window, Switch to MDI from the menu to switch the docked window to
default view.
The Switch to MDI option is enabled only when a window is docked to any side of
the Application window.

Section IV: Utilities

Activating a Window
To activate a window in Elixir Viewer:

1

Open multiple files in Elixir Viewer.

2

Select Window, Windows from the menu.
The Windows dialog displays a list of files opened in the Elixir Viewer.

3

Select a window from the list, and then click Activate to open it as an active
window.

4

Click Close Window to close the selected file from the Elixir Viewer workspace.

5

Click Cancel to return to Elixir Viewer workspace.

6

Select Window, Default State from the menu to set the Elixir Viewer workspace to
default state.

The Save option in Windows dialog is not applicable for Elixir Viewer.
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Using Elixir Viewer
The properties used to interpret an input data file can be set in a pre-defined setup file
(.epm) that can either be created using any DesignPro application or defined in an Elixir
Viewer session.
Elixir Viewer uses parsers to read input files for syntactical correctness, and for the
presence of required resource settings, which enables Elixir Viewer to accurately render
the display. Resource paths and input format settings are stored in a required setup file
(.epm). By default, Elixir Viewer uses the setup file ElxView.epm located at:
drive:/Documents and Settings/%Username%/Application Data/Elixir Technologies.
You can perform the following tasks using the Elixir Viewer:
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Setting Profile Preferences (page 255)



Specifying a Setup File (page 255)



Modifying the Input Settings (page 256)



Viewing Parser and Converter Properties (page 256)



Specifying Tag Reference Display Options (page 256)



Opening a File to View (page 257)



Applying Color to Forms (page 259)



Reviewing a Document (page 260)



Zooming In and Out of the Document (page 261)
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Setting Profile Preferences
You can customize Elixir Viewer to meet the requirements of your specific working
environment by creating and maintaining unique user profiles. A profile is a system file
that stores important file locations and other related information for DesignPro
applications.
Default User Profile
The default user profile is created and opened automatically when a DesignPro application
is opened for the first time.
To select a profile and view its information, select Tools, Profile Selection to display the
Profile Selection dialog. In the Current Profile area, select the required profile from the
Profile Name dialog.
See “Opening a New Profile” on page 231 in Chapter 9: "Elixir Profile Editor".
Custom User Profile
To create a custom user profile, select Tools, Profile Selection to display the Profile
Selection dialog. Click New and specify the properties for the custom profile.
See “Creating Custom Profiles” on page 221 in Chapter 9: "Elixir Profile Editor".
Setting Symbols Preferences
To set the Symbols properties, select Tools, Options from the menu to display the
Options dialog. Select the Symbols category to review the symbols properties.
See “Setting Symbol Properties” on page 234 in Chapter 9: "Elixir Profile Editor" for
more information.

Specifying a Setup File
To specify a setup file, select Tools, File Format Properties, Load from the menu to
display the Load Setup File dialog. Select the required setup file.
For details of opening setup files, refer to “Opening a Setup (EPM) File” on page 97.
You can remove the setup file by selecting Tools, File Format Properties,
Clear from the menu. A confirmation message is displayed. Click OK to clear
the setup file. The setup file (.epm) property settings clears, and the default
settings are applied.
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Modifying the Input Settings
To modify the input settings, select Tools, File Format Properties, Input Formats from
the menu, and access the required input format.

For information on all the options available in the selected input format property
dialog(s), click

on the top-right corner of the dialog.

You can also specify the resource search priorities and cache settings for the parser
through the Elixir dialog, by selecting Tools, File Format Properties, Elixir Properties
from the menu.

Viewing Parser and Converter Properties
To view the properties of a particular parser or converter, select Tools, Options from the
menu to display the Options dialog. Select the Info Server category.
For details of steps involved, see “Viewing Parser and Converter Properties” on page 110.

Specifying Tag Reference Display Options
When working with Elixir Viewer, you can customize the tag reference display and
specify the tag recognition options for tags.
To set the tag reference properties:
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1

From the Tools menu, select Options.
The Options dialog displays.

2

Select the Tag Ref category.

3

Select the tag reference presentation format from the Format drop-down list. The
options include:
 Percent: displays (%%Field Number) for tag presentation. by default, the field
number is set to 1.
 Tag Name: displays the tag name as specified in the form opened for viewing.
 Replacement Chars: displays the tags using the replacement characters defined
in the form.
 Sample Data: displays the text as sample data defined in the form.
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4

Use the Color list to specify the required background color for the tag reference.
Background color is only used as a visual aid to help in locating all tag references
used within a form.

5

Click Apply, and then OK to save the settings.

For more information on tag references, refer to DesignPro Tools Form Editor User
Guide.

Opening a File to View
To open a file for viewing:

1

Select File, Open from the menu.
The Open dialog displays.

2

From the Look In drop-down list, browse to the required directory.

3

Select one of the following file types from the Files of Type drop-down list:
 Elixir Document (*.edf)
 Elixir Form (*.efr)
 Xerox Form Object (*.frm)
 Xerox LCDS/Metacode (*.dat, *.met, *.mta, *.nor)
 Xerox Form Source (*.fsl), pcl (*.pcl;*.prn)
 Elixir GDF (*.gdf)
 Elixir Legacy Form (*.elx)
 Postscript (*.PS),
 Windows EMF (*.emf)
 Elixir Dat files (*.dat)
 Elixir PrintDriver Document (*.epl)
 Elixir PrintDriver Form (*.ep)
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4

Select the required file.
You can also set the input file settings by performing either of these functions:



Click
or
located at top of the Open dialog.
Click Edit Property Settings or Restore Default Settings located at
the bottom of the Open dialog.

For information on all the options available in the selected input format property
dialog(s), click

5

on the top-right corner of the dialog.

Click Open.
The selected file displays in the Application window.

If Elixir Viewer does not recognize the file format or type of a file you are trying to view,
a dialog with a list of input and output formats displays.

The dialog displays a list of input/output formats.
Select an appropriate file format from the list, and then click OK to open the file in Elixir
Viewer.
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Applying Color to Forms
To apply various color preferences to the documents:

1

From the Tools menu, select Options to open the Options dialog.

2

Select the General category, if not already selected.

3

Check Substitute Shades with Solid Color from the Preferences area to replaces
the shades applied to objects in the document with solid color.

4

Check Display Whole Forms in One Color and select the required color from the
drop-down menu.

5

Check Show Page Border from the Page Border area, and select the required color
from the drop-down menu.
The selected color is applied to the form border.
You can also select the following two options to apply half toning to raster fonts
and bitmaps in the document:




6

Use Raster Fonts Halftoning: prints raster fonts in halftone. At print
time, images are broken into a series of dots. This feature alters the density
and pattern of the black-and-white dots to simulate different shades of gray.
Use Bitmap Halftoning: prints continuous tones in an image. At print
time, images are broken into a series of dots. You can vary the sizes of the
dots in a halftone screen to create an optical illusion of variations of gray or
continuous color in the image.

Click Apply, and then OK to save the settings.
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Reviewing a Document
Elixir Viewer provides various ways of reviewing a document. You can scroll through the
document, jump to various pages, and can zoom in and out of the document.

Scrolling Through the Document
To scroll through a document that consists of many pages in the Elixir Viewer workspace:
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1

Select following options from the Go menu:
 Prev Page: displays the previous page in the document. This option is activated
only if the document consists of more than one page, and second or following
pages are opened.
 Next Page: displays the next page in the document. This option is activated only
if the document consists of more than one page.
 First Page: displays the first page in the document. This option is activated only
if the document consists of more than one page.
 Last Page: displays the last page in the document. This option is activated only if
the document consists of more than one page.

2

To move to a specific page select Go, Go To from the menu.

3

Enter the required page number in the Go To dialog.
The page specified opens in the Elixir Viewer.
You can also go directly to a specific page by selecting page number from the
Go To drop-down list in the Go toolbar, and press Enter on the keyboard. For more
information on Go toolbar, refer to “Go Toolbar” on page 240.
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Zooming In and Out of the Document
To zoom in and out of the document in Application window, Elixir Viewer provides basic
functions in the Zoom toolbar.
You can click

to zoom into the document or

toolbar.

to zoom out of the document from the Zoom

You can also zoom in and out of the document by performing either of the
following functions:
Select View, Zoom from the menu, and then select the appropriate
zooming option.
 Select required zooming option from the Custom Zoom drop-down list
provided in the Zoom toolbar.
Press + to zoom in and - to zoom out from the numeric keypad on the on the
keyboard. You need to turn off the Num Lock key to use this shortcut.


Printing and Previewing Documents
Using Elixir Viewer, you can open files in supported formats to view and print your fully
composed documents. It provides accurate viewing and print capabilities by enabling you
to view and print one page at a time. For a multi-page document, you can traverse pages
using the Go toolbar to view and print each page individually. You can also preview your
document and configure the printer settings before print time.
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Previewing a Document
To print preview a document:

1

Select File, Print Preview from the menu.
The preview window displays.

2

If the documents consists of more than one page you can use the following buttons to
navigate between the pages:
 Next Page: displays the next page in a form. This option is activated only if the
document consists of more than one page.
 Prev Page: displays the previous page in a form. This option is activated only if
the document consists of more than one page.
 One Page/Two Page: displays one or two pages at a time.
You can also print the document by clicking the Print button and selecting the
required options from the Print dialog. For more information on the Print
dialog refer to “Printing a Document” on page 263.
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3

To increase or decrease the magnification of the current page you can select either
Zoom In or Zoom Out respectively.
Zoom Out button is activated only if the Zoom In is previously selected.

4

Click Close to exit the preview window and return to the previous view of the form.
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Printing a Document
You can print the resource using a network printer, desktop printer or any virtual printer,
like PrintDriver. You can also choose to print multiple copies of the same document. In
addition, you can print specific pages, one or more sections or a range of pages in more
than one section.
To print a document:

1

From the File menu select Print.

You can also click

on the Standard toolbar to open the Print dialog.

2

In the Printer area, select a printer from the Name drop-down list.
The list displays the installed printers available to the system, which includes local or
virtual (e.g., print driver) with its path. You can review the following properties of
the selected printer:
 Properties: displays a properties dialog for the selected printer.
 Status: displays the operating state of the printer.
 Type: displays the name of the selected printer.
 Where: displays the network location of the selected printer.
 Comment: displays a brief narrative describing the printer.

3

Select Print to File to print a resource to a file instead of routing it to a printer.
When this option is selected, the resource is saved with the printer formatting, such
as font selection and color specifications, in a PRN file that can be printed at a later
time.
When Print to File is selected while printing, the resource is saved with the
selected printer driver specifications. The PRN file generated could be printed
later on a printer having the same or a compatible printer diver, otherwise the
PRN file will not print correctly.
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4

Specify the required print range by selecting one of the following options from the
Print Range area:
 All: prints all available pages.
 Pages: prints a range of pages specified in the From and To entry boxes.
 Selection: prints the selected contents of the page only.

5

In the Copies area, specify the required number of copies to be printed in the
Number of Copies entry box.

6

In the Page Shift (In DPI) area, specify a value for the following options, if
required:
 X Shift: specifies the horizontal page shift, in dots per inch.
 Y Shift: specifies the vertical page shift, in dots per inch.

7

Click OK to print the document.

It is recommended to preview the document before printing it.
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Chapter 11:

Resource Map
In this chapter...


Elixir Resource Map Overview



Elixir Resource Map Environment



Working with the Resource Map



Mapping Fonts



Mapping Characters



Tray and Media Mappings

Elixir Resource Map Overview
Elixir Resource Map offers an interactive and central location for defining, editing, and
deleting profile mappings of resources like fonts and characters for separate profiles.
These mappings generally depend on the specific architecture used by the client.
Elixir Resource Map enables you to perform the following operations:
Displays and Modifies the Elixir Resource Map File Contents
The Elixir Resource Map file is a single database file. It includes the selected profiles
along with the resource mappings.
Creates Font Mappings for Profiles
Supports mapping of raster-to-raster, raster-to-vector, vector to raster, and vector-to-vector
fonts.
Defines Associations for Non-Windows (i.e., Xerox) Fonts
Elixir Resource Map looks into an Elixir Resource Library for the imported version of the
fonts. Therefore, Xerox font that require special mapping must be imported into the Elixir
Resource Library and translates character resources from one format to another.

265

Creates Tray and Media Mappings
Elixir Resource Map enables you to select the tray or trays from which a printer feeds. In
addition, you can also select the paper type for printing.
Assigns 2-Character Prefix to Font Names
Some output formats have limitations on the size of a font name. When a document is
converted to such formats, the fonts have to be renamed.

Elixir Resource Map Environment
This section provides information on the Elixir Resource Map environment and describes
activities and tasks for using the workspace. Information is included on the following:


Opening Elixir Resource Map (page 266)



Elixir Resource Map Location (page 267)



What’s in the Workspace? (page 267)



Customizing the Workspace (page 273)



Navigating the Workspace (page 272)

Opening Elixir Resource Map
To open Elixir Resource Map:

1

Click Start, and select All Programs, Elixir Applications, DesignPro Tools,
DesignPro Manager.

2

From the Tools menu, select Resource Map.

The Elixir Resource Map workspace displays.
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Elixir Resource Map Location
Elixir Resource Map is a single database file (ElxMap.mdb) with a default location. This
file is stored in the Elixir System Data file. The System Data tab in the Options dialog
enables you to set and change the default properties for items in the System Data.ini file
and displays the predefined symbols along with the user-defined symbols. Each item
represents a Key (variable) and associated Value (path). Key and Value pairs indicate
where to find certain types of computer information.
The Symbols tab is a subset of the System Data tab. It includes information
on the system symbols that are predefined by Elixir, however, the list of
information for symbols comes from the same file, i.e., SystemData.ini file.

The default location of Elixir Resource Map file is:
%CommonAppData%\%Vendor%\MAPS\ElxMap.mdb.
You can set and change the default location of the Elixir Resource Map file in the System
Data file. For more information on viewing and setting the location of the Elixir Resource
Map file, refer to “Setting the Location of Elixir Resource Map File” on page 274.

What’s in the Workspace?
The Elixir Resource Map workspace consists of the following two child windows:


Mappings Window (page 268)



Messages Window (page 269)

You can customize the position and size of the windows to meet your requirements. The
workspace windows can be displayed as either floating or docked and can also be hidden
from view.
The following tasks explain the customizing options available for the Elixir Resource Map
windows:

Arranging Windows (page 270)


Arranging Icons (page 271)



Refreshing the Screen (page 271)

The title bar of the Resource Map main window displays the name of the selected child
window.
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Mappings Window
The Mappings window displays resource mappings for various profiles, and is divided
into two panes; the left-hand pane displays the Profile Tree, while the right-hand pane
displays the associated mappings. In the left-hand pane, each root node on the Profile
Tree represents a profile.
Each profile contains a collection of mappings, which are displayed in the Details view in
the right-hand pane. The parent tree node representing the Default profile includes subnodes identifying the associated font, character, tray or media mappings. You can also
choose to create custom profiles and map the profiles with the required fonts and
characters within the Mappings window.
For multiple Mappings windows, Elixir Resource Map automatically appends the
window name with a numeric digit. For example, the first window that opens in
the application is named Mappings1. The numeric digit is automatically
incremented and the subsequent windows are named Mappings2, Mappings3,
and so on.

Profile Tree
The Profile Tree depicts the Default profile by default. You can add and view the required
profile properties.

Default Profile Tree displays the profile nodes and details.

The Profile Tree can also display other nodes if you have saved other profiles
using the DesignPro Manager.
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Details View
The Details view displays a collection of mappings associated with the selected node in
the Profile Tree. It is a context sensitive view. The columns displayed depend on the
selected resource type. For example, Fonts, Characters, Trays, Media, etc.

You can refresh the Profile Tree to reflect the changes in another view by
selecting Refresh Tree from the View menu.

Setting the Splitter Position
The size of the Profile Tree and Mappings window can be adjusted using the Split option
from the View menu. The splitter enables you to adjust the divider bar between the Profile
Tree and Details view of the Mappings window.
To set the splitter in position:

1

From the View menu, select Split.
The mouse pointer changes to

2

.

Drag the bar to the left or the right side of the window to adjust the divider as
required.
You can also set the splitter position by placing the mouse pointer over the
divider bar, click and drag the bar either to the left or to the right side of the
window.

Messages Window
The Messages window is displayed behind the main window initially and can be moved to
any position. This window displays the processing and compilation errors, warning, and
informational messages generated by the application.
To customize message display settings, select View, Options from the menu and select the
Messages tab.
For details on working with the Messages window, see “Messages Window” on page 37 in
Chapter 2: "The Manager Environment".
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Arranging Windows
If you have multiple windows opened in Resource Map, you can arrange the images using
the options provided in the Windows menu.
To arrange images in the workspace:

1

Open multiple windows in the Resource Map.

2

Select one of the following options from the Window menu:
 Cascade: displays the image windows stacked and cascading from the upper left
to the lower right of the screen.
 Tile: displays all image windows edge to edge.
An illustration of arranging windows:

(1) Cascading example. (2)Tiling example.
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Arranging Icons
Elixir Resource Map enables you to arrange the workspace windows minimized icons in
an orderly manner, using the main menu options.
To arrange multiple windows:

1

Minimize all windows in the application.

2

From the Window menu, select Arrange Icons.
The windows arrange in the workspace.

(1) Unorganized window icons. (2) Window icons arranged in an orderly manner.

Refreshing the Screen
Elixir Resource Map enables you to open multiple views and change values in one view.
The refresh feature is used to reflect changes in other views.
To refresh the active screen, do one of the following:




From the View menu, select Refresh.
or
Press the F5 on the keyboard.
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Navigating the Workspace
Elixir Resource Map provides menus and toolbars for easy access to the most commonly
used application commands. You can perform the standard Windows operations through
the workspace tools.
Menus
A menu with drop-down menus displays directly below the application title bar. These
drop-down menus provide both standard MS-Windows and application-specific options.

Image displays the menu of Elixir Resource Map.
Selecting a menu item performs an associated action or displays a sub-menu or a dialog.
Toolbars
The Resource Map provides a Standard toolbar that provides one-click access to the basic
File, Edit and Help menu commands, such as creating a new mapping.
To show or hide the toolbar, select View, Toolbar from the menu. A check mark next to
the Toolbar indicates the selection and shows or hides the Standard toolbar accordingly.
Status Bar
Status bar displays along the lower edge of the application. It provides the information
about the selected profile in the Mappings window and the actions performed through the
menu options.

Choosing Commands
A command instructs Elixir Resource Map to perform a specific action. You can choose a
command by either:


Clicking a toolbar button.



Selecting a menu option.



Using a shortcut key.

In the sections that follow, command selection is described using the most common
method for the described task. However, related command selections can be used to
accomplish the same instruction and are listed down in notes.
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Customizing the Workspace
Elixir Resource Map enables you to customize the application operations and appearance
by changing the default options. You can set the preferences using the tabs provided in
Options dialog.

Setting the Default Font
The General tab in the Options dialog enables you to specify a default font for Resource
Map. The default font is used in place of a missing referred font.
To set the default font in the General tab:

1

Select View, Options from the menu.
The Options dialog displays.

2

Select the General tab.

3

Click
in the Default Font area.
The Font dialog displays.

4

Specify the Font type, Size, and Style in this dialog.

5

Select the required font character set from the Script list.
You can view a sample of your selections in the Sample area.

6

Click OK to set the selected font as the default.

Setting Key Path and Type of an Object
To set the Symbols properties, select View, Options from the menu to display the Options
dialog. Select the System Data tab to review the symbols properties.
See “Setting Symbol Properties” on page 234 in Chapter 9: "Elixir Profile Editor" for
more information.
The System Data category of the Options dialog is a subset of the Symbols
category. It includes information on the system symbols that are predefined by
Elixir, however, the list of information for System Data comes from the same file,
i.e., SystemData.ini file.
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Setting the Location of Elixir Resource Map File
The Elixir Resource Map is a single database file, ElxMap.mbd. The default location of
Elixir Resource Map file is %CommonAppData%\%Vendor%\MAPS\ElxMap.mdb. You
can set and change the default location of the Elixir Resource Map file in the System Data
file.
To set the location and name of the Elixir Resource Map file using the SystemData tab in
the Options dialog:

1

Select View, Options from the menu.
The Options dialog displays.

2

Click the Symbols tab to display the available options.

3

Locate and then select SYSTEM_MAP_TABLE key.
Each item represents a Key (variable) and the Value (path) associated with the Key.
SYSTEM_MAP_TABLE identifies the Elixir Resource Map, and
%CommonAppData%\%Vendor%\MAPS\ElxMap.mdb shows the default location
of the Elixir Resource Map file.

4

Click

5

Click Set to update the entry.

6

Click Apply and OK to save the settings.

next to the Value entry box for selecting a new Resource Map file.

Viewing Parser and Converter Properties
You can view the properties for all of the available parsers and converters using the Info
Server tab options in the Options dialog.
The available options in the folder tree include:


Input Parsers



Output Converters



Output Data Converters

To view the properties of a particular parser or converter, select View, Options from the
menu to display the Options dialog. Select the Info Server category.
For details of steps involved, see “Viewing Parser and Converter Properties” on page 110
in Chapter 5: "Using Converters".
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Registering New File Extensions
You can register file extensions for a selected converter or parser. These changes are added
and registered as supported file format extensions in the input or output Files of Type
filter available in the Open or Save dialogs.
To change extensions, click the Info Server tab in the Options dialog. Select an input or
output parser component (such as Input Parser, ElixirGDF, Document) and use the
Exensions entry box to specify a different resource extension.
The extensions setting applies to file extensions only, and does not affect the supported
file formats. To view the applied changes, re-open Elixir Resource Map.

To revert back to the default extension, click Default in front of the Extension
entry box.

Working with the Resource Map
Elixir Resource Map enables you to create and edit various fonts, characters, trays, and
media. The workspace provides you with the following operations to help in resource
mapping tasks:

Opening Multiple Mapping Windows
To open multiple Mappings windows, do one of the following:




Select Mapping Window from the View menu.
or
Click

on the toolbar.

Compacting a Resource Map
The Elixir Resource Map enables you to compress the contents and remove deleted entries
for superior application performance. This maintenance is typically required after a large
number of edit or delete operations are performed.
You can compress the Elixir Resource Map file size by selecting Map, Map table,
Compact from the menu. The compression effect is not visible immediately in the
application. The font files are deleted at the back end from the database, which results in
the reduction of the file size.
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Viewing the Status Information
To view the status information, click
on the toolbar to display the Status
Information dialog. The Status Information dialog displays the mapping and data link
status for the selected profile.

Using this dialog, you can open the Elixir Resource Map database in a Database
Management System. This dialog also provides access to set the database and Data Link
properties.

Using Profiles
You can customize the Elixir applications to suit a particular user, workgroup or enterprise
by creating, selecting, and modifying the unique user profiles. Elixir Resource Map
enables you to view information concerning the selected profile.
You can view the profile information from the Profile Selection or Options dialog.




To open the Profile Selection dialog, select Change Profile from the Map, Profile
menu to view the selected profile information.
To open the Options dialog, select Options from the View menu. Click the Profile
Selection tab for viewing selected profile information.

Selecting a Profile
To select a pre-defined profile, specify the required profile from the Profile Name dropdown list. See “Opening a New Profile” on page 231 in Chapter 9: "Elixir Profile Editor"
for details.
Registering a New Profile
To register a new profile, click New in the Profile Selection dialog to display the
Register New Profile dialog. See “Creating Custom Profiles” on page 221 in
Chapter 9: "Elixir Profile Editor" for details.
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Deleting Profile Mappings
To delete profile mappings, select the required node from the Profile Tree. From the Map
menu, select Profile, Delete Profile Mapping(s). A confirmation dialog displays.
Click Yes to delete the profile mappings.
If the selected node was a parent node, the profile mappings of the sub-nodes are also
deleted.

Mapping Fonts
Elixir Resource Map enables you to create mappings between resources like fonts.
Mapping is used in conversion and in the opening of resources.
The Resource Map mappings can be used while:


Converting resources of one format into another.



Defining the print media.



Opening coded fonts, etc.

When processing files using DesignPro Manager, it is often necessary to convert the font
resources from their original structure to a structure compatible with the required format.
For example, a raster font that is used in a DesignPro Manager application can require a
different structure if it is to be used in a PDF file.
In addition to the format, the layout of the characters used in a font and document may
differ. When DesignPro Manager applications and utilities process the documents and
associated fonts, it is important that all text structures display the same characters as the
original document. DesignPro Manager accomplishes these translations using the Elixir
Resource Map to map font and character resources between the supported print and
display formats.
Fonts are typically the most problematic of all resources. Each character must be
converted to the new format or mapped to a character that exists in the new
format. This will make sure, for example, that a raster version of a character
from a Xerox font prints using the same typeface, style, and point size on a
PostScript printer.

The font mapping feature enables one font format to be translated into another. Font
mappings are stored in the tree nodes of the Profile Tree in the Mappings window.
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The Profile Tree consists of five tree nodes, as described below:

Raster: contains the mapping definitions for Elixir raster fonts. A raster font
contains an arrangement of dots for each character. The simpler the arrangement, the
faster the printer can print. This tree node contains a sub-node that is used for storing
mappings between fonts and code pages.






Windows: contains the mapping definitions for Windows fonts.
Embedded Outline: contains the mapping definitions for Windows fonts. The
outline fonts are Xerox fonts that reside on Xerox printer and are scalable fonts
similar to Windows TrueType fonts.
PCL: contains the mapping definitions for PCL fonts.
AFP: contains the mapping definitions for AFP outline and AFP raster fonts. This
tree node contains two sub-nodes, Character set and Coded font, that contain the
AFP character sets and coded fonts respectively.

Displaying Font Mappings
Elixir Resource Map enables you to view font mapping by selecting the Fonts tree node
and/or its sub-nodes. Selecting a node displays the associated font mappings in the right
pane (Details view) of the Mappings window.
To display the font mapping:
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1

Select the Mappings window as the active child window of the application.

2

Click located to the left of the required profile.
The tree expands to display all of the nodes under the selected profile.

3

Click located to the left of the Fonts node.
This expands the Fonts node to list all of the supported fonts.

4

Select the required sub-node from the tree.
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The associated font mappings display in the Details view on the right-hand side of
the Mappings window.
1. Expand the required profile 2. Select Fonts tree to display font
node from the Profile Tree. mappings.

3. Review the associated font
mappings in the Details view.
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The Details view in the Mappings window is divided into a number of columns:

Source Font: displays the names of the source font mapped. The same name of a
font may occur more than once if multiple target assignments are made.







Target Font Type: specifies the required output format of the source font being
mapped.
Target Font: displays the name of the font to which the source font is being mapped.
Font Name: displays the font name specified in the Linked Code Page dialog. This
column is displayed only if the Code Page sub-node is selected.
Code Page: displays the code page specified in the Linked Code Page dialog. This
column is displayed only if the Code Page sub-node is selected.

You can sort the Mappings window contents either in ascending or descending order by
clicking on the column headings.

For more information on the Linked Code Page dialog, refer to
“Associating an Elixir Code Page with a Font” on page 300.
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Creating New Font Mappings
Elixir Resource Map enables you to create new font mappings. You can create font
mappings for Elixir, Windows, Embedded outline, PCL, and AFP fonts. These fonts can
be mapped to the available target font formats.
The sequence for creating new font mappings is illustrated in the figure below:
1. Right-click in the Profile Tree, select Font Map 2. Specify the required source font settings.
from the pop-up menu and the required source The options available depend on the font
font from the list to create a new font mapping. type selected for mapping.
3. Select Targets
category to display the
available associated
target font formats.

4. Select the required
target fonts to create
the Targets list.

6. Click Apply and OK to create
the new font mapping.
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5. Select a target font to
display the associated
target font settings.
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You can open the Font Mapping dialog by following one of the methods listed below:





Right-click in the Profile Tree, select Font Map from the pop-up menu, and then
select the required source font format.
Select the required source font format from the Map, Fonts menu.
Select the Fonts or a sub-node from the Profile Tree, right-click in the Details view,
and select Add from the pop-up menu.
If the code pages sub-node is selected, the Linked Code Page dialog displays.

Creating a New Font Mapping for AFP Character Set
To create a new font mapping for AFP character set:

1

Select Character Set from the Map, Fonts, AFP Font Map menu.
The Font Mapping dialog displays with the Source category selected.
You can also create a new font mapping for AFP character set by performing
either of the following functions;




2

3

Right-click in the Profile Tree and select Font Map, AFP Font Map,
Character Set from the pop-up menu.
Select Fonts, AFP, Character Set from the Profile Tree, right-click in
the Details view and select Add from the pop-up menu.

Enter the name of the source font in the Font Name entry box.
The name specified here will be displayed in the Source Font column in the Details
view of the Mappings window.
Select the required source font type from one of the following:
Outline: selects the AFP outline fonts. An outline font defines each shape or
character geometrically using a formula. The typeface can be displayed in any
size so a single font description can represent many different fonts. They are
called scalable because they can be of any size. These fonts are also called vector
fonts.
 Raster: selects the AFP raster fonts. A raster font contains an arrangement of
dots for each character. Raster fonts use a simple dot-based format, which is
easier for a printer to process. Each font requires a different set of raster patterns
or bitmaps.
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4

Select the Targets category and select the required target font formats.
For selecting and setting target font format properties, refer to the relative target font
task under “Using Target Font Types” on page 290.

5

Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.

Creating a New Font Mapping for AFP Coded Fonts
To create a new font mapping for AFP coded fonts:

1

Select Coded Font from the Map, Fonts, AFP Font Map menu.
The Font Mapping dialog displays with the Source category selected.
You can also create a new font mapping for AFP coded fonts by performing
either of the following functions;




Right-click in the Profile Tree and select Font Map, AFP Font Map,
Coded Font from the pop-up menu.
Select Fonts, AFP, Coded font from the Profile Tree, right-click in the
Details view, and select Add from the pop-up menu.

2

Enter the name of the source font in the Coded Font entry box.
The name specified here will be displayed in the Source Font column in the Details
view in the Mappings window.

3

Select the Targets category and select the required target formats.
For selecting and setting target font format properties, refer to the relative target font
task under “Using Target Font Types” on page 290.

4

Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.
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Creating a New Font Mapping for Elixir Fonts
To create a new font mapping for Elixir fonts:

1

Select Elixir Font Map from the Map, Fonts menu.
The Font Mapping dialog displays with the Source category selected.
You can also create a new font mapping for Elixir fonts by performing either of
the following functions;




Right-click in the Profile Tree and select Font Map, ELX font map from
the pop-up menu.
Select Fonts, Raster from the Profile Tree, right-click in the Details
view, and select Add from the pop-up menu.

2

Specify the source font settings.

3

Click Font Selection.
The Open dialog displays.

4

Select Elixir Legacy Font (*.hdr) from the Files of Type drop-down list and
browse to the required folder for selecting the font.
You can also select an Elixir font from a resource library. For more information
on importing fonts from the resource library, refer to
“Opening an Elixir Font from the Resource Library” on page 286.

5
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Select the required Elixir font, click Open, and return to the Font Mapping dialog.

Section IV: Utilities

6

Review the following properties of the selected font:
 Font: displays the selected font name.
 Size: displays the height of the characters in a font, each point size being
approximately 1/72 of an inch.
 Weight: displays the degree of boldness of a typeface (Bold, Medium, etc.).
 Family: displays the selected font typeface or family name. A typeface defines
the shape of each character (Arial, Times New Roman, etc.).
 Pitch: displays the width of the characters in a font; pitch measures how many
characters can fit in one inch (10, 12, 14, etc.).
 Italic: displays as checked if the selected font applies italicized formatting.
 Strikeout: displays as checked if the selected font applies strikeout formatting.
The name specified here will be displayed in the Source Font column in the Details
view of the Mappings window.

7

Select the Targets category and select the required target formats.
For selecting and setting target font format properties, refer to the relative target font
in “Using Target Font Types” on page 290.

8

Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.
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Opening an Elixir Font from the Resource Library
You can also select the source font from a resource library.
To select the required Elixir source font:

1

Open the Font Mapping dialog.

2

Select the Source category if not already selected.

3

Click Font Selection.
The Open dialog displays.

4

Select Elixir Resource Libraries (*.erc, *.erc32) from the Files of Type drop-down
list and browse to the library containing the required font.
The Resources Tree for the selected library displays in the dialog.

5

Expand the Library Root node and then the Fonts node to review the available
resource list.
You can also select another available resource according to your requirements by
expanding the relative tree node.

6

Select the required font resource.

7

Click OK to add the font and return to the Open dialog.

8

Click Open to return to the Font Mapping dialog.
The name specified here will be displayed in the Source Font column in the Details
view of the Mappings window.

For information on specifying source fonts, refer to
“Creating a New Font Mapping for Elixir Fonts” on page 284.
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Creating a New Font Mapping for Embedded Outline Font Map
To create a new font mapping for Embedded outline fonts:

1

Select Embedded Outline Font Map from the Map, Fonts menu.
The Font Mapping dialog displays, with the Source category selected.
You can also create a new font mapping for Embedded outline fonts by
performing either of the following functions;




Right-click in the Profile Tree and select Font Map, Embedded outline
font map from the pop-up menu.
Select Fonts, Embedded Outline from the Profile Tree, right-click in
the Details view, and select Add from the pop-up menu.

2

Enter the required name in the Face Name entry box.
The name specified here will be displayed in the Source Font column in the Details
view of the Mappings window.

3

Select the Targets category and select the required target formats.
For selecting and setting target font format properties, refer to the relative target font
task under “Using Target Font Types” on page 290.

4

Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view of
the Mappings window displays the selected source font and target font along with the
target font type.
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Creating a New Font Mapping for PCL Fonts
To create a new font mapping for PCL fonts:

1

Select PCL Font Map from the Map, Fonts menu.
The Font Mapping dialog displays with the Source category selected.
You can also create a new font mapping for PCL fonts by performing either of
the following functions:
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Right-click in the Profile Tree and select Font Map, PCL Font Map from
the pop-up menu.
Select Fonts, PCL from the Profile Tree, right-click in the Details view,
and select Add from the pop-up menu.

2

Enter the required number in the Printer Font ID entry box.
The number selected here will be displayed in the Source Font column in the Details
view of the Mappings window.

3

Select the Targets category and select the required target formats.
For selecting and setting target font format properties, refer to the relative target font
task in “Using Target Font Types” on page 290.

4

Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.
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Creating a New Font Mapping for Windows Fonts
To create a new font mapping for Windows fonts:

1

Select Map, Fonts, Windows Font Map from the menu.
The Font Mapping dialog displays with the Source category selected.
You can also create a new font mapping for Windows fonts by performing either
of the following functions;




Right-click in the Profile Tree and select Font Map, Windows font map
from the pop-up menu.
Select Fonts, Windows from the Profile Tree, right-click in the Details
view of the Mappings window, and select Add from the pop-up menu.

2

Click Font Selection.
The Font dialog displays.

3

Specify the Font type, Size, and Style in this dialog.

4

Select the font character set from the Script list.
You can view a sample of your selections in the Sample area.

5

Click OK to select the source font for mapping and return to the Font Mapping
dialog.

6

Review the following selected source font properties:
 Font: displays the selected font name.
 Font Style: displays the selected font style, such as Bold, Italic, etc.
 Strikeout: displays as checked, if the selected font applies strikeout formatting.
 Underline: displays as checked, if the selected font applies underline formatting.

7

Select the Targets category and select the required target font formats.
For selecting and setting target font format properties, refer to the relative target font
task under “Using Target Font Types” on page 290.

8

Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.
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Using Target Font Types
Elixir Resource Map provides different font formats for mapping. The target fonts
available for font mapping are license key and application dependent. For example, the
Xerox target font format are available with their respective license keys only.

Setting Xerox Target Properties
To set the Xerox target properties for Elixir or Windows fonts:

1

Right-click in the Profile Tree and select Font Map, Windows Font Map from the
pop-up menu.
The Font Mapping dialog displays with the Source category selected.

You can also set the Elixir target font properties by right-clicking in the Profile
Tree and selecting Font Map, Elx Font Map from the pop-up menu.
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2

Specify the source font settings.
For selecting and setting source font format properties, refer to the relative source
font in “Creating New Font Mappings” on page 281.

3

Select the Targets category to display available target font formats.

4

Select the FRM as the target font from the Supported Target Types list.
The Xerox sub-category displays under the Targets category.

5

Select Xerox from the Target Font Type list.

6

Click Font Selection.
The Open dialog displays.

7

From the Look In drop-down list, browse to the required directory.

8

Select Xerox Fonts (*.fnt) from the Files of Type drop-down list, and select a Xerox
font from the selected folder.
The name of selected font displays in the Name entry box.
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9

Click Open to set the selected font name in the Font entry box.

Check Open As Read-Only if you want to use the selected file in read-only
mode.

10 Click Apply, and then OK to save the Xerox target font properties.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.

Setting Elixir Target Properties for Windows or PCL Fonts
To set the Elixir target properties for Windows or PCL fonts:

1

Right-click in the Profile Tree and select Font Map, Windows Font Map from the
pop-up menu.
The Font Mapping dialog displays with the Source category selected.

You can also set the Elixir target font properties by right-clicking in the Profile
Tree and selecting Font Map, PCL Font Map from the pop-up menu.

2

Specify the source font settings.
For selecting and setting source font format properties, refer to the relative source
font in “Creating New Font Mappings” on page 281.

3

Select the Targets category to display available target font formats.

4

Select the ElixirDoc as the target font from the Supported Target Types list.
The Elixir sub-category displays under the Targets category.

5

Specify the ElixirDoc associated settings.

6

Click Font Selection.
The Font dialog displays.

7

Specify the Font type, Size, and Style in this dialog.
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8

Select the font character set from the Script list.
You can view a sample of your selections in the Sample area.

9

Click OK to select the source font for mapping and return to the Font Mapping
dialog.

10 Review the following font settings:












Font: displays the selected font name.
Size: displays the height of the characters in a font, each point size being
approximately 1/72 of an inch.
Weight: displays the degree of boldness of a typeface (Bold, Medium, etc.).
Family: displays the selected font typeface or family name. A typeface defines
the shape of each character (Arial, Times New Roman, etc.).
Pitch: displays the width of the characters in a font; pitch measures how many
characters can fit in one inch (10, 12, 14, etc.).
Italic: displays as checked, if the selected font applies italicized formatting.
Strikeout: displays as checked, if the selected font applies strikeout formatting.
Underline: displays as checked, if the selected font applies underline formatting.

11 Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.
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Setting HP PCL Target Properties
You can set the HP PCL target properties for both Elixir and Windows source fonts.
To set the HP PCL target properties:

1

Right-click in the Profile Tree and select Font Map, ELX Font Map from the popup menu.
The Font Mapping dialog displays with the Source category selected.
You can also set the HP PCL target font properties by right-clicking in the
Profile Tree and selecting Font Map, Windows Font Map from the pop-up
menu.

2

Specify the source font settings.
For selecting and setting source font format properties, refer to the relative source
font in “Creating New Font Mappings” on page 281.

3

Select the Targets category to display available target font formats.

4

Select PCL as the target font from the Supported Target Types list.
The HP PCL sub-category displays under the Targets category.

5

Select HP PCL as the target font from the Targets category.

6

Select one of the following options from the Action entry box:
 Map to Esc. Sequence: maps source font to the target HP PCL escape sequence.
The escape sequence specifies the HP PCL commands for identifying the
characteristics of a font.
You can enter the HP PCL escape sequence for the desired font in Map To entry
box, and omit the escape character. Elixir Resource Map maps the source font to
the HP PCL escape sequence. For more information on defining and using HP
PCL escape sequences, refer to the HP PCL 5 Technical Reference Manual.

Do not use the ligature “Esc” (Escape Character) in the Map To entry box,
instead use “\” (Back slash) character.
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Map to HP Font File: maps the source font to the HP PCL soft font.
You can browse for the required font file by clicking
adjacent to the Map To
entry box. The fonts with .flj extension are created when an Elixir Desktop
product creates a HP PCL soft font.
Soft fonts are stored on the disks, and can be transferred from the computer to
a printer. They can be used in the same way as cartridge or resident fonts. The
PCL soft fonts contain a font header and a set of character definitions. The font
header and character definitions contain information required for formatting
fonts. These formatted fonts can then be used in the HP LaserJet printers.





7

Map to Printer Font ID: maps the source font to the printer-resident font ID.
Enter the required font ID in the Map To entry box.
Rasterize Font: embeds font in the HP PCL file as a HP PCL raster font.
Checking Rasterize font make Map To entry box unavailable.

Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.

Setting PDF Target Properties
You can set the PDF target properties for both Elixir and Windows source fonts.
To set the PDF target properties:

1

Right-click in the Profile Tree and select Font Map, ELX Font Map from the popup menu.
The Font Mapping dialog displays with the Source category selected.

You can also set the PDF target font properties by right-clicking in the Profile
Tree and selecting Font Map, Windows Font Map from the pop-up menu.
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2

Specify the source font settings.
For selecting and setting source font format properties, refer to the relative source
font section under “Creating New Font Mappings” on page 281.

3

Select the Targets category to display available target font formats.

Section IV: Utilities

4

Select the PDF as the target font from the Supported Target Types list.
The PDF sub-category displays under the Targets category.

5

Select one of the following options from the Action entry box:
 Map to Postscript Font: maps the source font to the Postscript (Adobe Type 1)
font.
 Replace by Multiple Master Font: replaces the source font with the Adobe
Multiple Master font.
 Embed in the Output File: embeds source font in the PDF file. If the source
font is a raster font (Xerox raster), Elixir Resource Map converts the source font
to an Adobe Type 3 raster font and embeds it in the Postscript file; if the source
font is a True Type font, Elixir Resource Map converts and embeds it to Adobe
Type 1 outline font.
 Reference to Original Font: embeds reference to the original font in the output
file. This option is available only for Windows font mappings.

6

Select the required target font from the Target PDF Font list.
This option is enabled only when Map to Postscript Font is selected.

If Adobe Type Manager is not installed, selections are limited to basic fonts.

7

Click Apply and OK.
An entry for each added source and target fonts association is added to the mapped
fonts list that displays in the Mappings window, Details view.
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Setting PostScript Target Properties
You can set the Postscript target properties for both Elixir and Windows source fonts.
To set the Postscript target properties:

1

Right-click in the Profile Tree and select Font Map, ELX Font Map from the popup menu.
The Font Mapping dialog displays with the Source category selected.
You can also set the PostScript target font properties by right-clicking in the
Profile Tree and selecting Font Map, Windows Font Map from the pop-up
menu..

296

2

Specify the source font settings.
For selecting and setting source font format properties, refer to the relative source
font section under “Creating New Font Mappings” on page 281.

3

Select the Targets category to display available target font formats.

4

Select the PostScript as the target font from the Supported Target Types list.
The PostScript sub-category displays under the Targets category.

5

Select PostScript to set the target font properties.

6

Select one of the following options from the Action entry box:
 Map to Postscript Font: maps the source font to Postscript (Adobe Type 1) font.
 Embed in the Output File: embeds source font in the PDF file. If the source
font is a raster font (Xerox raster), Elixir Resource Map converts it to Adobe
Type 3 raster font and embeds in a Postscript file; if the source font is a True
Type font, Elixir Resource Map converts and embeds it to Adobe Type 1 outline
font.

7

Select the required font from the Target PostScript Font list.
This option is enabled only when Map to Postscript Font is selected.
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8

Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.

If Adobe Type Manager is not installed, selections are limited to basic fonts.

Setting VIPP Target Properties
You can set the VIPP target properties for both Elixir and Windows source fonts.
To set the VIPP target properties:

1

Right-click in the Profile Tree and select Font Map, ELX Font Map from the popup menu.
The Font Mapping dialog displays with the Source category selected.

You can also set the VIPP target font properties by right-clicking in the Profile
Tree and selecting Font Map, Windows Font Map from the pop-up menu.

2

Specify the source font settings.
For selecting and setting source font format properties, refer to the relative source
font section under “Creating New Font Mappings” on page 281.

3

Select the Targets category to display available target font formats.

4

Select VIPP as the target font from the Supported Target Types list.
The VIPP sub-category font displays under the Targets category.

5

Select VIPP to set the target font properties.
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6

Select one of the following options from the Action entry box:
 Map to PostScript Font: maps the source font to the Postscript (Adobe Type 1)
font.
 Embed in the Output File: embeds the source font in the PDF file. If the source
font is a raster font, Elixir Resource Map converts it to Adobe Type 3 raster font
and embeds in a Postscript file; if the source font is a True Type font, Elixir
Resource Map converts and embeds it to Adobe Type 1 outline font.

7

Select the required target font from the Target PostScript Font list.
This option is enabled only when Map to PostScript Font is selected.

If Adobe Type Manager is not installed, selections are limited to basic fonts.
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8

Specify the required height of the characters for the selected target VIPP font in
Pointsize.
This option is enabled only when Map to PostScript Font is selected and is available
for the Elixir source font only.

9

Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.
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Setting Windows TT Target Properties
To set the Windows TT target properties for Windows fonts:

1

Right-click in the Profile Tree and select Font Map, ELX Font Map from the popup menu.
The Font Mapping dialog displays with the Source category selected.
You can also set the WinFont target font properties by performing either of
these functions:






Right-click in the Profile Tree and select Font Map, Windows Font Map
from the pop-up menu.
Right-click in the Profile Tree and select Font Map, Embedded Outline
Font Map from the pop-up menu.
Right-click in the Profile Tree and select Font Map, AFP Font Map,
Character Set from the pop-up menu.

2

Specify the source font settings.
For selecting and setting source font format properties, refer to the relative source
font section under “Creating New Font Mappings” on page 281.

3

Select the Targets category to display available target font formats.

4

Select the ElixirGDF as the target font from the Supported Target Types list.
The WinTT sub-category displays under the Targets category.

5

Select WinTT to set the target font properties.

6

Click Font Selection.
The Font dialog displays.

7

Specify the Font type, Size, and Style in this dialog.

8

Select the font character set from the Script list.
You can view a sample of your selections in the Sample area.

9

Click OK to select the source font for mapping and return to the Font Mapping
dialog.
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10 Review the following font settings:







Font: displays the selected font name.
Font Style: displays the degree of boldness of a typeface (Bold, Medium, etc.).
Size: displays the height of the characters in a font, each point size being
approximately 1/72 of an inch.
Strikeout: displays as checked, if the selected font applies strikeout formatting.
Underline: displays as checked, if the selected font applies underline formatting.

11 Click Apply and OK.
The specified source font is mapped to the selected target font. The Details view in
the Mappings window displays the selected source font and target font along with the
target font type.

Associating an Elixir Code Page with a Font
Fonts support unique names for all of the characters. These names are referred to as the
graphic character identifiers (GCID). Each key on a keyboard corresponds to a
hexadecimal code points (Unicode). A code page is a table that associates graphic
character identifiers along with code points.
Some font architectures like Xerox do not support names for individual characters. For
these font architectures, the character mappings to the respective Unicode are performed
within the Elixir environment. For more information on character mappings, refer to
“Mapping Characters” on page 307.
A code page should be associated with a font whenever:

The font does not support native character naming.
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The font contains characters in positions that do not correspond to character
positions in the default code page.
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The default code page name is stored in the SystemData.ini file.
To display the default code page name:

1

From the Elixir Resource Map menu, select View, Options.
The Options dialog displays.

2

Click the System Data tab that displays the list of key/value pairs.

3

Locate and select the SYSTEM_CODEPAGE_MAP entry.
The Value entry box shows the selected code page value, which is T100ANSI. This
value is based on the ANSI 1252 character-mapping standard that is used by the U.S.
versions of Microsoft Windows.

You can associate the required code page with fonts as the default code page by
customizing the Elixir Resource Map. For more information on customizing, refer to
“Working with the Resource Map” on page 275.

Associating a Code Page with a Font Imported into a
Resource Library
To associate a code page with a font imported into a resource library:

1

Do either one of the following:
 Select Map, Fonts, Linked Code Page from the menu.
 Select Fonts, Raster, Code Pages from the Profile Tree, right-click in the
Details view of the Mappings window, and select Add from the pop-up menu.
The Linked Code Page dialog displays.

2

Click
adjacent to the Font Name entry box.
The Open dialog displays.

3

Select Elixir Resource Libraries (*.erc, *. erc32) from the Files of Type dropdown list and browse to the library containing the required font.
The resource tree for the selected library displays in a dialog.

4

Expand the Library Root node to view available resources.

5

Select the Fonts node to review the available resource list.

6

Select the required font resource.
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7

Click OK to select the font and return to the Open dialog.

8

Click Open to return to the Linked Code Page dialog.
The font has been specified and the next step is to specify either the code page or
character set. See “Associating the Code page for Mapping” on page 302 and
“Associating the Character Set for Mapping” on page 302 for details.

Associating the Code page for Mapping
To associate a code page with the selected font for mapping:

1

Specify the required font.
For more information, refer to “Assigning a Character Prefix to a Windows Font” on
page 304.

2

Select the Associate Code Page option from the Linked Code Page dialog.
Selecting this option enables the Code Page option below.

3

Select the Code Page option.

4

Enter the required code page name in the Code Page entry box; you can only enter
the code name if the Associate Code Page option is selected from above.

5

Click Apply and OK to return to the Mappings window.

Associating the Character Set for Mapping
To associate a character set with the selected font for mapping:
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1

Specify the required font.
See “Assigning a Character Prefix to a Windows Font” on page 304 for details.

2

Click the Associate Charset option from the Linked Code Page dialog.
This option associates the specified character set layout used by the Windows
character set with font. Each imported character font is mapped to the Unicode value
specified in the Windows character set.

3

Select the Charset option and select the required character set from the drop-down
list.
This option is enabled only if Associate Charset is selected from above.

4

Click Apply and OK to return to the Mappings window.
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Importing a MappingText file
Elixir Resource Map enables you to import mapping files in the application. The mapping
file contains information about the fonts and the associated code pages.
To import a mapping text file:

1

Do either one of the following:
 Select Import from the Map menu.
 Select Fonts, Raster, Code Pages from the Profile Tree, right-click in the
Details view of the Mappings window, and select Import from the pop-up
menu.
The Open dialog displays.

2

Select the Mapping Text Files (*.txt) option from the Files of Type drop-down list.

3

Browse to the required folder to select the required mapping file.

4

Select the required file, click Open and return to the Mappings window
The fonts and their associated code pages are displayed in the Details view.

Editing an Existing Mapping
To edit an existing source font mapping:

1

Select the required font from the Profile Tree.
The associated font mappings are displayed in the Details view of the Mappings
window.

2

Select the required entry in the Details view.

3

Do either one of the following:
 Select Map, Edit from the menu.
 Right-click the selected entry and select Edit from the pop-up menu.
The dialog associated with the selected font for editing the selected font entry is
displayed.

4

Edit available options as per your requirements.
For editing the existing mapping properties, refer to the relative source and target
font sections under “Creating New Font Mappings” on page 281 and
“Using Target Font Types” on page 290.

Chapter 11: Resource Map

303

Deleting an Existing Mapping
To delete an existing source font mapping:

1

Select the required font from the Profile Tree.
The associated font mappings are displayed in the Details view of the Mappings
window.

2

Select the required entry in the Details view.

3

Do either one of the following:
 Select Delete from the Map menu.
 Right-click the selected entry and select Delete from the pop-up menu.
The selected font mapping entry is deleted.

Assigning a Character Prefix to a Windows Font
Some output formats, such as Metacode, have limitations on the size of a font name
(typically 6 - 8 characters are supported). When a document containing TrueType or ATM
fonts is converted to one of these formats, the fonts must be renamed.
The new font name is composed using the PPSSWO scheme where:


PP = two character prefix;



SS = Size of font (in points);



W = Weight of font (Normal, Bold, Italic, and Bold-Italic);



O = Orientation (Portrait, Landscape, Inverse Portrait, and Inverse Landscape).

The 2-character prefix can either be automatically generated or it can be manually
assigned. With the exception of the 2-character prefix, the output conversion process
automatically generates each character of the font name.
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Displaying Font Prefix Mappings
Elixir Resource Map enables you to view the font prefixes assigned to the Windows fonts
by selecting the Font Prefix tree node.
To display the font prefix mappings:

1

Click located to the left of the required profile in the Mappings window.
This expands the tree to display all of the nodes under the selected profile.

2

Select the Font Prefix node.
The following columns are displayed in the Details view of the Mappings window:
 Face Name: displays the font face name specified in the Font Prefix dialog.
 Windows Charset: displays the character set selected in the Font Prefix dialog.
 Font Name Prefix: displays the 2-character long prefix name specified in the
Font Prefix dialog.

Assigning a Character Font Prefix to a Windows Font
To assign a character font prefix to a Windows font:

1

Do either one of the following:
 Select the Font Prefix node, right-click in the Details view, and select Add from
the pop-up menu.
 Select Map, Font Prefix from the menu.
The Font Prefix dialog displays.

2

Select the face (typeface) name of the Windows font from the Facename drop-down
list.
The list displays the available True Type or ATM fonts. Selecting the facename
automatically generates a default 2 - character prefix in the Prefix entry box for the
selected font.

3

Select the required Windows character set from the Character Set drop-down list.

4

Either enter the required 2 - character prefix in the Prefix entry box to or use the
default prefix.

5

Click Apply and OK to return to the Mappings window.
The settings are displayed in the Details view of the Mappings window.
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Editing an Existing Mapping
To edit an existing character prefix mapping:

1

Select the Font Prefix node from the Profile Tree.
The assigned character font prefixes are displayed in the Details view of the
Mappings window.

2

Select the required character font prefix entry from the Mappings window.

3

Do either one of the following:
 Select Edit from the Map menu.
 Right-click the required entry and select Edit from the pop-up menu.
The Font Prefix dialog displays.

4

Edit available options as per your requirements.
Refer to “Assigning a Character Font Prefix to a Windows Font” on page 305 for
details.

Deleting an Existing Mapping
To delete an existing character prefix mapping:

306

1

Select the Font Prefix parent node from the Profile Tree.
The assigned character font prefixes are displayed in the Details view of the
Mappings window.

2

Select the required entry for the source font in the Mappings window.

3

Do either one of the following:
 Select Delete from the Map menu.
 Right-click the required entry and select Delete from the pop-up menu.
The selected character font prefix entry is deleted.

Section IV: Utilities

Mapping Characters
As the DesignPro Manager prepares a document or a form for printing, each text character
on a page is mapped to a specific Unicode ID. When a document is being parsed, the
reverse process takes place; each character is mapped from its Unicode ID to the character
required by the output format. The character mappings feature of the Elixir Resource Map
is used to define and manage these mappings.
This section describes the Elixir Resource Map character mapping feature and how it
works.

Unicode Description
The Unicode standard (Unicode Standard, Version 3.0, The Unicode Consortium,
Addison-Wesley, Jan. 2000) is designed to create a unique identifier for each character
used in every written language around the world. It is based on a double-byte code that
uses 16 bits to represent each character. The Unicode standard supports mappings for over
65,000 characters.
Each written language is assigned a certain “zone” within the Unicode table. There are
also zones for specialized characters, such as symbols and figures, and a special zone
reserved for “Private use area” characters, i.e., custom characters that are not found in any
of the languages or symbol sets of the world.
The table displays the Unicode range for different Character Sets as specified in the
Unicode standards:

Character Set

Unicode Range
Hexadecimal Value

Decimal Value

Basic and Extended Latin

0020 - 0233

32 - 563

General Punctuation

2000 - 206F

8192 - 8302

CJK (Chinese, Japanese, Korean)
Unified ideographs

3400 - 9FA5

13312 - 40869

Private Use Area

E000 - F8FF

57344 - 63743

Character code translations from one format to another are also defined within the Elixir
Resource Map. DesignPro Manager architecture uses Unicode standard for identifying
characters, i.e., all fonts and documents processed by DesignPro Manager are mapped
using the Unicode standard.
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Elixir Resource Map supplied with DesignPro Manager contains the following predefined mappings:




AFP GCIDs: All of IBM AFP single-byte GCIDs are mapped to their equivalent
Unicode IDs.
Postscript Names: All standard PostScript names are mapped to their equivalent
Unicode IDs.

Setting Sample Fonts
Elixir Resource Map provides the sample fonts feature to help in manual character
mapping. You can specify a Windows font used to view the physical representation of the
character glyph in the Character Map dialog. In addition, you can also specify an AFP
character set, which is used to map the characters using the Unicode ID. This feature helps
in creating manual translations of the character codes.

Setting Sample Unicode Font
To select the sample Windows font:

1

Select Unicode from the Map, Sample fonts menu.
The Font dialog displays.
For information on all of the options available in the Font dialog, refer to the
Elixir Resource Map Online Help.
To open Online Help:
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From the Help menu select Contents, or



Click

in an open dialog.

2

Specify the Font type, Size, and Style in this dialog.

3

Select the font character set from the Script list.
You can view a sample of your selections in the Sample area.

4

Click OK to select the sample font and return to the Mappings window.
The sample font selected is used to view the physical representation of the character
glyph in the Character Map dialog.
For more information, refer to “Setting Character Mapping Options” on page 314.
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Setting Sample AFPDS Font
You can also select the AFPDS font from a resource library.
To select the required sample font:

1

Select AFPDS from the Map, Sample Fonts menu.
The Open dialog displays.

2

Select Elixir Resource Libraries (*.erc, *.erc32) from the Files of Type drop-down
list and browse to the library containing the required font.
The Resources Tree for the selected library displays in a dialog.

3

Expand the Library Root node to view available resources.

4

Select the Fonts node to review the available resource list.

5

Select the required font resource.
You can also select another available resource by expanding the relative node.

6

Select the required font resource.

7

Click OK to select the font and return to the Mappings window.
The font selected is used to map the characters using the Unicode ID. For more
information, refer to “Setting Character Mapping Options” on page 314.
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Displaying Character Mappings
Elixir Resource Map enables you to view character mappings by selecting the Characters
tree node and/or its sub-nodes from the Profile Tree. The node selection displays the
associated font mappings in the Details view of the Mappings window.
To display the character mappings:

1

Select Mappings windows as the active child window of the application.

2

Select the Characters node from the Profile Tree.

3

Click located to the left of the Characters node.
This expands the Characters node to list all supported fonts.
The associated mappings display in the Details view of Mappings window.
2. Select the Characters tree node
to display Character mappings.

1. Expand the
required profile
node from the
Profile Tree.

3. Review the associated character
mappings in the Details view.

The Characters node contains all of the character mappings that are assigned to the Elixir
Resource Map.
The sub-nodes of the Characters node contain sub-sets of entire sets of mappings.

AFP: displays all of the pre-defined AFPDS format character mappings.
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Postscript: displays all of the pre-defined Postscript format character mappings.
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The Details view in the Mappings window is divided into a number of columns. A
description of the columns displayed in the Mappings window is given below.


Character Name: displays the names of the characters as referenced in its native
environment.



Format: displays the format of the native font.



Unicode: displays the Unicode ID (in decimal).



Unicode - Hex value: displays the Unicode ID in hexadecimal format.



Shape: displays the physical representation of the character glyph.



Is Generated: indicates if the character mapping entry was added manually or
automatically. The checkbox displays as unchecked if the mapping entry was added
manually.
Is Default: indicates if the character mapping entry was automatically created when
the font was installed. The checkbox displays as checked if the mapping entry was
automatically created on font installation.

You can sort the contents of the Mappings window either in ascending order or
descending order by clicking on the column headings.

The Unicode ID can be used more than once if character names from different
environments (such as Postscript and AFP) are mapped to the same Unicode ID.

You can also add character mappings manually by using functions within the Elixir
Resource Map.
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Automatically Adding Character Mapping to Resource
Map
Elixir Resource Map enables you to create new character mappings. Character map entries
are added automatically when fonts are imported into Resource Library.
For information on the Resource Librarian, see the Elixir Resource Librarian Online
Help.
To open the Online Help, perform any of the following functions:



Select Help, Contents from the menu.
Click

available on the top right of an open dialog.

When a font is imported, active Resource Map is searched for each character name. If the
name is already mapped, assignment is not performed; if the name is not mapped, it is
automatically assigned to the Private use area of the Unicode map. The Private use area
entries are assigned to positions E000 - F8FF (hexadecimal) or 57344 - 63743 (decimal).
When the mapping is automatically created, Is Generated box in Mappings window is
checked for that entry.
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Manually Adding Character Mapping to Resource Map
Elixir Resource Map enables you to create new character mappings. You can create
mappings manually between the GCID’s of the characters and Unicode values.
The sequence for creating new character mappings is illustrated in the figure below:
1. Right-click in the Profile Tree and
select character to create a new
character mapping.

2. Specify the required
font settings.
3. Select the Unicode
category to specify the
respective Unicode value
for the selected GCID.

4. You can review the
Unicode associated
with the character
glyph in the sample
area. Click OK to
create the new
character mapping.

You can review the character
map added in the Details view
of the Mappings window.
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Setting Character Mapping Options
To add a new character map:

1

Right-click in the Profile Tree, select Character Map from the pop-up menu.
The Character Map dialog displays with the Source category selected by default.
You can also open Character Map dialog by performing either of the following
functions:
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Select Characters from the Map menu.
Select the Characters node from the Profile Tree, and right-click in the
Details view and select Add from the pop-up menu.

2

Select the source font from the Type drop-down list. You can select either AFPDS or
Postscript.

3

Select the required character GCID to be mapped from the Name drop-down list.

4

Select the Unicode category to display the available options.

5

Specify the required Unicode ID for the selected character type in the ID box.
You can view a sample of your selections in the sample area. You can also view the
name and hexadecimal equivalent of the selected Unicode value in the Name: and
Hex val: boxes in the dialog.

6

Click Apply and OK.
An entry for each added source character and target Unicode is added to the mapped
characters list that displays in the Details view of the Mappings window.
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Changing the Mapping of a Character
To edit an existing Unicode value for a specific character name:

1

Click located to the left of the required profile in the Mappings window.
This expands the tree to display all of the nodes under the selected profile.

2

Select the required node from the Characters node.
The associated character mappings are displayed in the Details view of the Mappings
window.

3

Select Edit from the Map menu.
The Character Map dialog for editing the selected font entry is displayed.
You can also open Character Map dialog by performing either of the following
functions:





4

Select Characters from the Map menu.
Select the Characters node from the Profile Tree, and right-click the
required character in Details view and select Add from the pop-up menu.
Double-click the selected entry.

Edit available options as per your requirements.
Refer to “Manually Adding Character Mapping to Resource Map” on page 313 for
more information on the available option.
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Deleting a Mapped Character
To delete an existing character mapping:

1

Click located to the left of the required profile in the Mappings window.
This expands the tree to display all of the nodes under the selected profile.

2

Select the required node from the Characters node.
The associated font mappings are displayed in the Details view of the Mappings
window.

3

Select the required entry from the Details view.

4

Select Map, Delete from the menu.
The selected font entry is deleted.

You can also delete a mapped character by right-clicking the selected entry and
selecting Delete from the pop-up menu.

Character Mapping Fonts using Non-Native Character
Names
Some font architectures, such as Xerox centralized, do not support character naming. For
such architectures, a method must be used to associate each character with its Unicode
value using the character’s physical position within the font. Elixir Resource Map
accomplishes this by associating an Elixir-format code page with the font.
To associate a code page with a font stored in the Elixir Resource Library, refer to
“Associating an Elixir Code Page with a Font” on page 300.
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Tray and Media Mappings
Elixir Resource Map enables you to select the paper type for printing (for example, you
can specify the paper type, color, and weight). In any print stream, tray commands specify
the tray(s) from which a printer feeds. The tray command syntax varies from print stream
to print stream. In order to maintain the tray settings, it is important to convert the tray
commands.
The Elixir Resource Map Tray and Media Mapping windows provide user-defined
settings to accomplish the following two-step conversion:


First, the input trays are mapped to user-defined media.



Second, the media are mapped to the output tray.

In addition, it is also possible to replace an Elixir form for a pre-printed stock using special
Elixir media syntax.

Displaying Tray Mappings
Elixir Resource Map enables you to view tray mappings by selecting the Trays node from
the Profile Tree.
To display the font mapping:

1

Select the Mappings window as the active child window of the application.

2

Click located to the left of the required profile.
This expands the tree to display all of the nodes under the selected profile.

3

Select the Trays node from the Profile Tree.
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The associated tray mappings display in the Details view on the right-hand side of
the Mappings window.
1. Expand the required
profile node from the 2. Select the Trays tree node to
Profile Tree.
display tray mappings.

3. Review the
associated tray
mappings in the
Details view.

The Details view in the Mappings window is divided into a number of columns. A
description of the columns that are displayed in the Mappings window is given below:


Input Tray: displays the tray name specified in the Tray Map dialog.



Format: displays the format selected in the Tray Map dialog.



Device: displays the name of the tray selected in the Tray Map dialog.



Media: displays the media description specified in the Tray Map dialog.

You can edit, add, and delete the tray mappings by right-clicking the selected entry in the
Details view of the Mappings window and selecting the required option from the pop-up
menu. You can also sort the contents of the Mappings window either in ascending or
descending order by clicking on the column headings.
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Mapping Input Format Trays to Elixir Media
To map input format trays to Elixir Media:

1

Select Tray from the Map menu.
The Tray Map dialog displays.
You can also open Tray Map dialog by performing either of the following
functions:




Right-click in the Profile Tree, and select Tray Map from the pop-up
menu.
Select the Trays node from the Profile Tree, and right-click in the Details
view, and select Add from the pop-up menu.

2

Select the required format from the Input Format list. The list specifies the
available input stream formats.
(This feature is currently not functional).

3

Enter the system-specified input tray name or id in Input Tray Definition entry box.
The tray name or ID specified depends on the input format selected.
Example: Input tray definition=Tray 1.
When working with LCDS and Metacode input files that use DJDE STOCKSET
commands. To do this, set the input tray to Stock-Name (as specified in the
JSL or STK file). The input tray value for Stock-Reference is not supported. If
you specify this value, an error message will be generated.

4

Specify the user-defined Elixir media definition in Media Definition.
Elixir Resource Map also enables you to specify the tray name or a form name in the
Media Definition entry box. To specify the media definition, you can use the syntax
TrayName=x, where TrayName = the name of the tray. In addition, you can also
specify the paper type, size, and weight.
For example: MediaType=letter; MediaColor=red; MediaWeight=80.

5

Click OK to map the input format tray to the Elixir media and return to the
Mappings window.
The Input Tray, Form Format, and the Media Definition specified in the Tray Map
dialog are displayed in the Details view of the Mappings window.
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Editing an Input Tray Entry
To edit an input tray entry:

1

Display the tray mappings.
Refer to “Displaying Tray Mappings” on page 317 for more information.

2

Select the required entry in the Details view.

3

Select Tray from the Map menu.
The Tray Map dialog for editing the selected entry is displayed.
You can also open the Tray Map dialog by performing either of the following
functions:




4

Right-click in the Profile Tree, and select Tray Map from the pop-up
menu.
Select the Trays node from the Profile Tree, and right-click in the Details
view, and select Add from the pop-up menu.

Edit the available options as per your requirements.
See “Mapping Input Format Trays to Elixir Media” on page 319 for details.

Deleting an Input Tray Entry
To delete an input tray entry:

1

Display the tray mappings.
See “Displaying Tray Mappings” on page 317 for details.

2

Select the required entry in the Details view.

3

Select Map, Delete from the menu.
The selected tray mapping entry is deleted.

You can also delete a mapped character by right-clicking the selected entry, and
then selecting Delete from the pop-up menu.
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Simulating Pre-Printed Stock
Pre-printed stock is stock of paper that has been printed with generic information, and the
same paper is reused to print additional information. For example, an Electrical company
sends out an invoice to its customers every month. This invoice has the customer’s
account activity printed on the front and invoice information printed on the back. The
invoice information is the same for all of the customers. The invoice information can be
printed separately and the same paper is reused to print information about individual
customers. The invoice information is pre-printed stock.
Pre-printed stock can be simulated by referencing an Elixir Form in the Media Definition
entry box in the Tray Map dialog of the Trays and Media Mappings windows. The
reference must use the syntax:
TrayName=x; Form=x
Where TrayName names the tray and Form names the Elixir Form used to simulate preprinted stock.

The referenced form can also be in the native format of the input stream, such as
FRM for LCDS/Metacode.

Displaying Media Mappings
Elixir Resource Map enables you to view media mappings by selecting the Media node
from the Profile Tree.
To display the font mapping:

1

Select the Mappings window as the active child window of the application.

2

Click located to the left of the required profile.
This expands the tree to display all of the nodes under the selected profile.

3

Select the Media node from the Profile Tree.
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The associated tray mappings display in the Details view on the right-hand side of
the Mappings window.
1. Expand the required 2. Select the Trays tree
profile node from the
node to display tray
Profile Tree.
mappings.

3. Review the associated
tray mappings in the
Details view.

The Details view in the Mappings window is divided into a number of columns. A
description of the columns that are displayed in the Mappings window is given below:


Output Tray: displays the tray name specified in the Tray Map dialog.



Format: displays the format selected in the Tray Map dialog.



Device: displays the name of the tray selected in the Tray Map dialog.



Media: displays the media description specified in the Tray Map dialog.

You can edit, add, and delete the tray mappings by right-clicking and selecting the
required entry in the Details view of the Mappings window and selecting the required
option from the pop-up menu. You can sort the contents of the Mappings window either
in ascending or descending order by clicking on the column headings.
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Mapping Elixir Media to an Output Tray
To map Elixir Media to output format trays:

1

Select Map, Media from the menu.
The Tray Map dialog displays.
You can also open the Tray Map dialog by performing either of the following
functions:




Right-click in the Profile Tree, and select Media Map from the pop-up
menu.
Select the Media node from the Profile Tree, right-click in the Details
view, and then select Add from the pop-up menu.

2

Select the required format from the Output Format list. This list specifies the
available output stream formats.
(This feature is currently not functional).

3

Enter the system-specified output tray name or id in Output Tray Definition. The
tray name or id specified depends on the Output format selected.
Example: Output tray definition=Tray 1

4

Specify the user-defined Elixir media definition in Media Definition entry box.
Elixir Resource Map also enables you to specify the tray name or a form name in the
Media Definition entry box. To specify the media definition, you can use the syntax
TrayName=x, where TrayName = the name of the tray. In addition, you can also
specify the paper type, size, and weight. Example: MediaType=letter;
MediaColor=red; MediaWeight=80.
Information added in Media Definition must match the one specified in the
Tray Map dialog. For more information on specifying media definition in the
Tray Map dialog, refer to “Mapping Input Format Trays to Elixir Media” on page
319.
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5

Click OK to map the input format tray to the Elixir media and return to the
Mappings window.
The Media Definition, Form Format, and the Output Tray definition specified in the
Tray Map dialog are displayed in the Details view of the Mappings window.
Mapping PCL Files
For PCL output format, the output trays are identified by their ID numbers. To make
the tray mapping effective for PCL output format, specify the following options:
Set up the input area. Select PCL from the Output Formats, and set up the
output area. Select the Paper category from the PCL dialog. Select the From
Document option in the Source drop-down list. It checks the Elixir Resource
Map for tray and media mapping definition. Click Apply, and then OK.

Editing Media Tray Entry
To edit a media tray entry:

1

Display media tray mappings.
For more information on displaying media tray mappings, refer to
“Displaying Media Mappings” on page 321.

2

Select the required entry in the window Details view.

3

Select Map, Edit from the menu.
The Tray Map dialog for editing the selected entry is displayed.
You can also open the Tray Map dialog by performing either of the following
functions:




4
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Right-click in the Profile Tree, and select Media Map from the pop-up
menu.
Select the Media node from the Profile Tree, right-click in the Details
view, and then select Add from the pop-up menu.

Edit the available options as per your requirements.
Refer to “Mapping Elixir Media to an Output Tray” on page 323 for more
information on available options.
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Deleting Media Tray Entry
To delete a media tray entry:

1

Display media tray mappings.
See “Displaying Media Mappings” on page 321 for details on displaying media tray
mappings.

2

Select the required entry in the Details view.

3

Select Map, Delete from the menu.
The selected media tray mapping entry is deleted.

You can also delete a media tray mapping by right-clicking the selected entry, and
then select Delete from the pop-up menu.
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Section V: References
Appendix A: Converting Resources using Converters
Explains how to convert Elixir Legacy resources to Xerox resources using Converters in
the DesignPro Manager.
Appendix B: Error and Warning Messages
Provides a list of error and warning messages that can be encountered while performing
DesignPro Manager and Converters operations, along with explanations for each
occurrence.
Appendix C: Glossary
Provides DesignPro Manager concepts and terms.
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Appendix A:

Converting Resources
using Converters
In this appendix...


Creating a Xerox Font



Creating a Xerox Logo



Creating a Xerox Form

Converter Overview
Converting resources (forms, fonts, and images) to different formats is often required
while working in the Xerox environment. Converters is an application that can convert
resource files into multiple file formats and can also save conversion parameters for
resource conversion. This is helpful when you need all of your resources used in a design
in the same format used by the target printer. For instance, Xerox format is specific to the
Xerox printer. Any other format needs to be saved/converted to the Xerox format before
printing. Prior to conversion, you can change default file format property options for most
supported file types.
Refer to the DesignPro Tools Online Help for information on all of the options
available in the Converter dialogs by clicking
dialog.

on the top-right corner of the

You can also save forms, fonts, and images to a target format in the respective DesignPro
Form, Font and Graphic Editor applications. In this appendix, the Elixir Legacy resources
are being converted to Xerox resources. However, the converter supports other formats for
conversion.
Refer to Chapter 5: “Using Converters” on page 93 for information on the supported
formats.
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Creating a Xerox Font
To convert an Elixir Legacy Font into a Xerox Font:

1

From the Resources window, browse to the folder Fonts, Elixir, Elixir1.

2

Select Elixir Legacy Font (.hdr) from the Filter drop-down list.
The Elixir Legacy Font files display in the Details window.

3

Select the required file from the Details window, drag it and drop on to the
Converters icon,

in the Applications tab of the Navigation window.
The selected folder from the
Resources window.

Filter drop-down list.

Applications
tab.

Converters
icon.

Drag the selected font
and drop onto the
Converters icon.

DesignPro Manager workspace highlighting the objects involved in a conversion.
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The Conversions dialog displays the available input and output formats.

4

Click
to view the properties for Elixir Legacy Fonts.
The GDF/ElixirForm dialog displays.

5

Review the dialog selections and make your changes.

For information on all of the options available in the selected input format
property dialog(s), click

on the upper-right corner of the dialog.

In case of converting a single resource to multiple formats, the input conversion
settings defined are applied to all of the target files created.

6

Click

to view the input file and path information.
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7

Select Xerox Font from the Output Formats under the Outputs area.
An Elixir Legacy Font can also be converted to other formats shown in the
Output Formats column simultaneously. For more information on multiple
conversions, see Chapter 5: “Using Converters” on page 93.

8

Click
adjacent to the Xerox Font option in the Output Formats column.
The Xerox LPS Resource Writer dialog displays.

9

Review the dialog selections and make your changes.

For information on all of the options available in the selected output format
property dialog(s), click

on the upper-right corner of the dialog.

10 Click

to open the Browse for Folder dialog, and specify a different location for
saving the file. The default path for saving an Xerox font file is
drive:\Elixir\Fonts\Xerox\.

11 Click OK to run the conversion.
The output file is placed at the location specified in step 10. The Messages window
displays the conversion process and the destination directory of the Xerox font.
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Creating a Xerox Logo
To convert an Elixir Legacy Graphic to Xerox IMG and Xerox LGO:

1

From the Resources window, browse to the folder Graphics, Elixir, Elixir1.

2

Select Elixir Legacy Graphic (.lp3) from the Filter drop-down list.
The Elixir Legacy Graphic files display in the Details window.

3

Select the required file from the Details window, and then click File, Convert from
the menu.
The Conversions dialog displays the available input and output formats.

4

Click
to view the properties for Elixir Legacy Graphics.
The GDF/ElixirForm dialog displays.

5

Review the dialog selections and make your changes.

For information on all of the options available in the selected input format
property dialog(s), click

6

Click

on the upper-right corner of the dialog.

to view the input file and path information.
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7

Select Xerox IMG & Xerox LGO from the Output Formats under the Outputs
area.

8

Click
adjacent to the Xerox IMG & Xerox LGO option in the Output Formats
column.
The Xerox LPS Resource Writer dialog displays.

9

Review the dialog selections and make your changes.

For information on all of the options available in the selected output format
property dialog(s), click

on the upper-right corner of the dialog.

10 Click

to open the Browse for Folder dialog, and specify a different location for
saving the file. The default path for saving a Xerox image is drive:\Elixir\Pics\Img\.

11 Click OK to run the conversion.
The output file is placed at the location specified in step 10. The Messages window
displays the conversion process and the destination directory of the Xerox image.
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Creating a Xerox Form
To convert an Elixir Form to Xerox Form Object:

1

From the Resources window, browse to the folder Forms, Elixir, Elixir1.

2

Select Elixir Form (*.efr) from the Filter drop-down list.
The Elixir Form files display in the Details window.

3

Select the required file from the Details window, and then press Alt + C on the
keyboard.
The Conversions dialog displays the available input and output formats.

4

Click

5

Select Xerox Form Object from the Output Formats under the Outputs area.

6

Click
adjacent to the Xerox Form Object option in the Output Formats
column.
The Xerox LPS Resource Writer dialog displays.

to view the input file-path.
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7

Review the dialog selections and make your changes.

For information on all of the options available in the selected output format
property dialog(s), click

on the upper-right corner of the dialog.

8

Click
to open the Browse for Folder dialog, and specify a different location for
saving the file. The default path for saving a Xerox font is drive:\Elixir\Forms\Frm.

9

Click OK to run the conversion.
The output file is placed at the location specified in step 8. The Messages window
displays the conversion process and the destination directory of the Xerox form.

The Elixir Legacy Form (.elx) can also be converted to the other available
formats by following the same process.
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Appendix B:

Error and Warning
Messages
In this appendix...


Error and Warning Messages Handling



Error Messages



Warning Messages

Error and Warning Messages Handling
DesignPro Manager displays processing and compilation errors, warning, and
informational messages generated by the application in the Messages window.
Right-click in the Messages window and select Show Color from the pop-up menu to
display color-coded boxes associated with each message type:


: A red box precedes the error messages.



: A blue box precedes the warning messages.

Informational messages are displayed in black; no box precedes them.
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The following image shows the Messages window displaying different informational,
error, and warning messages along with the date and time of generation.
Warning messages display with a blue-colored box.
Error messages display
with a red-colored
box.
Informational
messages.
Date and Time when the message was generated.

Error Messages
The error messages typically encountered while working with the DesignPro applications
are described in this section.
Invalid License Key

Error Message

Explanation

Solution

License key not found.
Cannot activate converters.

Cannot find the license key to
run the application.

Download the updated and
correct license key to run the
application.

Error Message

Explanation

Solution

Font "%1" not found

The associated font was not
found on path specified in the
Resources, Fonts tab of the
input property page.

Specify the correct path for the
associated font in the
Resources category, Fonts tab
of the input property page.

Form "%1" not found

The associated form was not
found on path specified in the
Resources, Forms tab of the
input property page.

Specify the correct path for the
form referred in the error
message, in the Resources
category, Forms tab of the
input property page.

Missing Resources
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Error Message

Explanation

Solution

Image "%1" not found

The associated image was not
found on path specified in the
Resources, Images tab of the
input property page.

Specify the correct path for the
Image referred in the error
message, in the Resources
category, Images tab of the
input property page.

Missing GDF/ELX Parser:
Font “C0AR10” not found.

The font file has not been
downloaded completely, or it
may be corrupt.

Download all required font
components properly and place
them in the corresponding fonts
folder.

Missing GDF/ELX Parser:
Font “C0AR10” not found.

Font file is not downloaded
completely or it may be
corrupt.

Download all required font
components properly and place
them in the corresponding fonts
folder.

Cannot retrieve resource
“C0AR10.”

Font file is not downloaded
completely or it may be
corrupt or missing.

Download all required font
components properly and place
them in the corresponding
folder.

Using default resource
instead of “C0AR10.”

Cannot find selected resource
at the specified path.

The specified font has been
replaced with the default
resource.

Resources not present in the
specified folder.

Specify the corresponding
folder for the referred
resources.

Cannot retrieve Image name.

Image resource is absent or
corrupted.

Specify the correct location for
image resources or replace the
corrupted image file.

Cannot retrieve form name.

Form resource is absent or
corrupted.

Specify the correct location for
form or replace the corrupted
form.

Error Message

Explanation

Solution

Cannot find resource file
“C:\Documents and Settings\
username\Desktop\
image.bmp.”

The resource (e.g., form) has
been downloaded from
another user’s machine, which
contains a linked image.
Cannot find the linked image
path referred in the form.

Redefine the path for the linked
image.

Invalid Resource Path
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Image Conversion - Memory Out of Space

Error Message

Explanation

Solution

Cannot create bitmap.

When converting either a
form or an image to TIFF
format, these messages are
displayed if the memory runs
out of space.

You can follow any one of the
following methods to fix the
problem:

Elixir Image Object: Cannot
load persistent storage.
Invalid pointer.

• Retry the conversion after
closing other applications.
• Retry the conversion after
reducing the resolution of the
image.
• Retry the conversion after
reducing the depth of the
image.

Object Extends Page Boundary

Error Message

Explanation

Solution

Object of type Image or
another rasterized object
extends beyond top or left
page boundary. Object will
be ignored.

Cannot convert object outside
the page boundary.

Resize or move the object to
place it within page boundaries.

Object of type Line extends
beyond bottom or right page
boundary. Object will be
processed.

Cannot convert part of object
outside the page boundary.

Resize or move the object to
place it within page boundaries.

Error Message

Explanation

Solution

Error: Unable to perform
transform operation due to
low memory resource.

Transformation fails due to
low memory.

Low memory issue. The user
can either expand the available
memory or kill some running
processes to free some space.

Low Memory
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Cannot Open Map Table

Error Message

Explanation

Solution

Insufficient rights. Cannot
open map table
C:\Documents and Settings\
All Users\Application Data\
Elixir Technologies\MAPS\
ElxMap.mdb.

The user does not have
sufficient rights to open the
mapping database.

Give appropriate rights to the
user for opening the mapping
database.

Error Message

Explanation

Solution

Enumeration of mapping
entries failed.

The mapping database file
does not exist or it has not
been successfully opened.

Place the mapping database file
on the specified path and also
give rights to the user to open
the mapping database file.

Error Message

Explanation

Solution

Wizard could not connect to
the remote Drive x.

The PrintDriver could not
connect to the mapped Drive x
for converting output file(s).

Make sure the remote drive is
accessible to perform the
conversion.

Error Message

Explanation

Solution

Text object “__” was badly
constructed. Please repair
input parser.

This error appears when input
parser has not set the
commands of text object
string properly.

Recreate the text object.

Cannot get font for text
“___”.

Textlib can not retrieve font
for the text object.

Recreate the text object.

Enumeration Failed

Mapped Drive

Text Strings

Note: “___” displays a text
string in the form.
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Zero Pages

Error Message

Explanation

Solution

The document contains only
blank pages.

Specify a valid input file.

Error Message

Explanation

Solution

Incorrect font/ink reference.
The value is higher than
fonts/inks number in font
list.

A local font value for a text
string cannot be found in the
list of fonts and inks for the
page. The local font value is
larger than the largest value in
the list.

To fix this error:

Empty document. No
PostScript file produced.
Empty document. No PDF
file produced.

Incorrect Font Reference





Specify the correct IDEN,
SKIP and/or OFFSET
values in the JSL file.
Update the JSL file path in
the JSL category of the
Metacode parser.
Make sure that the font list
in the FRM files
corresponds to the local font
ID values that are referenced
in the Metacode pages.

Incorrect Property Name

Error Message

Explanation

Solution

Incorrect property "Property
Name".

One of the property values
passed to the Command Line
Converter is incorrect.

Verify the following:
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Property is valid for the
converter being used.
Spelling of the property
name is correct.
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Incorrect JSL File Path

Error Message

Explanation

Solution

Cannot process JSL file
drive:\Path\Filename.

Processing of the JSL file
drive:\Path\Filename failed by
the LCDS parser due to
incorrect syntax or because it
is missing some necessary
information for conversion
(e.g., VFU information).

Check JSL file for any errors
and specify the correct path for
JSL file.

Error Message

Explanation

Solution

Output file has grown over x
GB. Architectural limits
reached. No file produced.

A file of maximum xGB size
can be generated.

It’s an architectural limit.
Reduce the file size.

File Size Limit

Note: In the above message,
‘x’ specifies the file size. The
limit for PS files is 2 GB,
and that for PDF files is 10
GB.
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Warning Messages
The warning messages typically encountered while working with the DesignPro
applications are described in this section.
Linked Resource Conversion

Warning Message

Explanation

Conversion of linked resource ‘image’ was
unsuccessful through original linkage settings.

The resource (such as form) was downloaded
from another user’s pc with a linked image;
cannot find the linked image path referenced in
the form; redefine the path for the linked
image.

Invalid Property in Command Line Converters

Warning Message

Explanation

Invalid property "Property Name".

Incorrect syntax for a property on the
Command Line. The Command Line
Converter ignores the specified property and
continues conversion.

Missing Unicode Character Reference
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Warning Message

Explanation

User unicode xxxxxxxx defined for 99999.

A character in a font being referenced during a
conversion has been mapped to the Unicode
Private Use Area in the Resource Map. This
occurs when the name of the character is not
found in the list of character names residing in
the Resource Map.
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Undefined Font

Warning Message

Explanation

Font facename undefined. Using “Arial.”

The specified font name has not been
recognized; replaced with the default font,
Arial.

System or True Type font with facename "My
Arial" not found on the local computer. Using
"Arial" instead.

System or True Type Font is not installed on
local computer using system default font
instead.

Resource Naming

Warning Message

Explanation

ELX output converter: The resource file
already exists.
'c:\Elixir\FONTS\ELIXIR\C0D0GT.hdr' (not
replaced)

The resource with the same name already
exists. Specify a different name to save the
resource.

Mapped Drive

Warning Message

Explanation

Warning: Wizard could not disconnect from the
remote drive x.

PrintDriver could not successfully disconnect
from the mapped drive x after converting the
output file.

Invalid Input

Warning Message

Explanation

Warning: C:\Testing.pdf file is invalid for
given 'Input Type' and 'Input Format.' When a

PDF parsing is not supported in DesignPro
Tools, therefore, when a pdf file is dropped
onto the Converters, this message is received.

pdf file is dropped on Converters icon,
the Manager.

in

Missing File Association

Warning Message

Explanation

Association is missing.

PrintDriver could not find a system association
for the file extension to an application. Specify
the appropriate associations for output files.
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Substituting Elixir Resources

Warning Message

Explanation

Substituting Elixir resource 'filename' for
original resource 'filename'.

The LCDS input parser could not locate the
native version of the resource. It has
successfully found and substituted an Elixir
Legacy version of the resource.

Missing Character Code

Warning Message

Explanation

Character 53 missing in font Arial.

The character ‘54’ of Character code is not
available in font ‘Arial.’ Skipping the missing
character code.

Mapping Database does not Exist

Warning Message

Explanation

Mapping database "C:\Documents and
Settings\All Users\Application Data\Elixir
Technologies\MAPS\ElxMap.mdb" doesn't
exist.

Mapping database file does not exist on the
specified path.

Same Passwords

Warning Message

Explanation

The Open Document and Change Security
Passwords should be different to apply security
checks.

Adobe Acrobat requires the user and owner
passwords to be different in order to apply
proper security restrictions.

Duplicate Group Name
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Warning Message

Explanation

Duplicate Radio Group(s) renamed.

Each radio button group should have a unique
name. The group is renamed if a group with
similar name already exists.
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Glossary
The following is an alphabetical listing of product-specific or unique terms and
abbreviations used in this guide.
Application tab
A tab page that can be used to open the installed DesignPro applications.
Cloned profile
Profile that is an exact replica of its parent profile. See Profile.
Default profile
Profile that uses all system defined profile items to create a new profile. See Profile.
Details view
A view displaying the contents of a node selected in the Profile Tree. See Profile Tree.
Derived profile
Profile that inherits the missing profile item values from its parent profile. See Profile.
Details pane
A pane that displays selected virtual or system folder filtered contents.
Documents folder
A directory containing the fully composed multi-page documents for Xerox Form Objects
(*.frm), Elixir (*.gdf), Enhanced Metafile (*.emf), Print Control Language (*.pcl;*.prn),
Portable Document Format (*.pdf), and PostScript formats.
Explorer window
A window displaying Windows Explorer view of system folders.
FDF
FDF (Forms Data Format) is the file format used for interactive forms (containing active
objects) data.
Flat View
A view displaying default environment variables and categorization of profile keys.
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Fonts folder
A directory containing Elixir Legacy Coded Font (X0*.cdf; X1*.cdf; X2*.cdf; X3*.cdf;
X4*.cdf), Xerox Fonts (*.fnt), and Windows font files.
Formats View
A view displaying the profile keys sorted by file format type.
Forms folder
A directory containing Xerox Form Object (*.frm), Xerox Form Source (*.fsl), Elixir,
Elixir Metafile, Print Control Language, Portable Document Format, and PostScript
forms.
Graphics folder
A directory containing Xerox IMG and LGO (*.img, *.lgo) and Elixir Legacy Graphic
files (*.lp3).
Hot key
See Keyboard shortcut.
Jobs folder
A directory containing Xerox Form Object (*.frm), Xerox Form Source (*.fsl), Elixir
FormDef (*.efd), and Elixir PageDef (*.epd) job folders.
Keyboard shortcut
A Special key or key combination for executing operation without using mouse; also
called hot key(s).
Mapping folder
The process of associating a physical folder path to virtual folders. See Virtual folder.
Mappings window
A window displaying Resource Map contents and assigned associations.
Messages window
A window displaying informational, error, and warning messages.
Navigation window
A window displaying the page tabs for switching between installed DesignPro
applications, utilities and tools and user-defined application shortcuts.
Profile
A system file that stores important file locations for Elixir applications.
Profile Tree
A tree depicting Default and custom profiles under the current user Windows login name.
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Resource Type View
A view displaying profile keys sorted by resource type.
Resources window
A window displaying Elixir Resources virtual folders tree.
Setup (.epm) file
A file that stores individual input and output property settings for conversion.
My Shortcuts tab
Applications can be opened directly from icons available on this tab page. My Shortcuts
tab displays user-defined shortcuts for different applications.
Standard toolbar
A toolbar that provides easy access to the most commonly used application commands.
Symbol
A key representing application objects with associated paths and types.
Tools and Utilities tab
A tab page that can be used to open the installed DesignPro tools and utilities.
Utilities
Service programs designed to perform everyday tasks such as verifying the validity of the
product license.
Virtual folder
Abstract representation of a DesignPro Tools physical file folder; displays in a tree in
DesignPro Manager organized by resource type, then format.

Appendix C: Glossary

349

350

Section V: References

Index
A
about
character mapping 307
mapping fonts 277
media mappings 317
tray mappings 317
Unicode 307
activating windows 253
Add New URL Source dialog 125
adding
automatic character mappings 312
character mappings 312
derived profile 223
font mappings 277
form references in DAT files 74
manual character mappings 313
new default profile 222
profile item 227
script commands in DAT files 75
toolbar buttons 46, 244
applications
creating shortcuts 65
window 239
Applications tab 32
arranging
workspace windows 250
assigning
character prefix to Windows fonts 304, 305
associating
character set for mapping 302
code page for mapping 302
code page with fonts 301
Elixir code page with fonts 300
automation
method 1 124
method 2 129
method 3 131

B
BAK 86

Index

Barr utility 163
Bcheck utility 165
BMP 18
Browse for Folder dialog 83, 126
browsing
workspace 49

C
CDF 17
changing
character mappings 315
profile properties 227
ruler unit 246
Character Map dialog 314
character mappings
adding 312
changing 315
displaying 310
non-native character names 316
setting 314
character prefix to Windows fonts
assigning 304, 305
choosing commands 47, 272
cloning
profiles 225
COD 17
code page with fonts
associating 301
collecting
diagnostic information 91
system information 91
color coding messages 41
Color dialog 183
Command Line Converter
automating method 1 124
automating method 2 129
automating method 3 131
automating Scout 124
DPTCLCu.exe 115
examples 120
specifying, parameters 121
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unstructured files 122
commands
choosing 272
compacting
Elixir Resource Map 275
configuring
file transfer package 138
resource searching 83
conventions
symbolic 23
typographic 23
converting
Elixir Legacy fonts 330
Elixir Legacy graphics 333
resources 329
copying files, printer
online Metacode files 151
Xerox 128-byte header files 151
Xerox-labeled files 146
creating
AFP character set font mapping 282
AFP coded fonts 283
application shortcuts 65
character mappings 312
command line parameter file 129
custom profiles 221, 255
DAT files 73
Elixir font mappings 284
Embedded outline font mappings 287
font mappings 281
media mappings 323
PCL font mappings 288
PCL fonts 288
physical folder, new 56
shortcuts 65
toolbars 45, 243
tray mappings 319
user profiles 255
Windows font mappings 289
Windows fonts 289
Xerox font 330
Xerox logo 333
customer support 25
Customize dialog 45, 243
customizing
Code Page Editor 192
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Elixir Profile Editor 233
Elixir Resource Map workspace 273
input settings 256
profiles 233

D
DAT files
adding script commands 75
creating 73
exporting 77
importing 77
understanding 73
working 76
DataWare card
copying files, printer 151
device driver, adding 151
default
directory 236
defining
physical folders 50
virtual folders 50
deleting
font mappings 304
font prefix mappings 306
form references 76
mapped characters 316
media tray mappings 325
profile item 231
profile mappings 277
profiles 226
script commands 76
shortcut 70
tray mappings 320
DesignPro Manager
basics 49
environment 29
opening 29
workspace windows 31
DesignPro Tools
images 18
details
formats 214
resources 214
Details view 211
Details window 228
dialogs
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Add New URL Source 125
Browse for Folder 83, 126, 235
Character Map 314
Color 183
Confirm Shortcut Delete 70
Customize 45, 243
Elixir Code Page Editor 183
Elixir Code Page Editor Options 192, 193, 194
Elixir Code Page Properties 191
Elixir Product Registration 156
Elixir Resource Index Service Configuration 83
Elixir Shortcut Wizard 65
ElixiTag 195
Export Setup File 105
Font 191, 273, 289, 290, 291, 299, 308
Font Mapping 282, 284, 288, 296, 299
Font Prefix 305
General 67
Linked Code Page 280, 301
Load Setup File 98, 255
Open 74, 81, 185, 199, 257, 284
Open Profile Configuration File 223, 225
Options 48, 109, 220, 248, 249, 269
PCL 324
Print 158, 262
Profile Properties 222, 223
Profile Selection 276
Properties of Profile Item 228
Register New Profile 276
Registered Font Properties 106
Save As 77, 78
Select Diagnostic File Name 92
Select Package File Name 89
Select Resource Library for Writing 190
Settings 67
Status Information 276
Tray Map 318, 321, 322, 323
Windows 253
Xerox LPS Resource Writer 332, 334
directory structure
default 236
Disp utility 167
displaying
character mappings 310
font mappings 278
font prefix mappings 305

Index

grid 247
media mappings 321
message time in Messages window 40
ruler 245
tray mappings 317
Disppw window 156
docking windows 251
documents
previewing 262
printing 261, 263
Documents folder 53
downloading files 142
DPTCLCu.exe
command line, parameters 115
using 114

E
editing
font Mappings 303
font prefix mappings 306
media mappings 324
tray mappings 320
EFR 17, 18, 74, 80, 87
Elixir
FormDef 19
images 18
Legacy forms 17
overlays 17, 74
PageDef 19
PrintDriver 17, 74
Elixir Code Page Builder utility
Code page properties 191
Code point mapping 187
Code point property settings 189
creating Code page 184
exporting Code page to Resource map 192
opening Code page 182
profile selection 194
saving Code page 190
setting modes 181
Elixir Code Page Editor
coded font preferences 194
customizing 192
general preferences 192, 193
Elixir Code Page Editor dialog 183
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Elixir Code Page Editor Options dialog 192, 193,
194
Elixir Code Page Properties dialog 191
Elixir fonts
associating code pages 300
CDF 17
COD 17
HDR 17, 18
Legacy code page 17, 18
Legacy coded 17, 18
opening from Resource Library 286
Elixir Legacy graphics
converting 333
Elixir PrintDriver forms 74
Elixir Product Registration dialog 156
Elixir Profile Editor
adding derived profile 223
adding new profile 222
adding profile item 227
changing profile properties 227
cloning profiles 225
creating profiles 221
customizing 233
deleting profile item 231
deleting profiles 226
Details view 211
environment 209
Flat view 211
Formats view 214
modifying profile item 230
opening 209
profile selection 233
Profile Tree 210
Profile window 210
symbol values 233
symbols 233
working 221
workspace 209
Elixir Resource Index Service Configuration dialog
83
Elixir Resource Librarian
toolbars 272
Elixir Resource Map
arranging icons 271
arranging windows 270
clearing messages window 276
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compacting 275
customizing workspace 273
environment 266
hiding toolbar 272
location 267
mapping characters 307
mapping fonts 277
mapping multiple windows 275
Mappings window 268
Messages window 220, 269
opening 266
opening multiple mapping windows 275
overview 265
refreshing 271
screen, refreshing 271, 273
setting location 274
setting splitter 269
showing toolbar 272
status information 276
using 275
working 275
workspace 266, 267
Elixir Shortcut Wizard 65
Elixir Viewer
activating windows 253
Applications window 239
customizing input settings 256
default state 253
environment 238
grid 246
menus 210, 239
Messages window 239
modifying input settings 256
opening 238
opening input file 257
overview 237
printing 261
reviewing document 260
scrolling document 260
toolbar 210
using 254
viewing 261
workspace 238
zooming in 261
zooming out 261
ElixiTag dialog 195
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ELX 17, 74, 80, 87
ElxTag utility
adding tags 199
copying tags 200
deleting tags 199
editing tags 199
exiting tags 200
saving 198
starting 195
working 196
EMF 17, 53, 74
Endfile.end, uploading 143
environment
DesignPro Manager 29
Elixir Profile Editor 209
Elixir Resource Map 266
Elixir Viewer 238
EP
See also Elixir PrintDriver forms
error messages
about 338
handling 337
incorrect JSL file path 343
incorrect property 342
examples
command line 120
Explorer window 33
Export Setup File dialog 105
exporting
DAT files 77
extensions
AFP 310
BAK 86
BMP 18
CDF 17
COD 17
DAT 53, 73, 77, 87, 237, 257
DBF 19
EDF 53, 94, 237, 257
EFD 19
EFR 17, 18, 74, 80, 87, 94, 237, 257
ELX 17, 74, 80, 87, 94, 95, 237, 257
EMF 17, 53, 74, 237, 257
EP 17, 74, 237, 257
EPD 19
EPL 94, 237, 257

Index

EPM 105, 255
FLJ 17, 18
FRM 80, 87, 237, 257
FSL 80, 87
GDF 53, 94
HDR 17
HTM 82
JPE 18
JPEG 18
JPG 18
LP3 18
MET 53, 237, 257
MTA 53, 237, 257
NOR 53, 237, 257
PCL 17, 18, 53, 87, 237, 257
PCX 18
PDF 17, 53, 95
PRN 53, 94, 237, 257
PS 17, 53, 95
SEG 96
TIF 18
VIP 17, 95
ZIP 87

F
FILE command 146
files
command line parameter 129
downloading 142
file transfers 138
Flat view
about 211
default environment variables 212
FLJ 17, 18
folders
physical folders 50
virtual folders 50
working 50
Font dialog 191, 273, 289, 291, 299, 308
Font Mapping dialog 282, 284, 288, 296, 299
font mappings
AFP character set 282
AFP coded fonts 283
creating AFP character set font mappings 282
creating AFP coded font mappings 283
creating Elixir font mappings 284
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creating Embedded outline font mappings 287
creating new font mappings 281
creating PCL font mappings 288
creating Windows font mappings 289
deleting 304
displaying 278
editing 303
Elixir fonts 284
Embedded outline fonts 287
PCL fonts 288
Windows fonts 289
Font Prefix dialog 305
font prefix mappings
deleting 306
displaying 305
editing 306
Fontcvt utility 169
fonts
input formats 17
output formats 18
PCL 17, 18
typeface 285, 292
virtual folder 53
Fonts folder 53
form references
adding 74
deleting 76
reordering 76
formats
Backup files (BAK) 86
Data files (DAT) 87
details 214
Elixir (GDF) 53
Elixir DAT File (DAT) 53
Elixir Document (EDF) 53
Elixir Form (EFR) 80, 87
Elixir Legacy Form (ELX) 80, 87
Elixir PageDef (EPD) 19
Enhanced Metafile (EMF) 53
FRM 216
FSL 217
IMG 217
LGO 218
Metacode 216
OGL 214
PCL 218
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PDF 220
Portable Document Format (PDF) 53
PostScript 53, 219
Printer Command Language (PCL) 53, 87
Settings file extensions (EPM) 84
TIFF 219
Web Page (HTM) 82
Xerox Metacode (MET, MTA, NOR) 53
Xerox Overlay Object (FRM) 80, 87
Xerox Overlay Source (FSL) 80, 87
Zip File (ZIP) 87
Formats view 214
forms
opening from DAT files 76
Forms folder 54
FRM 80, 87
FSL 80, 87

G
GDF 53
General dialog 67
Go toolbar 240
graphic ruler 245
Graphics folder 55
grid
displaying/hiding 247
setting spacing 248

H
handling
error messages 337
warning messages 337
HDR 17
help
customer support 25
Help menu 24, 112, 308
hiding
grid 247
ruler 245
host, uploading files 138
text files 139
Xerox-labeled files 138, 140
HOSTCOPY
files downloading 142
printer, placing 145
using 143
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physical folders 51
virtual folders 51

HP PCL fonts 293
HTM 82

I

M

images
BMP 18
Elixir 18
Elixir overlays 18
input formats 18
JPEG 18
LP3 18
output formats 18
PCX 18
TIFF 18
IMG formats 217
importing
DAT files 77
mapping text files 303
input formats
ElixirDoc 116
ElixirGDF 116
ElixirPDW 116
PCL 116
input settings
modifying 256

Makepub utility
extracting files 204
listing files 203
Manage window
DAT File 73, 74, 75
Diagnostic Information 92
Resource Package 88
Resource Search 78
managing resources
collecting diagnostic information 91
DAT files 73
packaging resources 87
resource replacement 78
resource searching 78
mapping
character set 302
characters 307
code page 302
deleting characters 316
fonts 277
opening multiple windows 275
physical folder 58
text files, importing 303
virtual folder 58
windows 275
Mappings tool 275
Mappings window
Details view 269
font mappings 279, 310
Profile Tree 268
media mappings
about 317
adding 323
creating 323
deleting 325
displaying 321
editing 324
working 317
menus
Elixir Viewer 210
Elixir viewer 239
Help 24, 112, 308

J
JCL, preparing 143
Jobs folder 55
JPE 18
JPEG 18
JPG 18

K
Key

about 234
String 236

L
Legacy
fonts 17
images 18
LGO formats 218
Linked Code Page dialog 280, 301
Load Setup File dialog 98, 255
locating

Index
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messages
Elixir Resource Map messages 220, 269
error 337
warning 337
Messages window
clearing messages 38
color coding messages 41
copying messages 38
displaying message time 40
logging messages 39
MET
See also formats
Xerox Metacode (MET, MTA, NOR)
Metacode formats 216
Metainw utility 174
modifying
input settings 256
profile items 230
moving
files 60
files in virtual folders 60
physical folders 60
MTA
See also formats
Xerox Metacode (MET, MTA, NOR)
My Shortcuts tab 32

N
navigating
workspace 272
Navigation window 31
NOR 53

O
OGL formats 214
Open dialog 74, 81, 185, 199, 257, 284, 290, 301
Open Profile Configuration File dialog 223, 225
Open Resource File dialog 74
opening
DesignPro Manager 29
Elixir fonts from a resource library 286
Elixir Profile Editor 209
forms from DAT files 76
input file 257
multiple mapping windows 275
profiles 231
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setup file 255
Options dialog
General category 48
Symbols category 234
System Data category 235, 236
outline fonts 282
output formats
ElixirDoc 117
ElixirGDF 117
Image 117
PCL 117
PDF 117
PostScript 117
overlays
Elixir 17, 74
Elixir Legacy 17
Elixir PrintDriver 17, 74
input formats 17
output formats 17
PCL 17
PDF 17
PostScript 17
Windows EMF 17, 74
overview
Elixir Profile Editor 207
Elixir Resource Map 265
Viewer 237

P
Pack utility 176
packaging
resources 87
resources report 90
parameters
command line, specifying 121
unstructured file, specifying 122
password file display 156
PCL 17, 18, 53, 87
PCL dialog 324
PCX 18
PDF 17, 53
PDF formats 220
PDF Plug-In utility
about 204
using 205
physical folder
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creating 56
defining 50
files,moving 60
locating 51
mapping 58
placing printer, HOSTCOPY 145
PostScript
fonts 296
format 17, 219
preparing JCL 143
Preview window 262
previewing
documents 262
Print dialog 158, 262
printing
documents 263
Elixir Viewer 261
PRN 53
profile items
adding 227
file 229
modifying 230
multi 228
path 229
single 228
profile mappings
deleting 277
profile properties
adding profile item 227
deleting profile item 231
modifying profile item 230
Profile Properties dialog 222, 223
profile selection
new profile, registering 276
opening 276
Profile Selection dialog 276
Profile window 209, 210
Formats view 214
Resource Type view 213
profiles
about 255
adding default 222
adding derived profile 223
changing properties 227
cloned 221
cloning 225

Index

creating 221
custom 221, 255
customizing 233
default 221
deleting 226
derived 221
modifying 230
opening 231
opening new profile 276
Profile Tree 210
registring new profile 276
remove profile 226
selecting 276
user 255
using 276
viewing 255
properties
profiles 227
Properties of Profile Item dialog 228
PS
See also PostScript

R

raster fonts 278, 282
Reblock utility 177
running 177
refreshing
Elixir Resource Map 271
Manager workspace 47
Register New Profile dialog 276
Registered Font Properties dialog 106
related guides 22
removing
profile 226
reordering
form references 76
script commands 76
replacing
images in forms 84
resources, converter settings 87
settings file in forms 86
resource searching 78
configure options 83
fonts 80
images 80
search report 82
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Resource Type view 213
resources
converting 329
details 214
fonts 17
images 17, 18
managing 73
overlays 17
Resource Type view 213
Resources window 33
Documents 53
Fonts 53
Forms 54
Graphics 55
Jobs 55
right-click menu 47
ruler 245
changing unit 246
displaying 245
hiding 245
running
Reblock utility 177

S
sample fonts
setting 308
setting AFPDS fonts 309
setting Unicode fonts 308
Save As dialog 77, 78, 82
Scout
automating Command Line Converter 124
script commands
deleting 76
reordering 76
searching resources
specifying search criteria 81
viewing search results 82
Select Diagnostic File Name dialog 92
Select Package File Name dialog 89
Select Resource Library for Writing dialog 190
selecting
profiles 233, 276
setting
AFPDS sample fonts 309
character mapping 314
Code Page Editor general preferences 192, 193
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coded font preferences 194
Elixir Resource Map, location 274
Elixir Resource Map, splitter 269
Elixir target fonts for PCL fonts 291
Elixir target fonts for Windows fonts 290, 291
grid spacing 248
Info Server category 274
PCL target fonts 293
PDF target fonts 294
Postscript target fonts 296
profile properties 227
sample fonts 308
sample Unicode fonts 308
symbol properties 92
target fonts 290
VIPP target fonts 297
WinFont target fonts 299
Xerox target fonts 290
Settings dialog 67
setup files
opening 255
shortcuts
creating 65
deleting 70
specifying
command line parameters 121, 132
target fonts 290
Standard toolbar 240
Status bar 241
Status Information dialog 276
Status information tool 276
Strip utility 178
support 25
supported file formats 17
System Data.ini 234

T
tabs

Applications 32
My Shortcuts 32
Tools and Utilities 32
target fonts
setting Elixir for PCL fonts 290, 291
setting Elixir for Windows fonts 290, 291
setting HP PCL 293
setting PDF 294
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setting Postscript 296
setting VIPP 297
setting WinFont 299
specifying 290
TIFF 18, 219
toolbars
adding buttons 46, 244
creating new 45, 243
customizing display 44, 242
Elixir Resource Librarian toolbars 272
Elixir Viewer 210
Go 240
Standard 44, 240
Zoom 241
tools
about 43
Mappings 275
menus 43
Status.inf 276
tools and utilities 155
password file display 156
Tools and Utilities tab 32
training 26
Tray Map dialog 318
Tray map dialog 321, 322, 323
tray mappings
about 317
adding 319
creating 319
deleting 320
displaying 317
editing 320
working 317

U
understanding
DAT file 73
Elixir Viewer 238
Unicode 307
unmapping virtual folders 64
unstructured file
specifying parameters 122
uploading
Endfile.end 143
metacode files 148
Metacode files to host 147

Index

metacode files with 871 device 150
with IBM 3270 148
with IRMA FT/3270 148
user profiles
custom 255
default 255
using
DPTCLCu.exe 114
Elixir Resource Map 275
Elixir Viewer 254
profiles 276
virtual folders 52
utilities
additional 160
Barr 163
Bcheck 165
Disp 167
ElxTag 195
FixElxOr 162
Fontcvt 169
Makepub 200
Metainw 174
Pack 176
Pdg Plug-In 204
Reblock 177
Stand-Alone utilities 155
Strip 178
UPDKEY 175, 178
XDisk32 179

V
Value
about 234
vector fonts 282
viewing
converter properties 256
input file 257
parser properties 256
profiles 255
status information 276
views
Details view 211
VIPP fonts 297
virtual folders
defining 50
Documents 53
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Fonts 53
Forms 54
Graphics 55
Jobs 55
locating 51
mapping 58
moving files 60
unmapping 64
using 52

Elixir Viewer 238
Explorer window 31
functions 47
Mappings window 268
Messages window 37, 220, 269
My Shortcuts tab 31
navigating 272
refresh tree 269
refreshing 47
Resources window 31
tools 43
Tools and Utilities tab 31
windows,understanding 267

W
warning messages
handling 337
Web Page (HTM) 90
Who Should Use this Guide? 22
windows
activating 253
applications 239
arranging 250, 270
Details 228
Disppw 156
docking 251
Elixir Resource Map 209, 266
Explorer window 33
Manage 73, 74, 75
Mappings 268, 275, 279, 303, 306, 310, 317
Messages 37, 209, 220, 239, 269
Navigation 31
Preview 262
Profile 209
Resources window 33
Windows dialog 253
Windows fonts 278
WindowsEMF 17, 74
working
DAT files 76
Elixir Resource Map 275
media mappings 317
tray mappings 317
with folders 50
workspace
Applications tab 31
browsing 49
commands 272
Details window 31
Elixir Profile Editor 209
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X
XDisk32 utility 179
Xerox
conversion, image 333
creating fonts 330
target fonts 290
Xerox LPS Resource Writer dialog 332, 334
Xerox-labeled files
printer, copying 146

Z
ZIP 87
Zoom toolbar 241
zooming in 261
zooming out 261
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